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第 1 章

入門

このマニュアルについて

ザイ リ ンクス  エンベデッ ド開発キッ ト  (EDK) は、ザイ リ ンクス FPGA (フ ィールド  プログラマブル

ゲート  アレイ ) デバイスにインプリ メン トするエンベデッ ド  プロセッサ システムを設計するツー

ルおよび IP (Intellectual Property) のセッ トです。

このマニュアルでは、EDK を使用してカスタム エンベデッ ド  プロセッサ システムを開発するデザ

イン フローを説明します。 基礎的な情報も含まれますが、EDK の機能とその使用方法の説明が主な

内容です。 

このマニュアルは、 次のよ う な場合に適しています。

• EDK とそのユーティ リ ティに関する基礎的な入門情報が必要な場合

• エンベデッ ド  プロセッサ システムの開発からしばら く離れていた場合

• ザイ リ ンクス  EDK ツールをインス トールする場合

• プロセッサ システムの設計中に簡単に参照できる資料が必要な場合

メモ : このマニュアルは、Windows オペレーティング システムでの動作に基づいて記述されていま

す。 Linux システムでは、ツールの動作およびグラフ ィカル ユーザー インターフェイス  (GUI) が異

なる場合があ り ます。

チュート リアル

ソフ ト ウェア ツールについて学ぶには、使用してみるのが最良の方法です。 このマニュアルには説

明したツールを実際に使用してみるチュート リ アルがあ り、手順に従ってサンプル プロジェク ト を

作成できます。 このセクシ ョ ンでは、 自動機能を使用した場合に実行される処理についても説明し

ています。 

その他の資料

EDK に関するその他の資料は、 次のサイ トから参照できます。

http://japan.xilinx.com/ise/embedded/edk_docs.htm

ISE (Integrated Software Environment) に関する資料は、 次のサイ トから参照できます。

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx11/manuals.pdf

http://japan.xilinx.com
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=edk+docs
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=sw+manuals
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添付ファイル

このマニュアルには、チュート リ アルを実行するためのサンプル プロジェク ト  ファ イルが添付され

ています。 Adobe Acrobat Reader の左下にあるク リ ップ アイコンをク リ ッ クする と、これらのファ

イルを参照できます。

添付されているファ イルは、 次のとおりです。

• bus_transaction_bfl_code.txt

• leds.c

• pn.do file

• pwm_light.vhd

• user_logic.vhd

EDK によるエンベデッ ド  プロセッサ デザインの簡略化

エンベデッ ド  システムは複雑です。 エンベデッ ド  デザインのハードウェア部分と ソフ ト ウェア部

分を機能させるだけでも課題であ り、 2 つのデザイン コンポーネン トが 1 つのシステムと して機能

するよ う統合する という作業も加わり ます。 これに FPGA の設計が加われば、 さ らに複雑さが増し

ます。

設計プロセスを簡略化するため、 ザイ リ ンクスでは複数のツール セッ ト を提供しています。 これら

のツール名、 プロジェク ト  ファ イル名、 略称を覚えておく と有益です。 このマニュアルの最後に

EDK で使用される用語を リ ス ト した付録 C 「用語集」 があるので、 参考にして ください。

ISE Design Suite : Embedded Edition
ザイ リ ンクスでは、 ISE Design Suite によ り さまざまな開発システム ツールを提供しています。 用
途に応じた異なるエディシ ョ ンがあ り、 エンベデッ ド  システムの開発用には Embedded Edition が
提供されています。 Embedded Edition には、 次のツールが含まれます。

• ISE (Integrated Software Environment)

• PlanAhead デザイン開発ツール、 ChipScope™ Pro (FPGA デザインのデバッグに有益)

• エンベデッ ド開発キッ ト  (EDK)

FPGA デザインでの ISE ツールの使用方法は、次のページから  ISE のヘルプおよびマニュアルを参

照してください。

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx11/manuals.pdf

エンベデッ ド開発キッ ト  (EDK)
EDK は、ザイ リ ンクス  FPGA デバイスにインプリ メン トするエンベデッ ド  プロセッサ システムを

設計するツールおよび IP のセッ トです。 

Xilinx Platform Studio (XPS)

XPS を実行するには、 ISE がインス トールされている必要があ り ます。 ISE は、 エンベデッ ド  プロ

セッサ システムおよびそのデザインに関するすべてを包括するツールです。

XPS は、 エンべデッ ド  プロセッサ システムのハードウェア部分を定義するのに使用する開発環境

です。 XPS は、 bash シェル コマンド  ライン、バッチ モード、 GUI を使用して実行できます。 この

マニュアルでは、 GUI を使用する方法を示します。

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=sw+manuals
http://www.xilinx.com
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ツールによるデザイン プロセスの短縮

ソフ トウェア開発キッ ト  (SDK)

SDK は XPS に補足的に使用する統合開発環境で、 C/C++ エンベデッ ド  ソフ ト ウェア アプリケー

シ ョ ンの作成および検証に使用します。 SDK は Eclipse™ オープン ソース  フレームワークに基づ

いて構築されているので、 GUI にはなじみがあるかもしれません。

その他の EDK コンポーネン ト

EDK には、 上記のほかに次のものが含まれています。 

• ザイ リ ンクス  エンベデッ ド  プロセッサ用のハード ウェア IP

• エンベデッ ド  ソフ ト ウェア開発用のド ライバおよびライブラ リ

• MicroBlaze™ および PowerPC® プロセッサをターゲッ ト と した C/C++ ソフ ト ウェア開発用

の GNU コンパイラおよびデバッガ

• マニュアル

• サンプル プロジェク ト

EDK に含まれるユーティ リ ティ を使用する と、 エンベデッ ド  システムの設計フローを最初から最

後まで実行できます。

ツールによるデザイン プロセスの短縮

次に、 エンベデッ ド  デザインのフローを示します。 
X-Ref Target - Figure 1-1

図 1-1 : 基本的なエンベデッ ド  システム設計プロセスのフロー

X11124

デバイス コンフィギュレーション

ISE (Integrated Software Environment)

XPS
(Xilinx Platform Studio)

デザイン インプリメンテーション

SDK  ソフトウェア開発キット

ソフトウェアのプロファイル作成

ソフトウェア開発

ソフトウェア デバッグ

ChipScope Pro

PlanAhead

Embedded Edition に
含まれているその他のツール

検証ファイルの生成

プロセッサ ハードウェア開発

ハードウェア
プラット
フォーム

デバイス コンフィギュレーション

http://japan.xilinx.com
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通常は、 まず ISE 開発ソフ ト ウェアを使用してエンベデッ ド  プロセッサ ソースを作成し、 これを

ISE プロジェク トに追加します。

• XPS は、 主にエンベデッ ド  プロセッサ ハードウェア システムの開発に使用します。 マイク ロ

プロセッサおよびペリ フェラルの仕様、 これらのコンポーネン トの接続およびプロパティの設

定に、 XPS を使用します。

• ソフ ト ウェアの開発には、 SDK を使用します。 ISE Design Suite: Embedded Edition のこのリ

リースから、 SDK はスタンドアロン アプリ ケーシ ョ ンと して入手するこ と も可能です。 SKD
は個別の実行ファイルであ り、 ほかのツールなしで実行できます。

• ハードウェア プラ ッ ト フォームの機能を検証するには、 デザインを  HDL シ ミ ュレータでシ

ミ ュレーシ ョ ンします。

XPS では、 次の 3 つのシ ミ ュレーシ ョ ンを実行できます。 

♦ ビヘイビア

♦ 構造

♦ タイ ミ ング

XPS では、 シ ミ ュレーシ ョ ンに使用する  HDL ファ イルも含め、 検証プロセス構造が自動的に

設定されるので、 ク ロ ッ ク  タイ ミ ングおよびリセッ ト  スティ ミ ュラス情報を入力し、 アプ リ

ケーシ ョ ン コードを供給するだけで済みます。

• XPS でデザインを設計したら、 ISE に戻って FPGA コンフ ィギュレーシ ョ ン ファ イルを生成

し、 ターゲッ ト  デバイスにプログラムします。

• エンベデッ ド  デザインを含むビッ ト ス ト リームを FPGA にコンフ ィギュレーシ ョ ンしたら、

SDK でソフ ト ウェア プロジェク トの ELF (Executable and Linkable Format) ファ イルをダウ

ンロード してデバッグします。

XPS に関連したエンベデッ ド  デザイン設計プロセスの詳細は、 http://japan.xilinx.com/ise/
embedded/edk_docs.htm から 『エンベデッ ド  システム ツール リ ファレンス  マニュアル』 の 「設計

プロセスの概要」 を参照してください。

設計開始の準備

ツールについて詳細に説明する前に、 ツールが正し く インス トールされ、 チュート リ アルの手順を

実行できるよ うに環境が設定されているかを確認します。

インス トール要件 : EDK ツールの実行に必要なもの

ISE および EDK

ISE と  EDK は、ISE Design Suite: Embedded Edition に含まれています。 ソフト ウェアおよび最新の

アッ プデート がインスト ールされているこ と を確認してく ださい。 http://japan.xilinx.com/support で
最新のソフト ウェア  バージョ ンを確認できます。

EDK のインス トール
要件

Linux の bash シェル

Linux プラ ッ ト フォームで EDK を実行する場合は、bash シェルが必要です。 『ISE Design Suite 11 :
インス トール、 ライセンス、 リ リース  ノート 』 に掲載されているサポート されるプラ ッ ト フォーム

も確認してください。

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=edk+docs
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=edk+docs
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=support
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?ver=11.1&locale=jp&topic=release+notes
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?ver=11.1&locale=jp&topic=release+notes
http://www.xilinx.com
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ソフ トウェア ライセンス

ISE 11.1 リ リースから、 ザイ リ ンクス  ソフ ト ウェアに FLEXnet ライセンスが使用されるよ うにな

り ました。 ソフ ト ウェアを初めて実行する際、ライセンス検証プロセスが実行されます。 有効なライ

センスが存在しない場合、Xilinx License Configuration Manager を使用してライセンスを取得でき

ます。 ソフ ト ウェアを試用する場合は、 評価ライセンスを生成できます。

ザイ リ ンクス  ソフ ト ウェアのライセンスの詳細は、『ISE Design Suite 11 : インス トール、ライセン

ス、 リ リース  ノート 』 を参照して ください。

シミ ュレーシ ョ ンのインストール要件

EDK ツールを使用してシ ミ ュレーシ ョ ンを実行するには、 適切なシ ミ ュレータをインス トールし、

シ ミ ュレーシ ョ ン ラ イブラ リ をコンパイルする必要があ り ます。

1. SecureIP をサポートする混合言語シ ミ ュレータ  (ModelSim PE/SE v6.4b または NCSim 8.1-
s009 以降) が必要です。 MXE は混合言語および SecureIP をサポート していないので、 エンベ

デッ ド  デザインには使用できません。

オプシ ョ ンで、 CoreConnect™ ツールキッ ト をインス トールします。 CoreConnect ツールキッ

トは、 バス  ファンクシ ョ ン モデル (BFM) シ ミ ュレーシ ョ ンを実行する場合にのみ必要です。

BFM シ ミ ュレーシ ョ ンを実行しない場合は、 CoreConnect ツールキッ ト をインス トールする

必要はあ り ません。CoreConnect は IBM から提供されている無償のユーティ リ ティで、 ザイ リ

ンクスの次の Web サイ トからダウンロードできます。

http://japan.xilinx.com/xlnx/xebiz/designResources/ip_product_details.jsp?key=dr_pcentr
al_coreconnect 

こ の Web ページで適切な選択をして注文および登録すると 、 ダウンロード できるよ う になり

ます。

シ ミ ュレーシ ョ ンの
インス トール要件

2. シ ミ ュレーシ ョ ン ライブラ リ をコンパイルしていない場合は、XPS ヘルプに説明されている手

順に従ってコンパイルしてください。

a. XPS ヘルプは、 [Help] → [Help Topics] をク リ ッ クする と表示されます。 また、

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx11/manuals.pdf からも

参照できます。

b. 「エンベデッ ド  プロセッサの設計手順」 → 「シ ミ ュレーシ ョ ン」 → 「シ ミ ュレーシ ョ ン ラ
イブラ リのコンパイル」 → 「XPS でのシ ミ ュレーシ ョ ン ライブラ リのコンパイル」 ト ピッ

クを参照してください。

インス トール プロセスの詳細は、『ISE Design Suite 11 : インス トール、ラ イセンス、 リ リース  ノー

ト 』 を参照してください。

http://japan.xilinx.com
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx11/manuals.pdf
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?ver=11.1&locale=jp&topic=release+notes
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?ver=11.1&locale=jp&topic=release+notes
http://japan.xilinx.com/xlnx/xebiz/designResources/ip_product_details.jsp?key=dr_pcentral_coreconnect
http://japan.xilinx.com/xlnx/xebiz/designResources/ip_product_details.jsp?key=dr_pcentral_coreconnect
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?ver=11.1&locale=jp&topic=release+notes
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?ver=11.1&locale=jp&topic=release+notes
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第 2 章

新規プロジェク トの作成

この章では、 ザイ リ ンクス  エンベデッ ド開発キッ ト  (EDK) を使用してエンベデッ ド  システムの開

発を開始します。

Base System Builder
BSB について Base System Builder (BSB) は、機能するデザインを短時間で効率的に作成するウ ィザードで、XPS

(Xilinx Platform Studio) に含まれています。 BSB ウ ィザードで作成したデザインは、要件に応じて

カスタマイズできます。

このセクシ ョ ンの最後に、BSB ウ ィザードを使用してプロジェク ト を作成する最初のチュート リ ア

ルがあ り ます。

BSB ウィザードを使用する理由

ザイ リ ンクスでは、 新規エンベデッ ド  デザイン プロジェク トの基本デザインを作成するのに BSB
ウ ィザードを使用するこ とをお勧めします。 BSB ウ ィザードで必要なデザインを作成できる場合

もあ り ますが、カスタマイズが必要な場合でも、BSB ウ ィザードで基礎となるハードウェアおよび

ソフ ト ウェア プラ ッ ト フォームを自動的にコンフ ィギュレーシ ョ ンできるので、設計時間を大幅に

短縮できます。 ウ ィザードを実行する と、 必要な基本要素をすべて含むプロジェク トが作成される

ので、 このプロジェク ト をカスタマイズしてよ り複雑なシステムを作成できます。

BSB ウィザードで可能な操作

BSB ウ ィザードでは、プロジェク ト  ファ イルの作成、ボードの選択、プロセッサおよび I/O インター

フェイスの選択と設定、 内部ペリ フェラルの追加、 ソフ ト ウェアのセッ ト アップ、 およびシステム

サマ リ  レポートの生成が可能です。

選択したボードのシステム コンポーネン トおよびコンフ ィギュレーシ ョ ンが認識され、適切なオプ

シ ョ ンが表示されます。

XMP ファ イルの作成時に、 BSB ウ ィザードで作成した別のプロジェク トの設定を適用するこ と も

可能です。

http://japan.xilinx.com
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ボード  タイプの選択

BSB ウ ィザードでは、 リ ス トからボード  タイプを選択するか、 カスタム ボードを作成できます。

サポート されるボード

ボード  タ イプの選択 

ザイリ ンク スまたはザイ リ ンク ス  パート ナーから提供されているエンべデッ ド  プロセッ サ開発ボー

ド を使用する場合、 BSB ウィ ザード でボード で使用可能なペリ フェラルを選択し、 自動的に FPGA
のピン配置をボード に一致さ せ、 ボード にダウンロード して実行できる完全なプラッ ト フォームと

テスト  アプリ ケーショ ンを作成できます。 各オプショ ンには、デフォルト 値があらかじめ選択されて

います。 この基本プロジェク ト は、XPS でさらにカスタマイズするか、ISE のインプリ メ ンテーショ

ン  ツールを使用してインプリ メ ント できます。

EDK をインス トールする と、 ザイ リ ンクス  ボード  ファ イルのみがインス トールされます。 サード

パーティ  ボードを使用する場合、 ボード  サポート  ファ イルを追加する必要があ り ます。 BSB ウ ィ

ザードの [Board Selection] ページに、 サードパーティのボード  サポート  ファ イルを見つけるのに

役立つページへのリ ンクがあ り ます。 ファ イルをインス トールする と、 BSB ウ ィザードのド ロ ップ

ダウン メニューにこれらのボードが表示されるよ うにな り ます。

カスタム ボード

カスタム ボードのデザインを開発している場合、 BSB ウ ィザードで使用可能なプロセッサ コア 
(ターゲッ ト  FPGA デバイスに応じて MicroBlaze™ または PowerPC® プロセッサ) を選択し、 IP
ライブラ リに含まれている互換性のある、 頻繁に使用されるペリ フェラル コアと接続できます。 生
成されたハードウェア システムを開始点と して使用し、 必要に応じてさ らにプロセッサおよびペリ

フェラルを追加できます。 カスタム ペリ フェラルの作成も含むこの作業には、XPS に含まれるユー

ティ リ ティ を使用できます。

プロセッサの選択とコンフ ィギュレーシ ョ ン

MicroBlaze または PowerPC のどちらかを選択し、 次のオプシ ョ ンを指定できます。

複数の I/O インターフ ェイスの選択とコンフ ィギュレーシ ョ ン

BSB ウ ィザードでは、 定義済みのボードで使用可能な外部メモリおよび I/O デバイスが認識され、

デバイスに応じて次を選択できます。

• 使用するデバイス

• ボーレート

• ペリ フェラル

• データ  ビッ ト数

• パリティ

• 割り込みの使用/不使用

外部メモ リおよび I/O デバイスのデータシート を BSB ウ ィザードから開く こ とができます。

• リ ファレンス  クロ ッ クの周波数

• プロセッサ バス  ク ロ ッ クの周波数

• リセッ トの極性

• デバッグ用のプロセッサのコンフ ィギュ

レーシ ョ ン

• キャ ッシュ設定

• 浮動小数点ユニッ ト  (FPU) 設定

http://www.xilinx.com
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内部ペリフェラルの追加

BSB ウ ィザードで、ペリ フェラルを追加できます。 ペリ フェラルは、選択したボードおよび FPGA
デバイス  アーキテクチャによ りサポート されているこ とが必要です。 カスタム ボードでは、一部の

ペリ フェラルしか通常の選択および自動システム接続できません。

ソフ トウェアの設定

標準の入力および出力デバイスは BSB ウ ィザードで指定でき、 サンプル C アプリケーシ ョ ンを生

成できます。 BSB ウ ィザードで生成したサンプル C アプリ ケーシ ョ ンは、付録 A「Project Navigator
での ModelSim を使用したシ ミ ュレーシ ョ ン」 のシ ミ ュレーシ ョ ン例で使用されます。 ソフ ト ウェ

アの開発には、ソフ ト ウェア開発キッ ト  (SDK) を使用するこ とをお勧めします。このマニュアルに

は、 SDK を使用するチュート リ アルが含まれています。 ソフ ト ウェア デバッグ チュート リ アルで

使用するサンプル C アプリケーシ ョ ンは、 SDK で生成したものです。

システム サマリ

BSB ウ ィザードですべてのオプシ ョ ンを選択する と、 システム サマ リが表示されます。 この時点

で、 プロジェク ト を生成するか、 前のダイアログ ボッ クスに戻って設定を変更できます。

チュー ト リアルで
使用されるデバイスと
ボード

このマニュアルでは、Spartan®-3A DSP 1800A スタータ  ボードを使用し、MicroBlaze プロセッサ

をターゲッ ト と しています。 選択するオプシ ョ ンは、14 ページの「チュート リ アル : 新規エンベデッ

ド  プロジェク トの作成」 に リ ス ト されています。

PowerPC 405 (Virtex®-4 FX) または PowerPC 440 (Virtex-5 FXT) プロセッサを含む FPGA を搭載

したボードを使用する場合は、 MicroBlaze または該当する  PowerPC プロセッサを使用できます。

ほとんどの場合、 ツールの動作は同じです。

BSB ウィザード と  ISE Design Suite
ISE ソフ ト ウェアで新規プロジェク ト を作成します。 プロジェク トの作成には、 Project Navigator
の New Project Wizard を使用します。 プロジェク ト を作成し、エンベデッ ド  プロセッサ ソースを作

成する と、自動的に XPS が開き、BSB を使用してエンベデッ ド  プロセッサ プロジェク ト を作成で

きます。 XPS が起動するのに多少の時間がかかり ます。

XMP フ ァ イル XMP (Xilinx Microprocessor Project) ファ イルは、開発するエンベデッ ド  システムの最上位ファイ

ル記述です。 すべてのプロジェク ト情報は、 XMP ファ イルに保存されます。 

XMP ファ イルは、HDL コードや制約ファイルなどのその他のソース  ファ イルと同様に、 ISE で作

成され管理されます。 これらのプロセスを次のチュート リ アルで学びます。

http://japan.xilinx.com
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チュート リアル :  新規エンベデッ ド  プロジェク トの作成

このチュート リ アルでは、ISE Project Navigator を起動して、エンベデッ ド  プロセッサ システムを

最上位ソースとするプロジェク ト を作成します。 

1. ISE Project Navigator を起動します。

2. [File] → [New Project] をク リ ッ ク し、 New Project Wizard を開きます。

3. 次の表の指示に従って、 ウ ィザードの各ページでオプシ ョ ンを設定します。

New Project Wizard が終了する と、ISE でエンベデッ ド  プロセッサ システムが含まれるこ とが

認識され、 XPS が起動します。

ウィザードのページ システム特性 設定または使用するコマンド

[Create New Project] • プロジェク ト名 ([Name])

• プロジェク トの保存ディ レク ト リ  
([Location]) および説明 
([Description])

• 最上位ソース  タイプ ([Top-level 
source type])

• プロジェク ト名を入力します (スペースは含めない)。

• プロジェク トの保存ディ レク ト リ を選択します (スペー

スは含めない)。 説明を記述するこ と もできます。

• [HDL] を選択します (デフォルト )。

[Device Properties] • 製品カテゴ リ  ([Product Category])

• デバイス  ファ ミ リ  ([Family])

• デバイス  ([Device])

• パッケージ ([Package])

• スピード  グレード  ([Speed])

• 合成ツール ([Synthesis Tool])

• シ ミ ュレータ  ([Simulator])

• 優先する言語 ([Preferred 
Language])

• [All]

• [Spartan-3A DSP]

• [XC3SD1800A]

• [FG676]

• [-4]

• [XST (VHDL/Verilog)]

• 使用するシ ミ ュレータを選択します。 *

• [VHDL]

その他の設定はデフォルトのままにします。

* サポート されているシ ミ ュレータは、8 ページの「インス

トール要件 : EDK ツールの実行に必要なもの」に リ ス ト さ

れています。

[Create New Source] [New Source] をク リ ッ ク します。 New Source Wizard が開

きます。

New Source Wizard の
[Select Source Type]

ソース タイプと して [Embedded 
Processor] を選択し、 次の値を指定し

ます。

• ファ イル名 ([File name])

• 保存ディレク ト リ  ([Location])

• 「system」 と入力します。

• デフォルトのディ レク ト リ を使用します。

[Add to project] をオンのままにします。

[Next] をク リ ッ ク し、次のダイアログ ボッ クスで [Finish]
をク リ ッ ク します。

[Create New Source] これ以外に新規ソースは追加しま

せん。

[Next] をク リ ッ ク します。 

[Add Existing Sources] 何も追加しません。 [Next] をク リ ッ ク します。 

[Project Summary] [Finish] をク リ ッ ク します。 

http://www.xilinx.com
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4. 「This project appears to be a blank project. Do you want to create a Base System using the BSB
Wizard?」 (このプロジェク トは空です。BSB ウ ィザードを使用して基本システムを作成します

か) という メ ッセージが表示されます。 これには少し時間がかかる場合があ り ます。 [Yes] をク

リ ッ ク します。

BSB ウ ィザードが起動します。 次の表の指示に従ってプロジェク ト を作成します。

メモ : 表に設定またはコマンドがない場合は、 デフォルト値をそのまま使用します。
.

ウィザードのページ システム特性 設定または使用するコマンド

[Welcome to the Base 
System Builder]

プロジェク ト  タイプ 
オプシ ョ ン

[I would like to create a new design] をオンにします。

[Board Selection] • ボード  ベンダー ([Board 
Vendor])

• ボード名 ([Board Name])

• ボードのリ ビジ ョ ン 
([Board Revision])

• [Xilinx] を選択します。

• [Spartan-3A DSP 1800A Starter Board] を選択します。

1800A ボードには Spartan-3A DSP デバイスが含まれて

おり、 MicroBlaze プロセッサを 1 つまたは複数コンフ ィ

ギュレーシ ョ ンできます。

• [1] を選択します (デフォルト )。

[System Configuration] システムのタイプ [Single-Processor System] をオンにします。

[Processor Configuration] • プロセッサのタイプ 
([Processor Type])

• システム クロ ッ ク周波数 
([System Clock Frequency])

• ローカル メモ リ  ([Local 
Memory])

• 浮動小数点ユニッ トの使用 
([Enable Floating Point 
Unit])

• [MicroBlaze] を選択します。

• デフォルトのシステム クロ ッ ク周波数 (62.5 MHz) をそ

のまま使用します。

• [16 KB] を選択します。

• 浮動小数点ユニッ トは無効にします (チェッ ク  ボッ クス

をオフ)。

[Peripheral Configuration] プロセッサ 1 (MicroBlaze) の
ペリ フェラルのリ ス ト  
([Processor 1 (MicroBlaze) 
Peripherals])

デフォルトのリ ス トから次のペリ フェラルを削除します。

• Ethernet_MAC

• SPI_FLASH

その他のコアはそのままにします。

[Cache Configuration] 命令キャ ッシュ  ([Instruction 
Cache]) およびデータ  キャ ッ

シュ  ([Data Cache])

オフにします。

http://japan.xilinx.com
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5. システム サマリ を確認したら、 [Finish] をク リ ッ ク します。

BSB およびカスタム ボードに関するメモ

カスタム ボードを含むプロジェク ト を作成する場合、 カスタム ボード  ライブラ リ用にザイ リ ンク

ス  ボード記述ファイル (*.xbd) を作成し、 $XILINX_EDK\board に配置する必要があ り ます。 詳
細は、 次のサイ トから 『Platform Specification Format Reference Manual』 の 「Xilinx Board
Description (XBD) Format」 を参照して ください。

http://japan.xilinx.com/ise/embedded/edk_docs.htm

次の操作

この後、 ハードウェアの基礎を説明します。

• 第 3 章 「Xilinx Platform Studio の使用」 では、 XPS (Xilinx Platform Studio) ソフ ト ウェアを

使用します。

• 第 4 章 「エンベデッ ド  プラ ッ ト フォームの操作」 では、XPS でプロジェク ト を表示し、変更す

る方法を学びます。

[Application Configuration] サンプル アプリ ケーシ ョ ンの

オプシ ョ ン ([Example 
Applications]) 

デフォルト値をそのまま使用します。 

[Summary] システム サマリ  ページ すべてのシステム コンポーネン ト を選択し、 コンフ ィギュ

レーシ ョ ンする と、 システムのサマリが表示されます。 この

ページで選択を確認します。

次のコンポーネン ト を含む MicroBlaze プロセッサが作成さ

れているはずです。

• 複数ポート  メモ リ  コン ト ローラ  (mpmc) 

• XPS GPIO (3 インスタンス)

• XPS UartLite (xps_uartlite) 

• LMB BRAM IF コン ト ローラ  (2 インスタンス)

前のページに戻って設定を変更できます。

BSB ウ ィザードによ りデフォルトのメモ リ  マップが作成さ

れます。 このメモリ  マップは BSB ウ ィザードからは変更で

きませんが、 BSB ウ ィザードを閉じた後に変更できます。

ウィザードのページ システム特性 設定または使用するコマンド

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=edk+docs
http://www.xilinx.com
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Xilinx Platform Studio の使用

この章では、Xilinx Platform Studio (XPS) の概要を説明します。 XPS を使用する と、BSB で作成し

たプロジェク ト をカスタマイズできます。 この章で XPS の概要を説明し、 その後の章で XPS を使

用してデザインを変更する方法を説明します。

メモ : この章を読むと、このマニュアルのこの後の章および XPS のその他の資料を理解しやすくな

るので、 目を通されるこ とをお勧めします。

XPS とは

XPS は、プロジェク トの設計を支援するツール セッ ト を含むグラフ ィカル ユーザー インターフェ

イスです。 この章では、 XPS ソフ ト ウェアと最も頻繁に使用されるツールについて説明します。

XPS ソフ トウェア

XPS ソフ ト ウェアを使用する と、ザイ リ ンクス  FPGA デバイスにインプ リ メン トする完全なエンベ

デッ ド  プロセッサ システムを設計できます。 次の図に、 XPS のメ イン ウ ィンド ウを示します。

この章のチュート リ アルでは、XPS のメ イン ウ ィンド ウの各部分にある情報およびツールを見てみ

ます。

http://japan.xilinx.com
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XPS ユーザー イン
ターフ ェ イスの使用

XPS のメ イン ウ ィンド ウは、 次の 3 つの部分から構成されています。

• プロジェク ト情報エ リア (1)

• [System Assembly View] (2)

• コンソール ウ ィンド ウ  (3)

XPS のメ イン ウ ィンド ウには、 次のエ リアもあ り ます。

• バス接続パネル (4)

• 表示切り替えボタン (5)

• フ ィルタ  パネル (6)

X-Ref Target - Figure 3-1

図 3-1 : XPS のメイン ウィンドウ

http://www.xilinx.com
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プロジェク ト情報エリア

プロジェク トの情報を表示します。こ こからプロジェク ト を管理します。 [Project]、 [Applications]、
および [IP Catalog] タブがあ り ます。

[Project] タブ

プロジェク トに関連するファイルおよび情報の一覧を表示します。 ファ イルおよび情報は、 次のカ

テゴ リに分類されています。

• [Project Files]

MHS (Microprocessor Hardware Specification) ファ イル、 MSS (Microprocessor Software
Specification) ファ イル、 ユーザー制約ファイル (UCF)、 iMPACT コマンド  ファ イル、 インプ

リ メンテーシ ョ ン オプシ ョ ン ファ イル、 BitGen オプシ ョ ン ファ イルなど、プロジェク ト特定

のファイルを リ ス ト します。

• [Project Options]

デバイス、ネッ ト リ ス ト 、 インプ リ メンテーシ ョ ン、 HDL、 シ ミ ュレーシ ョ ン モデルなどのプ

ロジェク ト特定のオプシ ョ ンを リ ス ト します。 

• [Design Summary]

エンベデッ ド  デザインのステート を表示し、システム ファ イルに簡単にアクセスできるよ うに

します。
X-Ref Target - Figure 3-2

図 3-2 : プロジェク ト情報エリアの [Project] タブ

http://japan.xilinx.com
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[Applications] タブ

ソフ ト ウェア アプリ ケーシ ョ ンのオプシ ョ ン設定と、各アプリ ケーシ ョ ン プロジェク トに関連付け

られているヘッダ ファ イルおよびソース  ファ イルの一覧を リ ス ト します (図 3-3)。 このタブを選択

している と、 次の操作を実行できます。

• ソフ ト ウェア アプリ ケーシ ョ ン プロジェク トの追加、 プロジェク トの作成、 およびブロ ッ ク

RAM への読み込み

• コンパイラ  オプシ ョ ンの設定

• プロジェク トへのソース  ファ イルおよびヘッダ ファ イルの追加

メモ : XPS でも ソフ ト ウェア プロジェク ト を作成および管理できますが、ソフ ト ウェアの開発には

SDK を使用するこ とをお勧めします。 

[IP Catalog] タブ

IP コアの一覧を表示します。 次の情報が示されます。

• コア名と ライセンスのステータス

• リ リース  バージ ョ ンとステータス  (アクティブ、 早期アクセス、 廃止予定)

• サポート されるプロセッサ

• 分類

バージ ョ ン変更履歴、 データシート、 MPD (Microprocessor Peripheral Definition) ファ イルなどの

IP コアの詳細情報は、[IP Catalog] タブで IP コアを右ク リ ッ ク して表示される メニューからアクセ

スできます。 デフォルトでは、 IP コアはファンクシ ョ ンごとにグループ化されています。

メモ : IP の詳細をすべて表示するには、 タブのサイズを広げる必要があ り ます。

X-Ref Target - Figure 3-3

図 3-3 : プロジェク ト情報エリアの [Applications] タブ
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チュート リアル :  プロジェク ト情報エリア

1. XPS でプロジェク ト を開き、 [Project] タブをク リ ッ ク します。

2. [Project Files] の下にあるアイテムのいずれかを右ク リ ッ ク し、[Open] をク リ ッ ク します。 この

後のチュート リ アルで、 これらのファイルの一部を編集します。 

3. [File] → [Close] をク リ ッ ク してファ イルを閉じます。

4. [Project Options] の下にあるアイテムのいずれかを右ク リ ッ ク して [Project Options] をク リ ッ

ク し、 [Project Options] ダイアログ ボッ クスを開きます。 [Project] → [Project Options] をク

リ ッ ク しても、 同じ操作を実行できます。

5. [Project Options] ダイアログ ボッ クスを閉じます。

6. [IP Catalog] タブをク リ ッ ク します。

7. [IP Catalog] タブの左上に 2 つのボタンがあ り ます。 これらをク リ ッ ク して、 [IP Catalog] タブ

の表示がどのよ うに変化するかを観察します。

8. [IP Catalog] タブに表示されているアイテムのいずれかを右ク リ ッ ク して、 表示されるコマン

ドを確認します。 特に、 次のコマンドに注目してください。

♦ [Add IP] : 選択した IP をデザインに追加します。

♦ [View PDF Datasheet] : IP のデータシート を開きます。

♦ [View IP Modifications (Change Log)] : IP の変更履歴を開きます。 

9. [Communication Low-Speed] の横にあるプラス記号をク リ ッ ク して展開表示します。

10. [XPS_UART (Lite)] ペリ フェラルを右ク リ ッ ク し、[View PDF Datasheet] をク リ ッ ク してデー

タシート を開きます。

[System Assembly View] 
[System Assembly View] では、 システム ブロ ッ ク  エレ メン ト を表示およびコンフ ィギュレーシ ョ

ンします。 [System Assembly View] がメ イン ウ ィンド ウに表示されていない場合は、ペインの下部

に表示されている  [System Assembly View] タブをク リ ッ ク します。

[Bus Interfaces]、 [Ports]、 および [Addresses] タブ

[System Assembly View] には 3 つのペインがあ り、上部のタブをク リ ッ クするこ とによ り表示を切

り替えます。

• [Bus Interfaces] : デザインのバスを表示します。 このビューから各バスの情報および接続を変

更できます。

• [Ports] : デザインのポート を表示します。 このビューから各ポートの詳細を変更できます。

• [Addresses] : デザインの各 IP インスタンスのアドレス範囲を表示します。 [Generate 
Addresses] をク リ ッ クする と、 システム アドレス  マップを自動的に生成できます。
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バス接続パネル 

[Bus Interface] タブを選択している と、 その左側にバス接続パネルが表示されます (18 ページの図

3-1 の 4)。 これは、 ハードウェア プラ ッ ト フォーム接続のグラフ ィカル表示です。

縦の線はバスを表し、 横の線は IP コアへのバス  インターフェイスを表します。 接続が可能な場合、

バスと  IP コアのバス  インターフェイスの交差点にコネクタ  シンボルが表示されます。

線と コネク タは、 互換性を示すために色分けされています。 コネク タ  シンボルの形によ り、 IP ブ
ロ ッ クがバス  マスタであるかバス  スレーブであるかが示されます。 塗りつぶされていないコネク

タは接続可能である こ と を示し、 塗りつぶされているコネク タは接続されているこ とを示します。

コネク タ  シンボルをク リ ッ クする と、 接続/接続解除を切り替えるこ とができます。

フ ィルタ  パネル

XPS には、[System Assembly View] での [Bus Interfaces] および [Ports] タブの表示を制御するフ ィ

ルタがあ り ます。 これらのフ ィルタは、[Bus Interfaces] または [Ports] タブを選択したと きにフ ィル

タ  パネル (18 ページの図 3-1 の 6) にリ ス ト されます。 これらのフ ィルタを使用する と、多数のバス

を含むデザインで接続パネルの表示を簡潔にするこ とができます。

表示切り替えボタン

デザイン情報を並べ替え、デザインを編集しやすくするため、[System Assembly View] にはデータ

の表示方法を変更する  2 つのボタンがあ り ます (18 ページの図 3-1 の 5)。

• [Change to Hierarchical View]/[Change to Flat View] ボタン

♦ Hierarchy View では、デザイン情報がハード ウェア プラ ッ ト フォーム上の IP コア インス

タンスごとにグループ化され、 ツ リー形式で表示されます。 これがデフォルト表示です。

♦ Flat View では、 いずれかの列のアルファベッ ト順に情報を並べ替えるこ とができます。

• [Expand All Tree Nodes]/[Collapse All Tree Nodes] ボタン

IP に関連付けられているネッ ト またはバスをすべて一度に展開表示または非表示にし ます。

コンソール ウィンドウ

コンソール ウ ィンド ウ  (18 ページの図 3-1 の 3) には、起動したツールからのランタイムの出力が表

示されます。 [Console]、 [Warnings]、 および [Errors] の 3 つのタブがあ り ます。

チュート リアル :  [System Assembly View]
1. [System Assembly View] 上部の [Ports] タブをク リ ッ ク します。

2. [External Ports] の横にあるプラス記号をク リ ッ ク して展開表示し、FPGA デバイス外部の信号

を表示します。 

3. 信号名は [Net] 列に表示されています。 RS232_Uart_1 ポートに関連する信号を見つけます。

必要に応じて [Net] 列ヘッダの右端を右にド ラ ッグして列幅を広げ、 内容がすべて表示される

よ うにしてください。 これらの信号を次の手順で参照します。 [External Ports] の横にあるマイ

ナス記号をク リ ッ ク して信号を非表示にします。

4. [RS232_Uart_1] ペリ フェラルの横にあるプラス記号をク リ ッ ク して展開表示します。

ネッ ト名が外部信号の名前と対応しているこ とを確認します。 UART からの RX および TX 
ネッ トは、 外部ポート と名前によ り関連付けられています。
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5. [RS232_Uart_1] ペリ フェラルを右ク リ ッ クし、 [Configure IP] をク リ ッ ク して IP コンフ ィ

ギュレーシ ョ ン ダイアログ ボッ クスを開きます。 システムのすべてのペリ フェラルに対して

同様のコンフ ィギュレーシ ョ ン ダイアログ ボッ クスを開く こ とができます。

a. パラ メータ名の上にカーソルを置く と何が起こるかを確認します。

b. ダイアログ ボッ クスの上部に、 3 つのボタンと  3 つのタブがあるこ とを確認します。

c. 終了したら、 このダイアログ ボッ クスを閉じます。

6. [Change to Hierarchical View]/[Change to Flat View] ボタンをク リ ッ ク して表示がどのよ うに

変化するかを観察します。

[Start Up Page]

[Start Up Page] には、リ リース情報へのリ ンク、ソフ ト ウェアおよびハードウェア デザイン フロー

へのリ ンクなど、XPS のご使用のバージ ョ ンに関する情報が表示されます。 また、EDK のマニュア

ルにアクセスするためのタブもあ り ます。 少し時間をとって [Start Up Page] の内容を確認してくだ

さい。

チュート リアル :  [Start Up Page] の内容の確認

このチュート リ アルでは、 [Start Up Page] の内容を確認します。

1. XPS のメ イン ウ ィンド ウで [Start Up Page] タブをク リ ッ ク します。 [Start Up Page] タブが表

示されていない場合は、 [Help] → [View Start Up Page] をク リ ッ ク します。

2. [New This Release] タブで [Redesigned interface improves project handoff and portability
between hardware and software teams] リ ンクをク リ ッ ク します。 以前のバージ ョ ンの XPS を
使用していた場合、新機能について学ぶこ とができます。 ほとんどの新機能は、このマニュアル

のチュート リ アルで扱います。

XPS ツール

XPS には、ソフ ト ウェア インターフェイスに加え、エンベデッ ド  プロセッサ システムのハードウェ

アおよびソフ ト ウェアのコンポーネン ト を開発するのに必要なツールも含まれています。

• Base System Builder (BSB) ウ ィザード  : 新規プロジェク ト を作成します。 BSB ウ ィザードは

XPS の起動時に表示される  [Xilinx Platform Studio] ダイアログボッ クスから起動できます。こ

のダイアログ ボッ クスは、 [File] → [New Project] をク リ ッ ク しても開きます。

• Platform Generator (Platgen) : エンベデッ ド  プロセッサ システムのハード ウェア プラ ッ ト

フォームを生成します。 Platgen を起動するには、 [Hardware] → [Generate Netlist] をク リ ッ ク

します。

• Simulation Model Generator (Simgen) : オリ ジナルのエンベデッ ド  ハード ウェア  デザイン  
(ビヘイビア  レベル) または完成した  FPGA インプリ メ ンテーショ ン  (タイ ミ ング  レベル) の
いずれかに基づいて、エンベデッ ド  ハード ウェア  システムのシミ ュレーショ ン  モデルを生成

します。Simgen を起動するには、 [Simulation] → [Generate Simulation HDL Files] をク リ ッ

ク します。

• Create and Import Peripheral (CIP) Wizard : 独自のペリ フェラルを作成し、EDK 準拠のレポジ

ト リ または XPS プロジェク トにインポート します。 このウ ィザードを起動するには、

[Hardware] → [Create or Import Peripheral] をク リ ッ ク します。

http://japan.xilinx.com
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• Library Generator (Libgen) : エンベデッ ド  プロセッサ システム用にライブラ リ、 デバイス ド
ライバ、 ファ イル システム、 および割り込みハンド ラを設定します。 Libgen を起動するには、

[Software] → [Generate Libraries and BSPs] をク リ ッ ク します。

チュート リアル :  XPS ツールにアクセスするメニュー コマンド
上記の XPS ツールには、[Hardware]、[Software]、[Simulation] メニューからアクセスできます。 各
メニューをク リ ッ ク して、 どのよ う なコマンドがあるかを確認してください。

XPS のディレク ト リ構造

前の章で開始したチュート リ アル デザインでは、 BSB ウ ィザードによ りプロジェク ト  ディ レク ト

リ構造が自動的に設定され、単純で完全なプロジェク トが作成されました。 ただし、ツールでどのよ

う な処理が実行されているのを理解しなければ、 BSB ウ ィザードによるプラ ッ ト フォームのコン

フ ィギュレーシ ョ ンで短縮された時間が無駄になり ます。 BSB ウ ィザードで作成されたディ レク

ト リ構造が、 プロジェク トの開発プロセスでどのよ うに有益であるかを見てみます。

メモ : ファ イルは、 プロジェク ト  ファ イルを作成したディ レク ト リに保存されています。

X-Ref Target - Figure 3-4

図 3-4 : ファイル ディ レク ト リ構造

http://www.xilinx.com
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XPS のディレク ト リ構造

ディ レク ト リ

BSB ウ ィザードでは、レポジ ト リ検索パスにいくつかのディレク ト リが自動的に作成されます。エ

ンベデッ ド  システム ソースの名前でプロジェク ト  ディ レク ト リが作成され、 そのディ レク ト リに

これらのサブディ レク ト リが含まれます。 これらのディ レク ト リは、 次のとおりです (図 3-4)。

次の 2 つのディ レク ト リには、 BSB ウ ィザードで生成されたファイルが含まれます。 

• TestApp_Memory_microblaze_0 

• TestApp_Peripheral_microblaze_1

これらのディ レク ト リには、 テス ト  アプリケーシ ョ ン C ソース  コード、 ヘッダ ファ イル、 および

リ ンカ スク リプ トが含まれます。 これらのファイルを使用するこ と もできますが、 このマニュアル

では SDK で作成したサンプル アプリケーシ ョ ンを使用します。 これについては、 この後の章で説

明します。

メ イン プロジェク ト  ディレク ト リには、 次のファイルも含まれています。

MHS と  MSS ファ イルは XPS で生成される主なファイルで、ハード ウェアおよびソフ ト ウェア シ
ステム全体がこれら  2 つのファイルで表されます。

__xps XPS およびその他のツールで内部プロジェク ト管理用に生成される中間

ファイルが含まれます。 このディ レク ト リは使用できません。

blockdiagram ブロ ッ ク  ダイアグラムに関連するファイルが含まれます。

data ユーザー制約ファイル (UCF) が含まれます。 このファ イルの詳細と使用方

法は、 次のサイ トから  ISE の UCF に関する資料を参照して ください。

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx11/
manuals.pdf

etc ツールの実行に使用されるオプシ ョ ンを設定するフ ァ イルが含まれます。

BSB ウ ィザード以外で操作を実行していないので、 このディ レク ト リは空

です。

pcores カスタム ハードウェア ペリ フェラルで使用されます。 

system.xmp 最上位プロジェク ト  ファ イルです。 XPS はこのファイルを読み込み、 ユー

ザー インターフェイスにその内容を図で表示します。 

system.mhs マイク ロプロセッサ ハードウェア仕様で、システム エレ メン ト、パラ メータ、

および接続をテキス ト形式で記述します。 MHS ファ イルは、 プロジェク トの

ハードウェア部分の基盤となり ます。

system.mss デザインのソフ ト ウェア部分を表すマイク ロプロセッサ ソフ ト ウェア仕様

で、システム エレ メン ト 、ペリ フェラルと関連付けられているソフ ト ウェア パ
ラ メータをテキス ト形式で記述します。 MSS ファ イルは、 プロジェク トのソ

フ ト ウェア部分の基盤となり ます。

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx11/manuals.pdf
http://japan.xilinx.com
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チュート リアル :  ディ レク ト リ構造

このチュート リ アルでは、 XPS のディ レク ト リ構造を見てみます。

1. Windows エクスプローラなどのファイル エクスプローラ  ユーティ リ ティで、 プロジェク トの

最上位ディ レク ト リに移動します。 

2. さまざまなサブディ レク ト リ を開き、 どのよ う なファ イルがあるかを確認します。

次の操作

これで、XPS の GUI のナビゲーシ ョ ン方法を理解でき、前の章で開始したプロジェク ト を操作する

準備ができました。 第 4 章 「エンベデッ ド  プラ ッ ト フォームの操作」 に進みます。

http://www.xilinx.com
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エンベデッ ド  プラッ ト フォームの操作

ハードウェア プラッ ト フォームの概要

エンベデッ ド  ハード ウェア プラ ッ ト フォームは、 1 つまたは複数のプロセッサ、 さまざまなペリ

フェラル、およびメモリ  ブロ ッ クで構成されています。 これらの IP ブロッ クは、インターコネク ト

ネッ ト ワークを使用して接続されます。 また、 システム外部と接続するために追加ポートが使用さ

れます。 各プロセッサまたはペリ フェラル コアの動作は、 カスタマイズできます。 インプ リ メン

テーシ ョ ン パラ メータはオプシ ョ ンの機能を制御し、FPGA に最終的に何をインプ リ メン トするか

を指定します。 インプ リ メンテーシ ョ ン パラ メータは、 システムのアドレスも定義します。

XPS でのハードウェア プラッ ト フォーム開発

MHS フ ァ イルに
ついて 

Xilinx® Platform Studio (XPS) では、対話型の開発環境を使用してハード ウェア プラ ッ ト フォーム

を詳細に設定できます。 ハードウェア プラ ッ ト フォーム記述は、 MHS (Microprocessor Hardware
Specification) ファ イルで管理されます。 MHS ファ イルは、 編集が簡単なテキス ト  ファ イルで、 エ

ンべデッ ド  システムのハード ウェア コンポーネン ト を記述した主要ソース  ファ イルです。 XPS で
は MHS ソース  ファ イルが HDL ネッ ト リ ス トに合成され、 このネッ ト リ ス トがインプ リ メンテー

シ ョ ン プロセスで処理されます。

MHS ファ イルは、 デザイン プロセスに必要不可欠です。 すべてのペリ フェラル インスタンシエー

シ ョ ンとそのパラ メータが含まれます。 バス  アーキテクチャ、ペリ フェラル、プロセッサ、接続、ア

ドレス空間などを含む、 エンベデッ ド  プロセッサ システムのコンフ ィギュレーシ ョ ンを定義する

ファイルです。 MHS ファイルの詳細は、次のサイ トから 『Platform Specification Format Reference
Manual』 の 「Microprocessor Hardware Specification (MHS)」 の章を参照して ください。

http://japan.xilinx.com/ise/embedded/edk_docs.htm

チュート リアル :  MHS ファイル

こ のチュート リ アルでは、 BSB ウィ ザード を実行したと きに作成さ れた  MHS ファ イルを見てみ

ます。

1. XPS ソフ ト ウェアのプロジェク ト情報エリ アで、 [Project] タブをク リ ッ ク します。

2. [Project Files] の下にある  [MHS File: system.mhs] をダブルク リ ッ ク して開きます。

3. [Edit] → [Find] をク リ ッ ク し、 表示された検索ツールバーを使用して system.mhs で

「xps_uartlite」 を検索します。

MHS ファ イルでペリ フェラル、ポート、およびパラ メータがどのよ うに設定されているかを見

ます。

4. デザインのその他の IP コアも見てみます。 終了したら、 system.mhs ファ イルを閉じます。

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=edk+docs
http://japan.xilinx.com
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[System Assembly View] でのハードウェア プラッ ト フォーム

[System Assembly View] には、すべてのハードウェア プラ ッ ト フォーム IP インスタンスがツ リー

ビューの表形式で表示されます。

この表示は、カスタマイズした り、並び替えたり、フ ィルタをかけたり して、見やすくできます。 IP
エレ メン ト 、ポート、プロパティ、およびパラ メータは [System Assembly View] で設定でき、MHS
ファ イルに直接記述されます。

ポート名の変更およびパラ メータの設定は、 Enter キーを押すか [OK] をク リ ッ クする と反映され、

MHS ファ イルのハードウェア データベースにシステム変更が自動的に記述されます。 MHS ファ

イルを編集するには、 [System Assembly View] を使用するこ とをお勧めします。

メモ : IP の追加、 削除、 カスタマイズについては、 第 7 章 「独自の IP の作成」 で説明します。

ハードウェア プラッ ト フォームの生成

ハードウェア プラ ッ ト フォームの生成には、3 つの操作があ り ます。 まず XPS でネッ ト リ ス ト を生

成し、 ISE® ツールでデザインをインプ リ メン ト  (FPGA ロジッ クにマップ) した後、 最後にインプ

リ メン ト されたデザインを FPGA にダウンロード可能なビッ ト ス ト リームに変換します。

ネッ ト リス トの生成

XPS でネッ ト リ ス ト を生成する と、 プラ ッ ト フォーム構築ツールである  Platgen が起動し、 次の処

理が実行されます。

♦ デザインのプラ ッ ト フォーム コンフ ィギュレーシ ョ ンである  MHS ファ イルが読み込ま

れます。

♦ MHS ファイルの HDL 記述が生成され、 system.[vhd|v] および system_stub.[vhd|v]
に記述されます。 system ファイルは、MHS 記述が HDL フォーマッ ト で記述されたものです。

system_stub ファ イルは最上位 HDL テンプレート  ファ イルで、プロセッ サ システムをコ

ンポーネント と して  HDL ベース  デザインにインスタンシエート する場合に使用します。 

♦ XST (Xilinx Synthesis Technology) を使用してデザインが合成されます。

♦ ネッ ト リ ス ト  ファ イルが生成されます。

Platgen の詳細は、 次のサイ トから 『エンベデッ ド  システム ツール リ ファレンス  マニュアル』 の

「Platform Generator (Platgen)」 の章を参照して ください。

http://japan.xilinx.com/ise/embedded/edk_docs.htm

ハードウェア プラッ ト フォームのエクスポート

エンベデッ ド 開発キッ ト  (EDK) では、ハード ウェア  プラッ ト フォームは XPS で設計し、ソフト ウェ

アはソフト ウェア開発キッ ト  (SDK) で開発およびデバッ グします。 ハード ウェア  プラッ ト フォーム

に関する情報は SDK で必要なので、 system.xml と いう ファ イルをエクスポート します。

system.xml フ ァ イル system.xml ファ イルには、 設計したハードウェア プラ ッ ト フォームでソフ ト ウェア開発および

デバッグを行うために SDK で必要な情報が含まれます。

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=edk+docs
http://www.xilinx.com
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[System Assembly View] でのハードウェア プラッ ト フォーム

チュート リアル :  ハードウェア プラッ ト フォームの SDK へのエクスポート

1. XPS ソフ ト ウェアで、 [Project] → [Export Hardware Design to SDK] をク リ ッ ク します。

2. デフォルトの保存ディ レク ト リ を使用するこ とをお勧めします。 デフォルトの保存ディ レク ト

リ を使用する場合、 system.xml ファ イルへのリポジ ト リ検索パスはプロジェク ト  ディ レク

ト リの system\SDK\SDK_Export\hw\.. になり ます。

メモ : XPS で使用される  XML ファ イルはほかにもあるので、使用する  XML ファ イルの場所

を知っておく こ とが重要です。

3. [Export Only] をク リ ッ ク します。 この後の章のチュート リ アルで、 SDK を実行します。

実行された処理

エクスポート処理を詳細に理解しておく こ とは、特に複数のハード ウェア バージ ョ ンを管理してい

る場合に重要です。

[Export Only] をク リ ッ クする と、SDK で使用される多数のファイルが作成されます。 XML ファ イ

ルに加え、 ソフ ト ウェア ド ラ イバおよびハード ウェア IP の資料も含まれており、 SDK から必要な

情報にアクセスできます。

も う  1 つのボタン [Export & Launch SDK] をク リ ッ クする と、既存の XML ファ イルが上書きされ

ます。 エクスポート  ディ レク ト リにビッ ト ス ト リーム (BIT) ファ イルおよびブロ ッ ク  メモ リ  マッ

プ (BMM) ファ イルが存在する場合はそれらは消去され、エクスポートするプロジェク トに BIT お
よび BMM が含まれる場合は、 これらがエクスポート  ディ レク ト リ保存されます。 これによ り、エ

クスポート  ディ レク ト リに最新のハード ウェア ファ イルのみが含まれるよ うにな り ます。

チュート リアル :  ビッ トス ト リームの生成

XPS での処理が正常に完了したら、 ISE Project Navigator を使用してデザインをインプ リ メン ト

し、 ビッ ト ス ト リームを生成できます。

ISE Project 
Navigator を使用
したデザインの
インプリ メ ン ト

Project Navigator は生成されたネッ ト リ ス ト とユーザー制約ファイル (UCF) を読み込み、 ハード

ウェア デザインを含む BIT ファ イルを生成します。 コンパイルされた C コードはビッ ト ス ト リー

ムには含まれず、 後で SDK を使用して追加します。

http://japan.xilinx.com
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1. Project Navigator のメ イン ウ ィンド ウを見ます。 [Design] パネルの表示は、次のよ うになって

いるはずです。

ビ ッ ト ス ト リームの
生成および UCF 
フ ァ イルの作成

ビッ ト ス ト リームを生成する前に、 ピン配置や実行速度など、 ISE 配置配線ツール (PAR) で使

用されるデザインに関する情報を追加する必要があ り ます。

これらの情報は、 UCF ファ イルに含まれます。 BSB を実行する と、 UCF ファ イルが生成され

ます。

2. Project Navigator で [Project] → [Add Source] をク リ ッ ク し、 プロジェク ト  ディ レク ト リの

system\data にある  system.ucf ファ イルを追加します。

この手順は、 XMP ソースが ISE プロジェク トの最上位デザインである場合にのみ必要です。

XMP を VHDL または Verilog ファ イルにインスタンシエートする場合は、 ISE によ り  EDK
UCF ファ イルが管理されます。

3. [Adding Source Files] ダイアログ ボッ クスが表示され、UCF ファ イル処理の進行状況が表示さ

れます。 ファ イル処理が完了したら、 [OK] をク リ ッ ク します。

X-Ref Target - Figure 4-1

図 4-1 : ISE Project Navigator の [Design] パネル

http://www.xilinx.com
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次の操作

[Design] パネルの [Hierarchy] ペインの表示は、 次のよ うにな り ます。

system.ucf ファイルが追加され、エンベデッ ド  システム デザイン (system.xmp) に関連付

けられています。

EDK system.bit およ
び BmmFile_bd.bmm 
フ ァ イル

4. [Design] パネルの [Processes] ペインで [Generate Programming File] をダブルク リ ッ ク しま

す。 この処理には数分かかり ます。処理が完了する と、 [Console] パネルに 「Process "Generate
Programming File" completed successfully」 という メ ッセージが表示されます。

生成されたビッ ト スト リ ームの名前は system.bit です。 これ以外に edkBmmFile_bd.bmm
と いう ファ イルも生成されます。このファ イルは、 SDK でターゲッ ト  ボード にメ モリ を読み込

むために使用されます。 

これらのファイルとそのディ レク ト リ  (ハード ウェア プロジェク トのルート  ディ レク ト リ ) を覚え

ておきます。 これらのファイルは、 この後の章で使用します。

次の操作

SDK を使用して、 プロジェク トのソフ ト ウェアを開発します。 次の 2 章で、 エンベデッ ド  ソフ ト

ウェア設計の基礎を説明します。

X-Ref Target - Figure 4-2

図 4-2 : system.xmp と  system.ucf ファイル

http://japan.xilinx.com
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ソフ トウェア開発キッ ト

ザイ リ ンクス  ソフ ト ウェア開発キッ ト  (SDK) は、エンベデッ ド  ソフ ト ウェア アプリ ケーシ ョ ン プ
ロジェク ト を開発するためのツールで、 Eclipse オープン ソース標準に基づく独自のソフ ト ウェア

です。 SDK は XPS に補足的に使用するプログラムで、 XPS でデザインに組み込んだペリ フェラル

およびプロセッサ エレ メン トで使用するソフ ト ウェアを開発します。

SDK について

ハードウェア プラ ッ ト フォーム、 ソフ ト ウェア プラ ッ ト フォーム、 ソフ ト ウェア プロジェク ト、

パースペクティブ、 ビューなどの SDK で使用される用語を理解しておく必要があ り ます。

SDK の用語 ハードウェア プラ ッ ト フォームとは、 XPS で作成され、XML ファ イルの形でエクスポート された

エンベデッ ド  ハードウェア デザインです。 XML ファ イルを SDK にインポートする という こ とは、

ハードウェア プラ ッ ト フォームをインポートする という こ とです。 1 つの SDK プロジェク トに対

して、 ハードウェア プラ ッ ト フォームを  1 つのみ含むこ とができます。

ハードウェア プラ ッ ト フォームをインポート したら、 ソフ ト ウェア プラ ッ ト フォームを作成しま

す。 ソフ ト ウェア プラ ッ ト フォームは、アプ リ ケーシ ョ ン ソフ ト ウェア スタ ッ クの最下位層を構成

するソフ ト ウェア ド ラ イバおよび OS をまとめたものです。 ソフ ト ウェア アプリ ケーシ ョ ンは、ア

プ リケーシ ョ ン プログラム インターフェイス  (API) を使用して、 指定のソフ ト ウェア プラ ッ ト

フォームにリ ンクするか、ソフ ト ウェア プラ ッ ト フォーム上で実行する必要があ り ます。 そのため、

SDK でソフ ト ウェア アプリケーシ ョ ンを作成および使用する前に、 ソフ ト ウェア プラ ッ ト フォー

ム プロジェク ト を作成する必要があ り ます。 SDK には、 次の 2 つのソフ ト ウェア プラ ッ ト フォー

ム タイプが含まれます。

SDK のソフ ト ウェア 
プラ ッ ト フ ォーム 
タ イプ

• standalone : 標準入力/出力、プロセッサ ハードウェア機能へのアクセスなどの基本的な機能を

提供する単純なセミホス ト型シングル スレッ ド環境 

• xilkernel : スケジューリ ング、スレッ ド、同期化、メ ッセージ パッシング、タイマなどの POSIX
型サービスを提供する単純な軽量カーネル 

1 つの SDK プロジェク トには、複数のソフ ト ウェア プラ ッ ト フォームを含めるこ とができます。 た
とえば、standalone 用にセッ ト アップされたソフ ト ウェア プラ ッ ト フォームと  xilkernel 用にセッ ト

アップされたソフ ト ウェア プラ ッ ト フォームを含めるこ とができます。 

ソフ ト ウェア プラ ッ ト フォームには、ソフ ト ウェア プロジェク トが含まれます。 ソフ ト ウェア プロ

ジェク トはアプ リケーシ ョ ンです。 1 つのソフ ト ウェア プラ ッ ト フォームに複数のソフ ト ウェア プ
ロジェク ト を含むこ とができます。
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パースペクテ ィ ブと
ビュー

SDK は、 実行する操作によってソフ ト ウェアのインターフェイスが変化します。 C または C++
コードを開発する場合はコード開発用のウ ィンド ウが表示され、 ハードウェア上でコードをデバッ

グする場合はデバッグ用のウ ィンド ウが表示されます。 コードをプロファ イルする際は、 また別の

ウ ィンド ウが表示されます (このマニュアルでは説明しません)。 EDK でのプロファイルの詳細は、

『EDK Profiling User Guide』 を参照して ください。 これらの異なるウ ィンド ウ  セッ トの表示をパー

スペクティブと呼び、 各パースペクティブの各ウ ィンド ウをビューと呼びます。

ワークスペースの左上にあるタブをク リ ッ クするだけで、 簡単にパースペクティブを切り替えるこ

とができます。 このパースペクティブが、 SDK にさらなる機能と柔軟性を与えています。

チュート リアル :  ハードウェア プラッ ト フォームのインポート

1. デスク ト ップで [Xilinx SDK 11] アイコンをダブルク リ ッ クするか、 [スタート ] → [プログラム ]
→ [Xilinx ISE Design Suite 11] → [EDK] → [Xilinx Software Development Kit] をク リ ッ ク し

ます。

2. ワークスペースを指定します。 場所はどこでもかまいません。 プロジェク トのルート  ディ レク

ト リか SDK での作業を実行するディ レク ト リ を指定してください。

注意 : パスにスペースが含まれていないこ とを確認して ください。

3. 前の章でエクスポート したハードウェア デザインを指定します。 これは XML ファ イル

(system.xml) で、 コードが実行されるエンベデッ ド  プラ ッ ト フォームが記述されています。

4. 次のメ ッセージが表示されます。 [OK] をク リ ッ クする前に、このメ ッセージの内容を確認して

ください。SDK でのプロジェク ト操作について説明されています。 メ ッセージの内容は、次の

とおりです。

ハードウェア デザインが読み込まれたので、 ソフ ト ウェア プロジェク ト を作成できます。

C または C++ アプリケーシ ョ ン プロジェク ト を作成する前に、 ソフ ト ウェア プラ ッ ト

フォーム プロジェク ト を作成する必要があ り ます。 ソフ ト ウェア プラ ッ ト フォーム プロ

ジェク ト を作成するには、 [File] メニューの下にある  [New] ボタンをク リ ッ ク し、

[Software Platform] を選択します。

ザイ リ ンクス  ソフ ト ウェア開発キッ ト  (SDK) のチュート リ アルは、 [Help] → [Cheat
Sheets] をク リ ッ ク してください。SDK のオンライン ヘルプは、[Help] → [Help Contents]
をク リ ッ クするか、 [Welcome] ページで [SDK] アイコンをク リ ッ ク して ください。

X-Ref Target - Figure 5-1

図 5-1 : [Next Steps] ダイアログ ボックス

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&ver=11.1&topic=sw+manuals&sub=edk_prof.pdf
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&ver=11.1&topic=sw+manuals&sub=edk_prof.pdf
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SDK が開き、次の図に示すよ うに [C/C++ Projects] ビューが表示されます。  microblaze_0
は、 ハードウェア プラ ッ ト フォームの MicroBlaze™ プロセッサを表します。

チュート リアル :  ソフ トウェア プラッ ト フォームの作成

作成したハードウェア プラ ッ ト フォームに対応するソフ ト ウェア プラ ッ ト フォームを作成します。

1. [File] → [New] → [Project] をク リ ッ ク し、 [Software Platform] を選択します。

1 つのエンベデッ ド  デザインに、複数のソフ ト ウェア プラ ッ ト フォームを含めるこ とができま

す。 このチュート リ アルで作成するのは、 standalone プロジェク トです。

メモ : ハードウェア プラ ッ ト フォームに複数のマイクロプロセッサが含まれる場合、各マイ ク

ロプロセッサが [Processor] ド ロ ップダウン リ ス トに表示されます。

2. 次のよ うに設定します。

♦ [Project name] :  SW_Platform_1

♦ [Processor] :  [microblaze_0 (microblaze)] 

♦ [Platform Type] :  [standalone]

♦ [Project Location] :  [Use default] をオン

3. [Finish] をク リ ッ ク します。

実行された処理

SDK によ り、 ハードウェア仕様ファイル (system.xml) と選択したソフ ト ウェア プラ ッ ト フォー

ムのタイプが読み込まれ、ハード ウェア プラ ッ ト フォームのコンポーネン トに対応するライブラ リ

がコンパイルされます。 このプロセスのログを [Console] ビューで確認できます。 

X-Ref Target - Figure 5-2

図 5-2 : ハードウェア プラッ ト フォームを含む [C/C++ Projects] ビュー
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ソフト ウェア  プラッ ト フォームのド ライバと ライブラ リ のリ スト を表示するには、 [SW_Platform_1]
を右ク リ ッ ク して  [Software Platform Settings] をク リ ッ ク します。 左側のボッ クスで [Software
Platform]、 [OS and Libraries]、 [Driver] を選択すると 、それぞれソフト ウェア  プラッ ト フォーム、OS
と ライブラリ 、ド ライバが表示されます。 このダイアログ  ボッ クスでコンフィ ギュレーショ ンを変更

できます。

次の図に示すよ うに、[C/C++ Projects] タブで [SW_Platform_1] の下にある  [microblaze_0] を展開

表示します。 code、 include、 lib、および libsrc フォルダに、エンベデッ ド  デザインのハード

ウェアのライブラ リすべてが含まれます。

いずれかのファイルをダブルク リ ッ クする と、 SDK エディ タ  エリアに表示されます。

チュート リアル :  ソフ トウェア環境の設定

前の章で作成したエンベデッ ド  プロセッサ デザインをターゲッ ト とするコードを記述する環境を

設定しました。

このチュート リ アルでは、Software_Platform_1 用の Managed C アプリ ケーシ ョ ン プロジェク

ト を作成します。

X-Ref Target - Figure 5-3

図 5-3 : ソフ トウェア ディ レク ト リ  ツリー
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1. [File] → [New] → [Managed Make C Application Project] をク リ ッ ク します。

使用可能なサンプル アプリ ケーシ ョ ンが複数あ り ます。 まず Hello World サンプル アプリケー

シ ョ ンを使用します。

2. [Create a new Managed Make C project] ページで次のよ うに設定します。

♦ [Project Name] :  hello_1

♦ [Software Platform] :  [SW_Platform_1]

♦ [Project Location] :  [Use Default Location for Project] をオン

♦ [Sample Applications] :  [Hello World] を選択

3. [Next] をク リ ッ ク します。

4. [Select a build configuration] ページで次のよ うに設定します。

♦ [Project Type] :  [Xilinx MicroBlaze Executable]

♦ [Configuration] :  すべてのチェッ ク  ボッ ク ス  ([Debug]、[Release]、および [Profile]) をオン

5. [Finish] をク リ ッ ク します。

hello_1 サンプル アプリ ケーシ ョ ンが自動的に構築され、 ターゲッ ト  ハードウェアにダウン

ロード可能な ELF ファ イルが生成されます。

[C/C++ Projects] ビューに、ソフ ト ウェア プラ ッ ト フォームと ソフ ト ウェア プロジェク トに関

する情報が表示されます。どのよ うな情報が表示されているかを確認して ください。このビュー

に、 関連するプロジェク トの管理情報が表示されます。

X-Ref Target - Figure 5-4

図 5-4 : [C/C++ Projects] ビューに表示されるプロジェク ト

http://japan.xilinx.com


38 japan.xilinx.com EDK コンセプ ト、 ツール、 テクニッ ク
UG683 EDK 11.1

第 5 章 : ソフ トウェア開発キッ ト

6. [hello_1] ソフ ト ウェア プロジェク トの下にある  [src] フォルダを展開表示します。

[hello_1 {SW_Platform_1}] とい う表示によ り、 このソフ ト ウェア プロジェク トが

SW_Platform_1 ソフ ト ウェア プラ ッ ト フォーム用に構築されているこ とがわかり ます。

7. [helloworld.c] をダブルク リ ッ ク します。 ファ イルが SDK エディ タ  ウ ィンド ウに開きま

す。 必要に応じて、 サンプル コードを変更したり、 独自のコードを作成したりできます。

このプロジェク ト 用に hello_1.ld リ ンカ  スク リ プト も生成されています。 リ ンカ  スク リ プト は、

ソフト ウェア  コード を読み込むハード ウェア  システム  メ モリ の位置を指定するために必要です。

これで、ソフ ト ウェア プロジェク ト を編集、コンパイル、構築するフレームワークが完了しました。

次のチュート リ アルでデバッグを実行します。

チュート リアル :  SDK でのデバッグ

デバッグとは、C コードをターゲッ ト  ハード ウェアにダウンロード して実行し、 コードが正し く実

行されるかど うかを評価するプロセスです。 FPGA では、FPGA にデザインを読み込むため、FPGA
をビッ ト ス ト リームでコンフ ィギュレーシ ョ ンする手順が追加で必要です。 この場合、 デザインは

エンベデッ ド  プロセッサ システムです。

1. システムをデバッグ用に設定します。

a. USB プログラム ケーブルを接続し、RS232 ケーブルでデモ ボード と コンピュータを接続

します。 デモ ボードがオンになるので、USB ケーブルの LED は緑色に点灯するはずです。

FPGA をビ ッ ト ス ト
リームでコンフ ィギュ
レーシ ョ ン

b. PC でハイパーターミナル (またはその他のターミナル エミ ュレーシ ョ ン プログラム) を
開き、 表示を 9600 ボー、 8 ビッ ト  データ、 1 ス ト ップ ビッ トに設定します。

2. [Tools] → [Program FPGA] をク リ ッ ク します。

3. 開いたダイアログ ボッ クスで、 次のよ うに設定します。

♦ [Bit File] :  プロジェク ト  フォルダに含まれる  system.bit ファ イルを選択

♦ [Bmm File] :  プロジェク ト  フォルダに含まれる  edkBmmFile_bd.bmm ファ イルを選択

♦ [Specify the ELF file to be initialized to each processor's BRAM memory] :  [Processor] が
[microblaze_0]、 [Type] が [microblaze]、 [Initialization ELF] が [BootLoop]

メモ : ハードウェア プロジェク トの設定方法によって、 ファ イル名が異なる場合があ り ます。
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4. [Save and Program] をク リ ッ ク します。 FPGA がビッ ト ス ト リームで正し くプログラムされた

こ とを示すメ ッセージが表示されます。

FPGA ビ ッ ト ス ト リー
ムとブー トループのダ
ウンロード

ビッ ト ス ト リームが FPGA にダウンロード され、 マイ ク ロプロセッサが bootloop という自身

に分岐する命令で初期化されます。 ブートループはプロセッサを既知のステートに保持し、 別

のプログラムがダウンロード されて実行されるかデバッグされるのを待ちます。

FPGA のオンチップ RAM に ELF ファ イルを含める場合は、[Program FPGA] ダイアログ ボッ

クスの [Initialization ELF] フ ィールドで ELF ファ イルを指定します。 こ こでは、ELF ファ イル

を別の手順でダウンロード します。

5. [hello_1.elf] を右ク リ ッ ク し、 [Debug As] → [Debug on Hardware] をク リ ッ ク します。

[Debug] パースペク
テ ィ ブ

パースペクティブが [Debug] に変更されました。

6. [Debug] パースペクティブで、 C コードの最初の実行行がハイライ ト され、 [Debug] ビューに

Thread[0] で main() 関数が自動的に挿入されたブレークポイン トのため 28 行目で停止し

ているこ とが示されます。

7. [Resume] ボタン  をク リ ッ ク してコードを実行します。

X-Ref Target - Figure 5-5

図 5-5 : [Program FPGA] ダイアログ ボックス
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8. [Terminate] ボタン  をク リ ッ ク してデバッグ セッシ ョ ンを停止します。

9. ターミナル ウ ィンド ウで出力を確認します。 終了したら、 SDK を閉じます。 

実行された処理

SDK で実行したコードによ り ターミナル ウ ィンド ウに 「Hello World」 と表示され、SDK を使用し

てソフ ト ウェアが簡単に実行できたこ とがわかり ます。

次の操作

この章では、SDK プロジェク ト を設定し、ターゲッ ト  ボードにビッ ト ス ト リームをダウンロード し

てコードを実行しました。

次の章ではさ らに SDK を使用して、新規ソフ ト ウェア プロジェク ト を作成、 ソース コード管理を

使用、 およびデバッグを実行します。

X-Ref Target - Figure 5-6

図 5-6 : ターミナルの表示
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ザイ リ ンクス  ソフ ト ウェア開発キッ ト  (SDK) は、ソフ ト ウェア開発プロセス全体で使用できます。

ソフ ト ウェア プロジェク トの作成、編集、および構築、 ソフ ト ウェアのターゲッ ト  ハードウェア上

でのデバッグ、 ターゲッ ト  ハードウェア上でのソフ ト ウェアのプロファイル、 ソフ ト ウェアのリ

リース、 ソフ ト ウェアのフラ ッシュ  メモ リへのプログラムなど、 ソフ ト ウェア開発の作業はすべて

SDK で実行できます。

ド ライバ 
SDK での作業を開始する前に、 ザイ リ ンクスが提供する低レベルのソフ ト ウェア ド ライバについ

て知っておく必要があ り ます。 これらのド ライバは、 次のディ レク ト リにあ り ます。

<Xilinx Install>\EDK\sw\XilinxProcessorIPLib\drivers

各ペリ フェラル ド ラ イバに 1 つずつディ レク ト リがあ り、ハードウェアの各部分に対応する ド ライ

バを EDK で使用できます。 このディ レク ト リには、 少な く と も次のものが含まれています。

• ド ライバのソース  コード

• ド ライバに関する  HTML 資料

• ド ライバの使用例

次に進む前に、 これらの重要な情報を確認してください。

SDK のパースペクティブとウィ ンドウのタイプ

前の章で示したよ うに、 SDK にはパースペクティブという異なる画面表示があ り ます。

前の章では、 [C/C++] パースペクティブと  [Debug] パースペクティブで作業を実行しました。 これ

以外に、 も う  1 つ [Profiling] パースペクティブがあ り ます。 どのパースペクティブで作業していて

も、SDK のウ ィンド ウ  システムが優れているこ とがわかり ます。 パースペクティブには、編集ウ ィ

ンド ウ と情報ウ ィンド ウの 2 種類のウ ィンド ウがあ り ます。

C または C++ ソース  コードを含む編集ウ ィンド ウは言語特有であ り、 構文が認識されます。 編集

ウ ィンド ウでアイテムを右ク リ ッ クする と、 そのアイテムに対して実行可能な操作のリ ス トが表示

されます。

情報ウ ィンド ウは特に柔軟性があ り、 必要に応じていくつでも開く こ とができます。 情報ウ ィンド

ウには複数のビューがあるこ とがあ り、 ウ ィ ンド ウ上部のタブをク リ ッ クするこ とによ り切り替え

るこ とができます。

[Debug] パースペク ティ ブのビューには [Disassembly]、[Registers]、[Memory]、および [Breakpoints]
などがあり ます。 これらのビューは、 自由に移動、 ド ラッ グ、 および組み合わせるこ と ができます。
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[Debug] パースペク
テ ィ ブのビュー

[C/C++] または [Debug] パースペクティブで、いずれかのビューをク リ ッ ク して別のウ ィンド ウに

移動してみてください。 ビューが移動先のウ ィンド ウで表示されます。 選択したパースペクティブ

で使用可能なビューを表示するには、 [Window] → [Show View] をク リ ッ ク します。

ウ ィ ンド ウをさまざまに移動してみてください。ワークスペースを自在にカスタマイズできるのは、

SDK の優れた機能の 1 つです。 

チュート リアル :  ソフ トウェアの編集

前の章で、サンプル ソフ ト ウェア モジュールをコンパイルし、デバッグしました。 このチュート リ

アルでは、 さ らに 2 つのサンプル モジュールを実行し、 これら  2 つのルーチンを呼び出すソフ ト

ウェア モジュールを作成します。 複数のソース  ファ イルを含むソフ ト ウェア プロジェク トの管理

方法を学ぶのが目的です。

1. SDK を閉じている場合は、 [スタート ] → [プログラム] → [Xilinx ISE Design Suite 11] →
[EDK] → [Xilinx Software Development Kit] をク リ ッ ク して再起動します。

2. 新規ワークスペースを作成します。

3. 第 5 章 の 「チュート リ アル : ハードウェア プラ ッ ト フォームのインポート 」 の手順に従って、

同じハード ウェア仕様ファイルを使用してハード ウェア  プラッ ト フォームをインポート します。

4. 第 5 章 の 「チュート リ アル : ソフ ト ウェア プラ ッ ト フォームの作成」 の手順に従って新しい

standalone ソフ ト ウェア プラ ッ ト フォームを作成します。 ソフ ト ウェア プラ ッ ト フォームの

名前は editor_exercise_platform にします。

チュート リアル :  Managed Make C アプリケーシ ョ ン プロジェク トの作成

次に、 異なるサンプル アプリ ケーシ ョ ンを関連付けた Managed Make C アプリ ケーシ ョ ン プロ

ジェク ト を 2 つ作成します。 その後、空の C アプリ ケーシ ョ ン プロジェク ト を作成してこれら  2 つ
のファイルを含める方法を学びます。

このよ う な基本的なファイル管理は、 大型のプロジェク トで必要です。 手順が複雑だと感じられる

場合は、 第 5 章のチュート リ アルに戻ってプロジェク トの管理方法を復習して ください。

1. 第 5 章を参照して、Managed Make C アプリケーシ ョ ン プロジェク ト を作成します。 [Memory
Test] サンプル アプリ ケーシ ョ ンを選択します。

2. Managed Make C アプリ ケーシ ョ ン プロジェク ト をも う  1 つ作成します。 このプロジェク トで

は、 [Peripheral Tests] サンプル アプリ ケーシ ョ ンを選択します。
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3. [C/C++ Projects] ビューの表示は、 次のよ うになっているはずです。 両方の C プロジェク ト

(memory_tests および peripheral_tests) が editor_exercise_platform 用に作成さ

れています。

これらの 2 つのアプリ ケーシ ョ ンを実行するには、 前の章と同様に、 FPGA ビッ ト ス ト リーム

をボードにダウンロードする必要があ り ます。

4. [Tools] → [Program FPGA] をク リ ッ ク します。

5. 開いたダイアログ ボッ クスで、 次のよ うに設定します。

♦ [Bit File] :  プロジェク ト  フォルダに含まれる  system.bit ファ イルを選択

♦ [Bmm File] :  プロジェク ト  フォルダに含まれる  edkBmmFile_bd.bmm ファ イルを選択

♦ [Specify the ELF file to be initialized to each processor's BRAM memory] :  [Processor] が
[microblaze_0]、 [Type] が [microblaze]、 [Initialization ELF] が [BootLoop]

メモ : ハードウェア プロジェク トの設定方法によって、 ファ イル名が異なる場合があ り ます。

X-Ref Target - Figure 6-1

図 6-1 : 2 つの C プロジェク ト
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2 つのサンプル プログラムで何が実行されるかを確認するため、 まず memory_tests プロ

ジェク ト を実行し、 その後 peripheral_tests プロジェク ト を実行します。

6. 次の手順に従って、 memory_tests プロジェク ト を実行します。

a. [C/C++ Projects] タブで memory_tests/Binaries の下にある  memory_tests.elf
ファ イルを見つけます。

b. [memory_tests.elf] を右ク リ ッ ク し 、 [Debug As] → [Debug on Hardware] をク リ ッ ク し

ます。

c. [Debug] パースペクティブが開いたら、[Run] → [Resume] をク リ ッ ク してプログラムを実

行します。 ターミナル ウ ィンド ウでプログラムの出力を確認します。

d. [Run] → [Terminate] をク リ ッ ク してデバッグ セッシ ョ ンを終了します。

X-Ref Target - Figure 6-2

図 6-2 : [Program FPGA] ダイアログ ボックス
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7. [C/C++] パースペクティブをク リ ッ ク し、 peripheral_tests C プロジェク トに対して手

順 6 の操作を実行します。

memory_tests および peripheral_tests アプリケーシ ョ ンを実行する と、 ターミナル

ウ ィンド ウの出力は次のよ うになり ます。

8. [Run] → [Terminate] をク リ ッ ク してデバッグ セッシ ョ ンを終了します。

2 つのアプリ ケーシ ョ ンが正し く実行されました。 この後、 これらの 2 つのアプリケーシ ョ ンを呼

び出す 3 つ目のアプリ ケーシ ョ ンを作成します。 SDK では、これを既存のアプリケーシ ョ ンをイン

ポートするこ とによ り実行します。 次のチュート リ アルで、アプリ ケーシ ョ ンをインポート します。

X-Ref Target - Figure 6-3

図 6-3 : ターミナル ウィンドウの出力
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チュート リアル :  複数のソース ファイルでの作業

既存の 2 つのソフ ト ウェア アプリケーシ ョ ンを、3 つ目のアプリケーシ ョ ンで呼び出せるよ うに変

更する必要があ り ます。 各アプリケーシ ョ ンの main() を変更し、 新しい main() 関数で呼び出せ

るよ うにします。

1. [C/C++] パースペクティブで、 memorytest.c および testperiph.c ファ イルをダブルク

リ ッ ク して開きます。

2. memorytest.c で、main() を memorytest_main() に変更します。 53 行目付近にあり ます。

3. testperiph.c で、 main() を peripheraltest_main() に変更します。 46 行目付近にあ

り ます。

X-Ref Target - Figure 6-4

図 6-4 : [C/C++ Projects] タブの 2 つのプロジェク ト
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4. ファ イルを保存します。

保存する と、 ファ イルが自動的に構築されます。 main 関数がないので、 この処理でエラーが発

生します。 関数名を main() に戻せば、 エラーはなくなり ます。

次に、memorytest_main() および peripheraltest_main() 関数を呼び出すモジュールを

作成します。

5. 第 5 章 の 「チュート リ アル : ソフ ト ウェア環境の設定」 を参照して、 Managed Make C アプリ

ケーシ ョ ン プロジェク ト を作成します。 [Empty Application] サンプル アプリケーシ ョ ンを選

択し、 プロジェク ト名を 「top_test」 と します。

6. [File] → [New] → [File] をク リ ッ ク します。[New File] ダイアログ ボッ クスで、[Enter or select
the parent folder] で [top_test] を選択し、 [File name] に 「top_test.c」 と入力してファイル

を作成します。

7. top_test.c ファ イルを開き、 次の図に示すコードを入力します。

8. ファ イルを保存します。 SDK によ り ファ イルが自動的に構築されます。 この自動構築機能は、

[Project] → [Build Automatically] をク リ ッ ク してオン/オフを切り替えるこ とができます。

SDK で memorytest_main() および periphraltest_main() を見つけるこ とができないので、 エ

ラーが発生します。

次に、 memorytest_main() および peripheraltest_main() 関数を top_test プロジェク ト

にインポート し、 top_test ソフ ト ウェア プロジェク トでアクセスできるよ うにします。

X-Ref Target - Figure 6-5

図 6-5 : top_test.c
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1. [File] → [Import] をク リ ッ ク し、 [File system] を選択します。

2. [File system] ページで次の図に示すよ うに設定します。

上図のダイアログ ボッ クスでは、 memory_tests ファ イル システムのインポート方法を指定

しています。 この例では、 インポートする  C ファ イルが各ディ レク ト リに 1 つあるので、 ファ

イル階層全体をインポートする必要はあ り ません。 よ り複雑なプロジェク ト をインポートする

場合は、[Create Complete Folder Structure] をオンにします。 こ こでも このオプシ ョ ンをオンに

できますが、 結果は同じになり ます。

3. peripheral_tests ファ イル システムに対して同じ操作を実行します。

X-Ref Target - Figure 6-6

図 6-6 : ファイル システムのインポート
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これら  2 つのファイル システムをインポート すると 、 top_test.c のエラーがなく なり 、 [C/C++
Projects] タブの表示は次の図に示すよう になり ます。 エラーがなく ならない場合は、 42 ページの

チュート リ アルの手順 2 で作成したファイルがインポート されているかどう かを確認してく ださい。 
X-Ref Target - Figure 6-7

図 6-7 : プロジェク ト  ディ レク ト リ  ツリー
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4. test_top を右ク リ ッ クして [Generate Linker Script] をク リ ッ ク し、アプ リ ケーシ ョ ンのカス

タム リ ンカ スク リプ ト を作成します。

5. top_test.elf ファ イルを右ク リ ッ ク し、 [Debug As] → [Debug on Hardware] をク リ ッ ク し

てアプ リケーシ ョ ンをダウンロードおよび実行し、 正し く実行されるこ とを確認します。 ター

ミナル ウ ィンド ウに、memory_tests および peripheral_tests の両方が正し く機能しているこ と

が示されます。

チュート リアル :  デバッガの使用

このチュート リ アルでは、デバッガの機能を見てみます。 SDK には、ソース  レベル デバッグ機能が

含まれています。 ほかのデバッガを使用したこ とがある場合、SDK デバッガに通常の機能のほとん

どが含まれているこ とがわかり ます。

[Debug] パースペクティブの [Debug] ビューには、デバッグ セッシ ョ ンの状態に関する詳細な情報

が表示されます。

上図では、 呼び出しスタ ッ クが 3 レベルであるこ とがわかり ます。 アドレス  0x000001c8 の

main() によ りアドレス  0x000005ac の peripheraltest_main() が呼び出され、そこからアド

レス  0x0000085c の GpioInputExample() が呼び出されています。 

プログラムは現在停止されており、 ブレークポイン トに達したこ とを意味します。 呼び出しスタ ッ

クの各アイテムには、 呼び出しルーチンのあるコード行も示されています。

ソフ ト ウェアの実行も  [Debug] ビューから制御できます。 [Debug] パースペクティブで [Debug]
ビューの上部にあるボタンの上にマウスを配置する と、 各ボタンの機能が表示されます。

X-Ref Target - Figure 6-8

図 6-8 : [Debug] ビュー
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チュート リアル :  デバッグ出力の観察

このチュート リ アルを開始する前に、 50 ページの 「チュート リ アル : デバッガの使用」 のチュート

リ アルを終了してください。

1. [C/C++ Projects] タブで top_test.elf ファ イルを選択します。 [Run] → [Debug As] →
[Debug on Hardware] をク リ ッ ク し、 top_test.elf ファイルをターゲッ ト  ボードにダウン

ロード します。 ダウンロードが正常に完了する と、 [Debug] パースペクティブが開きます。

2. [Disassembly] や [Memory] など、 必要なビューが表示されていない場合は、 [Window] →
[Show View] をク リ ッ ク してビューを選択して ください。

ビューの位置は、 ド ラ ッグ アンド  ド ロ ップで自由に移動できます。

上図では、 プロセッサ コードは main() の最初にあ り、 プログラムの実行が 26 行目で停止し

ています。 

[Disassembly] ビューを見る と、アセンブリ  レベルのプログラムの実行が 0x000001b8 で停止

しているこ とがわかり ます。

[Registers] ビューを開き、RPC レジスタ  (プログラム カウンタ ) に 0x000001b8 が含まれてい

るこ とを確認します。 [Registers] ビューが表示されていない場合は、[Window] → [Show View]
→ [Registers] をク リ ッ ク します。

3. top_test.c ファ イルの peripheraltest_main() 行の左側のマージンをダブルク リ ッ ク

します。 peripheraltest_main() にブレークポイン トが設定されます。

X-Ref Target - Figure 6-9

図 6-9 : [Debug] パースペクティブ

http://japan.xilinx.com


52 japan.xilinx.com EDK コンセプ ト、 ツール、 テクニッ ク
UG683 EDK 11.1

第 6 章 : SDK での編集およびデバッグ

4. [Breakpoints] ビューでブレーク ポイント が設定されているこ と を確認します。 [Breakpoints]
ビューが表示さ れていない場合は、[Window] → [Show View] → [Breakpoints] をク リ ッ ク し

ます。

5. [Run] → [Resume] をク リ ッ ク してプログラムの実行を再開し、ブレークポイント まで実行しま

す。 [Debug] ビューおよび [Disassembly] ビューから、プログラムの実行が peripheraltest_
main() の行、 アド レス  0x000001c0 で停止したこ と がわかり ます。

6. [Run] → [Step Into] をク リ ッ ク し、 peripheraltest_main() ルーチンに移動します。

peripheraltest_main() ルーチンが実行され、 0x00000580 で停止します。 呼び出しス

タ ッ クは 2 レベルになり ます。

7. [Run] → [Resume] をク リ ッ ク して、 プログラムを最後まで実行します。

プログラムの実行が終了する と、 [Debug] ビューにプログラムが exit ルーチンで停止したこ

とが示されます。 デバッガでプログラムを実行する と、 このよ うになり ます。

8. ターミナル ウ ィンド ウで peripheraltest_main() および memorytest_main() の両方が

実行されたこ とを確認します。

9. コードを数回実行します。 コードを 1 行ずつ実行、メモリやブレークポイン ト を確認、コードを

変更、 print 文を追加するなど、 いろいろ試してみてください。 また、 ビューを追加したり移動

したり してみてください。

これで、 複数のファイルを含む C プログラムを機能させるこ とができました。 また、 デバッガの使

用方法、 SDK のカスタマイズ方法も学びました。

次の操作

次の章では、独自の IP を作成します。 その後の章では、デュアル プロセッサ デザインを作成し、デ

バッグする方法を説明します。
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XPS (Xilinx® Platform Studio) ではデザイン作成のほとんどの操作が自動的に実行されるので、エ

ンベデッ ド  プロセッサ システムを簡単に作成できます。 Base System Builder (BSB) ウ ィザードを

使用する と、 設計にかかる時間と労力を削減できます。

XPS および BSB 
ウ ィザードの利点

BSB ウ ィザードを使用して、 ほとんどのエンベデッ ド  プロセッサ デザインを作成できます。 BSB
ウ ィザードで作成したデザインは、 XPS でカスタマイズできます。 デザインのカスタマイズは、

UART Lite のボー レート を変更するなど既存の IP コアの一部のパラ メータを変更するだけで済む

場合から、 カスタム IP を設計して既存のデザインに組み込む必要がある場合があ り ます。

CIP ウ ィザードの利点 必要なカスタム IP の機能のほかに、CoreConnect™ バス  プロ ト コル、XPS に必要な pcores ディ

レク ト リ構造、バス  ファンクシ ョ ン モデル シ ミ ュレーシ ョ ン フレームワークの作成などを理解す

る必要があ り ます。 この章では、 これらのシステムの特徴を説明し、 Create and Import Peripheral
(CIP) Wizard を使用してカスタム IP を作成する手順を示します。

CIP ウィザードの使用

CIP ウ ィザードには、BSB ウ ィザード と同様の利点があ り ます。 バス  インターフェイス  ロジッ クな

どのデザインのフレームワークを作成し、 カスタム ロジッ クを統合するための HDL テンプレート

を提供します。 カスタム ペリ フェラル コア (pcore) をエンベデッ ド  デザインに含めるために必要な

ファイルは、 すべて CIP ウ ィザードで生成されます。

カスタム IP の作成は、XPS の最も理解されていない機能の 1 つです。 CIP ウ ィザードを使用すれば

pcore フレームワークを簡単に作成できますが、 どのよ う な処理がなぜ実行されるのかを理解する

のは重要です。 この章では基本を説明し、初期プロセスを示します。 また、参照および解析用に完成

した pcore デザインも含まれています。

http://japan.xilinx.com


54 japan.xilinx.com EDK コンセプ ト、 ツール、 テクニッ ク
UG683 EDK 11.1

第 7 章 : 独自の IP の作成

IP 作成の概要

XPS の [System Assembly View] (18 ページの図 3-1) に、バス、プロセッサ、および IP の接続が表

示されます。 作成する  IP は、 設計しているシステムに互換しているこ とが必要です。

互換性のある  IP を作成するには、 次の手順に従います。

1. IP に必要なインターフェイスを特定します。 カスタム ペリ フェラルを接続するバスを特定す

る必要があ り ます。 たとえば、 次のインターフェイスを選択できます。

♦ プロセッサ ローカル バス  (PLB) バージ ョ ン 4.6 :  プロセッサと高パフォーマンス  ペリ

フェラル間の高速インターフェイスです。 PowerPC® および MicroBlaze™ プロセッサ シ
ステムの両方で使用されます。

♦ 高速シンプレッ クス  リ ンク  (FSL) :  ポイン ト  ツー ポイン トの FIFO のよ う なインター

フェイスです。 MicroBlaze プロセッサ デザインで使用でき、PowerPC プロセッサ システ

ムでは通常使用されません。

2. 機能をインプ リ メン ト し、検証します。 EDK ペリ フェラル ライブラ リで使用可能な共通機能を

再利用できるこ とを念頭においてください。

3. スタンドアロン コアを検証します。 コアを分離するこ とによ り、 デバッグが簡単になり ます。

4. IP を EDK にインポート します。 ペリ フェラルを EDK のリポジ ト リ検索パスにコピーする必

要があ り ます。 プラ ッ ト フォーム仕様フォーマッ ト  (PSF) の MPD (Microprocessor Peripheral
Definition) および PAO (Peripheral Analyze Order) ファ イルを作成し、EDK ツールでペリ フェ

ラルが認識されるよ うにします。

5. ペリ フェラルを XPS で作成したプロセッサ システムに追加します。

CIP ウィザードを使用したカスタム IP の作成

CIP ウ ィザードは、カスタム IP を作成、検証、 インプ リ メン トするのに必要な手順の実行を支援し

ます。 また、 XPS でサポート されるバスをサポート します。 

カスタム ロジッ クを直接 PLBv46 バスに接続するのが最も良くあるケースです。CIP ウ ィザードを

使用する と、 バス  プロ ト コルの詳細を理解していなくても簡単にバスを接続できます。 スレーブ接

続とマスタ接続の両方を使用できます。

CIP ウ ィザード で IP 
の HDL テンプレー ト
と  BFM シ ミ ュレー
シ ョ ンを作成

CIP ウ ィザードは、 IP 作成プロセスを順を追って示すこ とによ り、 デザインのインプ リ メンテー

シ ョ ンおよび検証を支援します。 多数のテンプレートが設定され、これを  IP ロジッ ク用に編集でき

ます。

HDL テンプレートの作成に加え、BFM (バス  ファンクシ ョ ン モデル) 検証用に pcore 検証プロジェ

ク ト も作成されます。 テンプレート と  BFM プロジェク トの作成によ り、IP 開発を即座に開始でき、

IP が作成中のシステムに互換するこ とを確実にできます。 BFM シ ミ ュレーシ ョ ンの詳細は、付録 B
「IP バス  ファンクシ ョ ン モデル シ ミ ュレーシ ョ ン」 を参照してください。
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CIP ウィザードの実行前に知ってお くべきこと

CIP ウ ィザードでプロジェク ト を作成する前に、 次の情報を確認します。

CIP ウィザードでサポート されるペリフ ェラル

CIP ウ ィザードでは、定義済みの IP インターフェイス  (IPIF) ラ イブラ リ を使用して、4 種類の PLB
v4.6 ペリ フェラルを作成できます。

• シングル データ  ビート転送用 PLB v4.6 スレーブ

• バース ト  データ転送用 PLB v4.6 スレーブ

• シングル データ  ビート転送用 PLB v4.6 マスタ

• バース ト  データ転送用 PLB v4.6 マスタ

CIP ウ ィザードでは、 高速シンプレッ クス リ ンク  (FSL) ペリ フェラルの作成がサポート されます。

ウ ィザードの [Bus Interface] ページの下部にある  [Enable OPB and PLB v3.4 bus interfaces] をオ

ンにする と、 以前の PLB v3.4 および OPB バスも使用できるよ うにな り ます。

メモ : OPB および PLBv3.4 IP のサポートは、 XPS 12 で削除される予定です。

資料

CIP ウ ィザードを起動する前に、 使用するバス  インターフェイスの資料を参照してください。 資料

に含まれる情報に目を通すこ とによ り、バス  システム インターフェイスの詳細を理解し、混乱を避

けるこ とができます。 CIP ウ ィザードの詳細は、[Help] → [Help Topics] をク リ ッ ク し、XPS ヘルプ

で 「エンベデッ ド  プロセッサの設計手順」 → 「ペリ フェラルの作成と インポート 」 のセクシ ョ ンを

参照してください。 このヘルプに、 CIP ウ ィザードを実行する際に必要な基本的な情報が含まれて

います。

IP データシー トへの
アクセス

XPS には、システムの IP に関連するデータシートが含まれています。 データシートにアクセスする

には、 [Help] → [View Start Up Page] をク リ ッ ク して [Start Up Page] を開き、 [Documentation] タ
ブをク リ ッ ク して [IP Reference and Device Drivers Documentation] を展開表示し、 [Processor IP
Catalog] をク リ ッ ク します。

PLBv4.6 ペリ フェラルを作成する場合は、カスタム ペリ フェラルがスレーブかマスタか、シングル

データ  アクセスかバース ト  データ  アクセスかによって、 次のいずれかのデータシート を参照して

ください。

• plbv46_slave_single

• plbv46_master_single

• plbv46_slave_burst

• plbv46_master_burst

IP インターコネク ト  (IPIC) 信号に関する説明は、カスタム ロジッ クに接続する  IPIF 信号を特定す

るのに役立ちます。

メモ : 次のチュート リ アルで説明するよ うに、CIP ウ ィザードは通常 XPS から起動しますが、XPS
の環境外で実行するこ と も可能です。
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チュート リアル :  テンプレートの生成と保存

このチュート リ アルでは、CIP ウ ィザードを使用してカスタム ペリ フェラル用のテンプレート を作

成します。 簡単にするため、ほとんどの手順ではデフォルト値を使用しますが、設定可能なオプシ ョ

ンをすべて見ていく こ とができます。

注意 : アドバンス  ユーザー以外は、 このチュート リ アルを実行する前に第 4 章 「エンベデッ

ド  プラ ッ ト フォームの操作」 および第 5 章 「ソフ ト ウェア開発キッ ト 」 のチュート リ アルを

完了してください。

1. CIP ウ ィザードを起動し、 カスタム ペリ フェラル ファ イルの保存先を指定します。

a. ISE® Project Navigator を起動し、プロジェク ト を読み込みます。system.xmp を選択し、

[Manage Processor Design (XPS)] プロセスをダブルク リ ッ ク して XPS を起動します。

b. XPS で、 [Hardware] → [Create or Import Peripheral] をク リ ッ ク します。

最初のページで [Next] をク リ ッ クする と、 [Peripheral Flow] ページが開きます。 こ こで、新規

ペリ フェラルを作成するか、 既存のペリ フェラルをインポートするかを指定します。

2. [Create templates for a new peripheral] をオンにします。 次のページに進む前に、このページに

記載されている情報に目を通してください。

メモ : CIP ウ ィザードの各ページには、有益な情報が記載されています。 [More Info] をク リ ッ

クする と、 関連の XPS ヘルプ ト ピッ クが表示されます。

3. [Repository or Project] ページで、カスタム ペリ フェラル ファ イルの保存先を指定します。 この

ペリ フェラルは 1 つのエンベデッ ド  プロジェク トで使用するので、[To an XPS project] をオン

にします。

CIP ウ ィザードを XPS から起動したので、 ディ レク ト リの場所は既に入力されています。

メモ : カスタム pcore を複数のエンベデッ ド  プロジェク トで使用する場合は、ファ イルを  EDK
レポジ ト リに保存できます。 

4. [Next] をク リ ッ ク します。 [Name and Version] ページが表示されます。

http://www.xilinx.com


EDK コンセプ ト、 ツール、 テクニッ ク japan.xilinx.com 57
UG683 EDK 11.1

CIP ウィザードの使用

このページでは、 ペリ フェラルの名前とバージ ョ ンを指定します。

♦ このチュート リ アルでは、 「pwm_lights」 という名前を使用します。

♦ バージ ョ ン番号は自動的に入力されますが、 必要に応じて変更できます。 プロジェク トの

説明も記述できます。

5. [Bus Interface] ページでは、ペリ フェラルをエンベデッ ド  デザインに接続するプロセッサ バス

を選択します。 このチュート リ アルでは、 [Processor Local Bus (PLB v4.6)] をオンにします。

メモ : [Bus Interface] ページから、 関連するデータシートにアクセスできます。

6. [Next] をク リ ッ ク します。 [IPIF (IP Interface) Services] ページが表示されます。

X-Ref Target - Figure 7-1

図 7-1 : [Name and Version] ページ
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このページでは、 CIP ウ ィザードによ り自動的に次のものが作成されます。

♦ PLB バスへのマスタまたはスレーブ接続

♦ 必要なバス  プロ ト コル ロジッ ク

♦ カスタム HDL コードを接続するのに使用する信号セッ ト  

これらの基本的な機能以外に、 オプシ ョ ンのサービスも追加できます。 

[More Info] をク リ ッ ク し、開いたヘルプ ト ピッ クで [IPIF の機能] リ ンクをク リ ッ ク してくだ

さい。 各サービスの詳細を参照して、 その機能が IP で必要かど うかを判断できます。

7. すべてのチェッ ク  ボッ クスをオフにします。 このチュート リ アルでは、 これらのサービスは必

要あ り ません。

次の [Slave Interface] ページでは、 バース トおよびキャ ッシュ  ライン サポート を設定します。

このチュート リ アルではこのサポートは使用しませんが、スレーブ ペリ フェラルおよびデータ

幅に関する記述に目を通してから次のページに進んでください。

8. [Next] をク リ ッ ク します。 [IP Interconnect (IPIC)] ページが表示されます。

X-Ref Target - Figure 7-2

図 7-2 : [IPIF (IP Interface) Services] ページ
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このページには、カスタム ペリ フェラルで使用可能な IPIC 信号が表示されます。 これらの信号

の機能がわからない場合は、 前のページに戻って該当する仕様を参照してください。 選択され

ている信号で、 ほとんどのカスタム ペリ フェラルを適切に接続できます。

このチュート リ アルでは、異なるアドレスへの複数の書き込みをデコードする必要があるので、

HDL 内にデコード  ロジッ クを作成するのに必要な [Bus2IP_Addr] 信号を追加します。

[IPIF (IP Interface) Services] ページで [User logic memory space] をオンにした場合、ユーザー

メモ リ空間を管理するページが開きます。

9. [Bus2IP_Addr] をオンにします。 その他のチェッ ク  ボッ クスは変更しません。

10. [Next] をク リ ッ ク します。 [Peripheral Simulation Support] ページが表示されます。

このページでは、プロジェク トの BFM シ ミ ュレーシ ョ ン プラ ッ ト フォームを生成するかど う

かを指定します。 BFM シ ミ ュレーシ ョ ン プラ ッ ト フォームを生成するには、 次が必要です。

♦ EDK 用の BFM シ ミ ュレーシ ョ ン パッケージがダウンロードおよびインス トールされて

いる。

♦ ModelSim SE または PE がインス トールされている。

X-Ref Target - Figure 7-3

図 7-3 : [IP Interconnect (IPIC)] ページ
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[BFM Package Installation Instructions] リ ンクをク リ ッ クする と、 BFM のライセンスを取得

し、ダウンロードおよびインス トールできます。 BFM シ ミ ュレーシ ョ ンについては、付録 B「IP
バス  ファンクシ ョ ン モデル シ ミ ュレーシ ョ ン」を参照してください。このチュート リ アルで作

成している  IP で BFM シ ミ ュレーシ ョ ンを実行する予定の場合は、 BFM プラ ッ ト フォームを

生成してください。

CIP ウ ィザードでは、pcore フレームワークをインプ リ メン トする  2 つの HDL テンプレートが

作成されます。

♦ pwm_lights.vhd ファ イル : PLBv4.6 バス  インターフェイス  ロジッ クが含まれます。

ペリ フェラルにシステム外部へのポートが含まれる場合は、 適切なポート名を追加する必

要があ り ます。 このファ イルには説明が記述されており、 ポート情報をどこに追加したら

よいのかはっき りわかり ます。

Verilog デザインの場合は、 HDL 構文を使用してポート名を記述する必要があるこ とに注

意してください。 次のチュート リ アルのソース  コードを、 今後の pcore 作成のテンプレー

ト と して使用できます。

♦ user_logic.vhd ファ イル : ペリ フェラルを定義するカスタム RTL を追加するテンプ

レート  ファ イルです。 追加のソース  ファ イルを作成するこ と もできますが、こ こで必要な

のは user_logic.vhd ファ イルのみです。

11. [Next] をク リ ッ ク します。 [Peripheral Implementation Support] ページが表示されます。
X-Ref Target - Figure 7-4

図 7-4 : [Peripheral Implementation Support] ページ
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Verilog サポー ト [Peripheral Implementation Support] ページには、ハードウェアおよびソフ ト ウェアのインプ リ

メンテーシ ョ ン用のファイルを生成するオプシ ョ ンが リ ス ト されています。

♦ user_logic テンプレート を VHDL の代わりに Verilog で生成する場合は、 [Generate
stub 'user_logic' template in Verilog instead of VHDL] をオンにします。

♦ pcore デザインをタイ ミ ング解析またはタイ ミ ング シ ミ ュレーシ ョ ン用にインプ リ メン ト

する場合は、 [Generate ISE and XST project files to help you implement the peripheral
using XST flow] をオンにします。 必要な ISE プロジェク ト  ファ イルが生成されます。 ペ
リ フェラルが低速で単純な場合は不要です。

♦ ペリ フェラルが複雑で複雑なソフト ウェア  ド ライバを必要と する場合は、[Generate template
driver files to help you implement software interface] をオンにすると 、選択したサービスに基

づいて必要なド ライバ構造およびプロト タイプ ド ライバが作成されます。

このチュート リ アルでは、これらのチェッ ク  ボッ クスはオフのままにします。 最後のページに、

CIP ウ ィザードで作成されるファ イルとその保存先が表示されます。

サマリ情報 12. この情報を確認し、[Finish] をク リ ッ ク します。 ファ イル生成ステータスが [Console] ウ ィンド

ウに表示されます。

実行された処理

CIP ウ ィザードでどのよ うな処理が実行されたのでし ょ うか。 こ こで、 IP 作成に関する概念とウ ィ

ザードで作成された出力を検証してみます。

EDK では、 PLB スレーブおよびバース ト  ペリ フェラルを使用して、 さまざまなプロセッサ ペリ

フェラルの一般的な機能をインプ リ メン ト します。 PLB スレーブとバース ト  ペリ フェラルは、バス

マスタまたはバス スレーブと して機能します。

CIP ウ ィザードの [Bus Interface] および [IPIF (IP Interface) Services] ページでは、 ターゲッ ト  バ
スと  IP で使用するサービスを選択します。これによ り、IP で必要な PLB スレーブとバース ト  ペリ

フェラル エレ メン ト を指定します。

PLBv4.6 スレーブ
およびバース ト  
ペリ フ ェ ラル

PLB スレーブおよびバース ト  ペリ フェラルは検証および最適化されており、詳細にパラ メータ指定

可能なインターフェイスです。 また、 簡略化されたバス  プロ ト コルのセッ ト も提供します。 カスタ

ム RTL は IPIC 信号に接続されるので、PLB または FSL バス  プロ ト コルを直接操作するよ り も非

常に簡単です。 PLB スレーブおよびバース ト  ペリ フェラルを要件に合わせてパラ メータ指定する

こ とによ り、 すべてを一から作成する必要がないので、 設計およびテス トにかかる労力を大幅に削

減できます。
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図 7-5 に、 バス、 単純な PLB スレーブ ペリ フェラル、 IPIC、 およびユーザー ロジッ クの関係を示

します。

次の図に、 CIP ウ ィザードで作成されたディ レク ト リ構造と主要なファイルを示します。 これらの

ファイルは、 プロジェク ト  ディ レク ト リの pcores サブディ レク ト リに保存されています。

メモ : この図には、 すべてのファイルは表示されていません。

X-Ref Target - Figure 7-5

図 7-5 : カスタム ペリフェラルの PLB スレーブ/バースト  モジュール

X-Ref Target - Figure 7-6

図 7-6 : CIP ウィザードで生成されるディ レク ト リ構造
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CIP ウ ィザードで生成されるファ イルに関して、 次の点に注意して ください。

• pwm_lights.vhd および user_logic.vhd とい う  2 つの HDL テンプレート  ファ イルが

生成されます。

• user_logic ファ イルは、pwm_lights.vhd でコンフ ィギュレーシ ョ ンされた PLB スレー

ブ/バース ト  コアを使用して PLB v4.6 バスに接続します。 

♦ user_logic.vhd ファ イルは、 カスタム機能ブロ ッ ク と同等です。

♦ pwm_lights.vhd ファ イルは、 PLBv.46 スレーブ/バース ト  ブロ ッ ク と同等です。 

• カスタム ロジッ クは IPIC 信号を使用して接続されます。

次の図に、 図 7-5 で示されるブロ ッ ク図と図 7-6 に示されるファ イルの関係を示します。

デザインを完了するには、 カスタム ロジッ クを 2 つのファイルに追加する必要があ り ます。

サンプル デザインの説明

CIP ウ ィザードを使用する と、 読み出しレジスタ と書き込みレジスタで必要な機能が実行できる場

合は、 完全に機能するペリ フェラルを作成できます。 単純なペリ フェラルはこのよ うに作成できま

すが、 実際に機能するサンプル デザインを変更する方法を知っておく と有益なので、 個々では単純

な PLBv4.6 ペリ フェラルを定義します。

次のチュート リ アルで、 このペリ フェラルのソース  コードを開き、 変更します。 これらのファイル

は、プロジェク ト  ディ レク ト リの pcores サブディ レク ト リに保存されています。 このマニュアル

に添付されているサンプル ファ イルを使用するこ と もできます。 Adobe Acrobat Reader の左下に

あるク リ ップ アイコンをク リ ッ ク し、 添付ファイルを確認してください。 チュート リ アルでこれら

のファイルを開きます。

X-Ref Target - Figure 7-7

図 7-7 : IP モジュールと生成されたファイルの関係
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このカスタム ペリ フェラルは、評価ボードの 8 個の LED を制御します。 pwm_lights 回路は、次

のよ うに動作します。

• オフセッ ト  0 に書き込むと  LED がオフになり ます。

• オフセッ ト  4 に書き込むと  LED がオンになり ます。

• 単純な PWM 回路を使用してライ トの輝度を制御します。輝度は 16 個の値によ り指定します。

♦ オフセッ ト  8 に書き込むと対数強度駆動スケールが使用されます。

♦ オフセッ ト  12 に書き込むと線形強度対数スケールが使用されます。

• 制御回路ステータスを リードバッ ク します。

ハードウェア デザインに加え、単純なソフ ト ウェア アプリケーシ ョ ンによ り さまざまな設定と リー

ドバッ ク  ステータスを制御します。

チュート リアル :  CIP ウィザードで生成されたテンプレート  ファイルの変更
このチュート リ アルでは、CIP ウ ィザードで生成されたテンプレート  ファ イルを開き、変更します。

概念的には、 このチュート リ アルでの操作は簡単です。 CIP ウ ィザードで作成した pcore を制御す

る  C コードを読み込んで実行するだけです。 チュート リ アルを開始する前に、 ソフ ト ウェアの次の

機能にも注目してください。

• ワークスペースで使用される  system.xml ファ イルは、 SDK でモニタされます。 このファ イ

ルは、 第 4 章 「エンベデッ ド  プラ ッ ト フォームの操作」 で使用しました。 このファ イルが変更

される と、その変更が SDK で認識されます。 このチュート リ アルでファイルにハードウェアを

追加したと きに、 この機能の例を見るこ とができます。

• デフォルトでは、すべての C コードはブロ ッ ク  RAM にマップされます。 このチュート リ アル

の C コードはこれまでのチュート リ アルで使用したものよ り もサイズが大きいので、 SDK で
マップされたブロ ッ ク  RAM では小さすぎます。 そのため、 リ ンカ スク リプ ト を変更する必要

があ り ます。 SDK には、 リ ンカ スク リプ トの変更を簡略化する  GUI があ り ます。

1. XPS で [File] → [Open] をク リ ッ ク し、 pcores\pwm_lights_v1_00_a\hdl\vhdl ディ レ

ク ト リ に移動します。 このディ レク ト リ に pwm_lights.vhd ファ イルと  user_logic.vhd
ファ イルがあり ます (62 ページの図 7-6 を参照)。

メ モ : これらのフ ァ イルを表示するには、 [フ ァ イルの種類] ド ロ ップダウ ン リ ス ト から

[VHDL] を選択する必要があ り ます。

2. pwn_lights.vhd ファ イルを開きます。 

このファ イルに外部ポート名を追加します。 外部ポート名は、 次の 2 箇所に追加します。

♦ 最上位エンティティ  ポート宣言

♦ user_logic インスタンシエーシ ョ ンのポート  マップ
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3. 160 行目付近にスクロールします。次の図に示すよ うに、最上位エンティティに LED ポート宣

言を追加します。

4. 390 行目付近にスクロールします。次の図に示すよ うに、 user_logic ポート  マップに LED
ポート宣言を追加します。

5. ファ イルを保存します。

2 つのテンプレート  ファ イル (<ip core name>.vhd および user_logic.vhd) でユー

ザーが情報を入力する必要がある部分には、 必要な情報とその場所を示すコ メン トが記述され

ています。 

ほとんどの場合 <ip core name>.vhd に必要な変更は、最上位エンティティにポート を追加

し、 user_logic インスタンシエーシ ョ ンにこれらのポート をマップするこ とだけです。

6. XPS で [File] → [Open] をク リ ッ ク し、pcores\pwm_lights_v1_00_a\hdl\vhdl ディ レ

ク ト リに移動します。 

7. user_logic.vhd ファ イルを開きます。

8. 完成した user_logic.vhd ファ イルは、 このマニュアルに添付されています。 添付ファイル

は、Adobe Acrobat Reader の左下にあるク リ ップ アイコンをク リ ッ クする と表示されます。 現
在開いている  user_logic.vhd ファ イルの内容を、 このマニュアルに添付されている  
user_logic.vhd ファ イルの内容で置換し、 ファ イルを保存します。

X-Ref Target - Figure 7-8

図 7-8 : LED ポートのコード

X-Ref Target - Figure 7-9Ad

図 7-9 : ポート宣言の追加
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ファイルの内容の確認

VHDL を理解していれば、 pwm_lights のコードを理解するのは簡単です。

user_logic.vhd には、 最上位 pwm_lights.vhd ファ イルと同様に、 カスタム RTL を追加す

る位置を示すコ メン トが含まれています。 CIP ウ ィザードを使用したこ とがない場合は、 コ メン ト

を参照し、 インターフェイス信号のリ ス トおよび RTL を追加する位置を確認してください。

自動生成されたジェネ リ ッ クおよびポート は変更しないでください。 指定された位置にカスタム

ジェネ リ ッ クおよびポートのみを追加してください。 

100 行目付近に、ユーザー ポート  LEDs (0 to 7) が追加されています。 この出力ベクタは、評価ボー

ドの 8 個の LED を駆動します。 デザインに特定の信号を追加した場合は、この位置にそれらのポー

ト を追加します。 これらのポートは、最上位ファイルにも追加し、user_logic にマップする必要

があ り ます。

architecture 宣言の後のコードは、 ほとんどカスタム コードです。

必要な内部信号および定数を宣言した後、 デザインの最初のブロ ッ クで単純なカウンタを駆動しま

す。 このカウンタから、 次の 2 つの出力信号が取り出されます。

• PWM アップデート  ク ロ ッ ク  (約 1KHz)

• LED アップデート  クロ ッ ク  (約 4Hz)

クロ ッ ク  レー トの変更 これらのク ロッ ク  レート を変更するには、定数 PWM_tap および slow_clock_tap を変更します。

decode プロセスは、 IPIC からのインターフェイス信号から適切な関数を選択します。 カスタム ブ
ロ ッ クへの書き込みは、Bus2IP_WrCE(0) がアクティブ (High) のと きに実行されます。 デコード

ロジッ クにアドレス信号を追加するこ とによ り、 次の動作をインプ リ メン ト します。

• オフセッ ト  0x00 に書き込み :  すべての LED をオフ

• オフセッ ト  0x04 に書き込み :  すべての LED をオン

• オフセッ ト  0x08 に書き込み :  LED の輝度は 2 乗関数駆動信号を使用して調整

• オフセッ ト  0x0C に書き込み :  LED の輝度は線形関数駆動信号を使用して調整

• オフセッ ト  0x1x に書き込み :  LED の輝度を定数 (0 ～ 0xFF) に設定

PWM プロセスは、slow_clock のアッ プデート  レート に基づいて駆動信号をアップデート します。

• 最初の case 文は、 2 乗関数を使用して駆動値をアップデート します。

• 2 番目の case 文は、 線形に駆動値をアップデート します。

自由に駆動値を変更してみてください。 16 個の駆動値が使用されます。

LED は、PWM で生成された駆動信号で駆動されます。 駆動信号のデューティ  サイクルは、0% (駆
動なし ) からほぼ 100% (0xFF または 255) です。 

247 行目付近の LEDs(0 to 7) の代入は、回路に最後に記述された命令に基づいて  LED を制御します。 

説明したコードはどれも単純なので、自由に変更して試してみてください。 ただし、 256 行目以降の

インターフェイス信号には、特定の動作が必要です。 これらの信号を不正なロジッ クで駆動する と、

カスタム pcore がバスの動作を阻害し、 デバッグ中に予測されない結果が得られます。

IP2Bus_Data は、読み出し動作でプロセッサによ り読み出されるバスです。 PLB を正し く動作さ

せるには、 カスタム pcore から読み出しが実行されている場合を除き、 このバスをすべて 0 で駆動

する必要があ り ます。 リセッ トが 0 で Bus2IP_RdCE が 1 であれば、読み出しは正し くデコード さ

れます。 この条件が満たされた場合、カスタム回路で指定の値がバスに駆動されます。条件が満たさ

れない場合は、 0 が駆動されます。
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このサンプル デザインでは、ペリ フェラル アドレス  マップ内のアドレスを読み出すと、次のよ う な

32 ビッ ト値が返されます。 

最後の信号 IP2Bus_WrAck および Bus2IP_WrCE(0) も重要です。 IP2Bus_WrAck は書き込み確認

信号で、カスタム  ロジッ クから送信する必要があり ます。 IP2Bus_WrAck は 1 サイクル間のみ High
にします。カスタム  ロジッ クで応答に wait ステート を追加する必要がある場合は、遅延させるこ と が

できます。 この例では wait ステート は不要なので、IP2Bus_WrAck を直接 Bus2IP_WrCE(0) に接

続し、 単純な  wait ステート なしの応答を生成します。 読み出し確認信号のロジッ クも同一で、 必要に

応じて wait ステート を追加できます。

pwm_lights pcore には C_INCLUDE_DPHASE_TIMER パラメ ータが含まれており 、これを  1 に設

定すると 、ペリ フェラルがバス要求に応答しない場合に自動バス  タイムアウト 信号が生成されます。 

この例では、データ位相タイマは含まれていません。 このロジッ クを追加する場合は、pwm_lights

ペリ フェラルに C_INCLUDE_DPHASE_TIMER パラ メ ータを追加し、 値を  1 に設定します。 このロ

ジッ ク を追加すると 、 未確認のバス転送は PLB ク ロッ クの 128 サイク ル後にタイムアウト します。

最後に、 IP2Bus_Error が定数ロジッ ク  0 で駆動されており、 エラーが発生していないこ とを示

します。 カスタム ペリ フェラルが別の外部ロジッ クを待機する必要があ り、 タイムアウ トする可能

性がある場合は、 ロジッ クで IP2Bus_Error を駆動してバス転送を終了できます。

プロセッサ システムへのカスタム IP の追加

pwm_lights.vhd および user_logic.vhd を変更したと きに、 テンプレート  デザインに新し

いポート を追加しました。 MPD ファ イルでポート またはパラ メータを変更した場合、CIP ウ ィザー

ドをインポート  モードで実行する必要があ り ます。 これによ り、 EDK へのインターフェイス  ファ

イルである  PSF ファ イル (MPD および PAO) が再生成されます。 インポート  フローを完了したら、

カスタム pcore をエンベデッ ド  デザインに追加できます。

このチュート リ アルを開始する前に、 現在 IP 作成プロセスのどの段階であるかを確認します。

• CIP ウ ィザードを実行して pwn_lights ペリ フェラルを作成し、 バス  インターフェイスを設定

してテンプレート  ファ イルを生成しました。

• 次に、再び CIP ウ ィザードを使用してプロジェク トに pwm_lights を追加します。 このプロセ

スで、 pwm_lights が XPS の適切なディ レク ト リにインポート され、 MPD および PAO ファ

イルが生成されます。 PSF ファ イルの詳細は、次のサイ トから 『Platform Specification Format
Reference Manual』 を参照してください。

http://japan.xilinx.com/ise/embedded/edk_docs.htm

ビッ ト  0 ～ 15 :  0xF0F0

ビッ ト  16 ～ 23 : LED 駆動レジスタに記述される  1 バイ ト値

ビッ ト  24 ～ 27 : 0x0

ビッ ト  28 ～ 31 : all_off (1 ビッ ト )、 run (1 ビッ ト )、 linear (2 ビッ ト )

http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=edk+docs
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チュート リアル :  CIP ウィザードを使用した XPS プロジェク トへの変更した
ファイルのインポート

1. CIP ウ ィザードを起動し、[Peripheral Flow] ページで [Import existing peripheral] をオンにし、

XPS プロジェク トに既存のペリ フェラルをインポートするこ とを選択します。

2. [Name and Version] ページで、[Name] ド ロ ップダウン リ ス トから  [pwm_lights] を選択しま

す。 バージ ョ ンは必要あ り ませんが、 [Use version] をオンにしてデフォルト値またはカスタム

バージ ョ ン番号を使用します。

3. この名前の既存のペリ フェラルを上書きするかどう かを確認する  [Overwrite Existing Peripheral]
ダイアログ  ボッ クスが表示されたら、 [Yes] をク リ ッ ク します。

4. [Source File Types] ページで [HDL source files] をオンにします。 RTL または既存のネッ ト リ

ス ト を使用して pcore を作成するこ と もできます。 カスタム ペリ フェラルに資料を含めるこ と

もできます。 

こ こまでは簡単でしたが、 この後インポート  フローは複雑になり ます。 

CIP ウ ィザードでは、さまざまな方法で作成された pcore をインポートできます。 pcore を CIP
ウ ィザードを使用して作成した場合は、 PAO (Peripheral Analysis Order) ファ イルを使用して

ソース  ファ イルを特定するのが最も簡単な方法です。

X-Ref Target - Figure 7-10

図 7-10 : [HDL Source Files] ページ
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5. [HDL Source Files] ページで、[Use existing Peripheral Analysis Order file (*.pao)] をオンにし

ます。 

6. PAO ファイルを選択します。 デフォルト では、[Browse] ボタンをク リ ッ クすると 最上位 pcores
ディ レク ト リ が開きます。 PAO ファ イルは、 pwm_lights_v1_00_a\data サブディ レク ト リ

にあり ます。

PAO ファ イルを使用して下位ライブラ リ を含む必要なソース  ファ イルを指定する場合は、 さ

らにファ イルやライブラ リ を追加する必要はあ り ません。

多数のファイルで構成される複雑なペリ フェラルをインポートする場合は、ライブラ リ  パスお

よび HDL ソース  ファ イル パスに必要なファイルおよびライブラ リが含まれているこ とを確

認してください。

メモ : ファ イルを表示するには、 [ファ イルの種類] ド ロ ップダウン リ ス トでファ イルの種類を

変更する必要がある場合があ り ます。

7. [HDL Analysis Information] ページで、 リ ス トの最後に user_logic.vhd および 
pwm_lights.vhd が含まれているこ とを確認します。

8. [Current Logical Library] ダイアログ ボッ クスが表示され、追加した VHDL ファ イルがコンパ

イルされていないこ とが示される場合があ り ます。 [Next] をク リ ッ ク し、 ウ ィザードでこれら

のファイルがコンパイルされるよ うにします。

X-Ref Target - Figure 7-11

図 7-11 : [HDL Analysis Information] ページ
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9. [Bus Interface] ページで、適切なバスを選択します。 pwm_lights ペリ フェラルは PLBv46 ス
レーブ (SPLB) なので、 [PLBV46 Slave (SPLB)] をオンにします。 

[SPLB : Port] ページに、このデザインで使用される  PLBv46 バス信号がリ ス ト されます。 これ

らの信号および関連付けられているバス  プロ ト コルは、すべて CIP ウ ィザードで自動的に処理

されます。

ほとんどの場合、特に CIP ウ ィザードを使用してコアを作成している場合は、必要な信号がす

べて含まれているかを解析するのに時間を費やす必要はあ り ません。

別の方法でコアを作成した場合、 複雑なバス  インターフェイスやカスタム バス  インターフェ

イスが含まれる場合は、 バス信号を解析するのにこのページが有益です。

pwm_lights ペリ フェラルは、pcore をデザインに含める と きに、XPS が割り当てる  1 つのア

ドレス範囲にマップされます。 複雑なペリ フェラルでは、 メモ リ  ブロ ッ クやデコード範囲が含

まれる場合もあ り ます。

10. [SPLB : Parameter] ページで、 デフォルト値をそのまま使用します。

pwm_lights ペリ フェラルには、 割り込みソースは含まれていません。

11. [Identify Interrupt Signals] ページで、 [Select and configure interrupt(s)] をオフにします。

複雑なペリ フェラルでは、多数のパラ メータを使用し、注意深く  PLB バスの動作を制御する必

要がある場合があ り ます。 [Parameter Attributes] ページでは、 パラ メータ設定を表示および変

更できます。

X-Ref Target - Figure 7-12

図 7-12 : [Parameter Attributes] ページ
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ド ロ ップダウン リ ス トから、 カスタム pcore のパラ メータのみを表示するか ([List User
Parameters only])、 選択したバス  インターフェイスのパラ メータのみを表示するか ([List Bus
Interface Parameters only])、 両方を表示するか ([List All Parameters]) を選択できます。

pcore パラ メータは、 CIP ウ ィザードのこれまでのページで生成されています。 バス  インター

フェイス  パラ メータは自動的に生成されています。

このペリ フェラルでは、 変更は不要です。

12. [Port Attributes] ページで [LEDs] をク リ ッ ク し、[Display advanced attributes] をオンにして属

性をすべて表示します。 このよ うにする と、 ポート属性をよ り詳細に制御できます。 属性は、

MPD ファ イルに記述されます。

ド ロ ップダウン リ ス トで [List All Ports] を選択する と、 カスタム pcore とエンベデッ ド  プロ

セッサ サブシステムの接続に使用されるすべてのポートが表示されます。 PLB 信号が多数あ

り ますが、 CIP ウ ィザードですべてのポートの属性が自動的に設定されます。

13. このページを参照した後、 [Next] をク リ ッ ク して最後のページに進みます。 [Finish] をク リ ッ

クする と、 インポート操作は完了です。

pwm_lights pcore を
プロジェ ク トに追加

[IP Catalog] タブの [Project Local pcores] の下に、 カスタム  ペリ フェラルがリ スト さ れてい

ます。

pwm_lights をデザインに追加する前に、既存のデザインに 1 つだけ変更を加える必要があり

ます。 評価ボード の 8 個の LED は、GPIO 出力に接続されています。 pwm_lights でこれらの

LED を駆動するよう にするので、 LEDs_8Bit pcore をデザインから削除する必要があり ます。

14. [System Assembly View] で [LEDs_8Bit] を右ク リ ッ ク し、 [Delete Instance] をク リ ッ ク しま

す。 [Delete IP Instance] ダイアログ ボッ クスが表示されます。 

15. こ こでは、 デフォルト設定を使用します。 外部ポートは、 デザインに手動で追加します。

16. [IP Catalog] タブで [PWM_LIGHTS] を右ク リ ッ ク し、 [Add IP] をク リ ッ ク します。

IP が [System Assembly View] に追加されます。 [Bus Interfaces] タブで確認できます。 

X-Ref Target - Figure 7-13

図 7-13 : [Delete IP Instance] ダイアログ ボックス
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17. バス接続パネルで、 PLB バスをク リ ッ ク してバスを接続します。

これで、 pwm_lights コアがエンベデッ ド  システムに追加されました。 次に、 pwm_lights

と評価ボード上の LED の外部接続を追加する必要があ り ます。

18. [Ports] タブをク リ ッ ク し、[pwm_lights_0] を展開表示して、[Net] 列のド ロ ップダウン リ ス

トから  [Make External] を選択します。

デフォルト名である  pwm_lights_0_LEDs[0:7] がネッ ト名と して使用されます。 [Ports]
タブの 1 番上にある  [External Ports] を展開表示する と、 pwm_lights_0_LEDs_pin[0:7]

というポート名が表示されます。

19. pwm_lights_0 のド ロ ップダウン ボッ クスをク リ ッ クする と、割り当てられたネッ トおよび

ピン名を変更できます。 また、 MHS ファ イルを手動で編集するこ と も可能です。 こ こでは、デ

フォルト名をそのまま使用します。

次に、 pwm_lights pcore のアドレスを生成します。 

20. [Addresses] タブをク リ ッ ク します。 [Unmapped Addresses] の下に pwm_lights_0 が表示さ

れていない場合は、 [Project] → [Rescan User Repositories] をク リ ッ ク します。

21. [Addresses] タブで [Generate Addresses] をク リ ッ ク します。 pwm_lights pcore が
0xC4600000 ～ 0xC460FFFF のアドレス範囲に割り当てられます。

22. DDR2_SDRAM のアドレス範囲が 0x88000000 ～ 0x8fffffff であるこ とを確認します。 
このアドレスが変更されている場合は、 元の値に戻します。

単純なペリ フェラルが 64KB のアドレス空間に割り当てられるのはおかしいと思われるかも

しれませんが、 大きいアドレス空間ではデコードするアドレス  ラ インが少なくて済みます。

FPGA では、多入力のデコーダはカスケード されたルッ クアップ テーブルと してインプ リ メン

ト されます。

カスケード 段が増えると 、動作周波数は低く なり ます。 広いアド レス範囲に割り 当てると 、FPGA
インプリ メ ンテーショ ンの動作が速く なり ます。 

23. 最後に、 UCF ファ イルで LED 出力を適切な FPGA ピンに割り当てます。

X-Ref Target - Figure 7-14

図 7-14 : 新規 IP のバスを接続
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24. [Project] タブをク リ ッ ク し、 [UCF File] をダブルク リ ッ ク して開きます。

25. fpga_0_LEDs_8Bit_GPIO_IO_O を検索します。 GPIO pcore を削除しましたが、UCF ファ

イルにはこれらのピン割り当てが残っています。 pcore を削除しても、 UCF ファ イルは自動的

にアップデート されないので注意してください。

26. 8 個すべての fpga_0_LEDs_8Bit_GPIO_IO_O_pin を pwm_lights_0_LEDs_pin に置

換し、 UCF ファ イルを保存します。

これで、 カスタム pcore が完成しました。

デザインのエクスポート
と ビッ ト スト リ ームの
生成

次に、ハードウェア デザインをエクスポート して新しいビッ ト ス ト リームを生成し、ハードウェア

でこの pcore をテス ト します。

1. XPS で、 [Project] → [Export Hardware Design to SDK] をク リ ッ ク します。 デフォルトのディ

レク ト リ をそのまま使用し、 [Export Only] をク リ ッ ク します。 

2. エクスポートが完了したら、XPS を閉じて ISE に戻り、[Generate Programming File] をダブル

ク リ ッ ク します。

3. SDK を起動します。 起動するのに少し時間がかかる場合があ り ます。 ハード ウェア プラ ッ ト

フォームの変更が認識される と、[Hardware Design Changes Detected] ダイアログ ボッ クスが

表示されます。

4. [Show Hardware Changes] をク リ ッ ク します。 

次の図に示すファイルがブラウザで開きます。
X-Ref Target - Figure 7-15

図 7-15 : ハードウェア デザイン変更サマリ
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LED を駆動する  xps_gpio pcore が削除され、 pwm_lights が追加されています。 SDK で
system.xml ファ イルに加えたハードウェア プラ ッ ト フォームの変更が認識され、 表示され

ます。

5. ブラウザ ウ ィンド ウを閉じます。

[Hardware Design Changes Detected] ダイアログ ボッ クスで [SDK Actions] タブをク リ ッ クす

る と、 gpio ド ラ イバが削除され、 pwm_lights ド ラ イバが追加されたこ とが表示されます。

6. [Hardware Design Changes Detected] ダイアログ ボッ クスを閉じます。

SDK に [C/C++] パースペクティブが表示されます。

7. 第 5 章および第 6 章で使用したワークスペースを使用する場合は、 standalone プラ ッ ト フォー

ムが既に存在しています。

新しいワークスペースを使用して SDK を起動した場合は、 cip_wizard_platform という

standalone ソフ ト ウェア プラ ッ ト フォームを作成します。

8. LEDS とい う  Managed Make C アプリ ケーシ ョ ン プロジェク ト を、 [Empty Application] サン

プル アプリ ケーシ ョ ンを選択して作成します。

このマニュアルの添付ファイルは、Adobe® Acrobat Reader の左下にあるク リ ップ アイコンを

ク リ ッ クする と表示されます。

9. leds.c とい う名前の新規ソース  ファ イルを追加します。 このマニュアルに添付されている

leds.c ファ イルの C コードをコピーして貼り付け、保存します。コンパイル エラーが発生し

ます。 このエラーは、 オブジェク ト  コードが選択されたメモ リ空間よ り も大きいこ とが原因で

発生します。 これを調べてみます。

10. [Projects] タブで [leds.c] を右ク リ ッ ク し、 [Generate Linker Script] をク リ ッ ク します。

[Linker Script Generator] ダイアログ ボッ クスが表示されます。 テキス ト、 ヒープ、スタ ッ クな

ど、すべてがブロ ッ ク  RAM (ilmb_cntlr_dlmb_cntlr) に割り当てられています。 この割

り当てを、 メモ リ空間が大きい DDR2 RAM に変更します。

11. [Linker Script Generator] ダイアログ ボッ クスで、 すべてのコード  セクシ ョ ンに対してド ロ ッ

プダウン リ ス トから  [DDR2_SDRAM_MPMC_BASEADDR] を選択します。 ヒープおよびスタ ッ ク

のサイズが 0x1000 に設定されているこ とを確認します。

これで、 コードが正し く コンパイルされます。 作成された ELF ファ イルは約 93K で、 16K の
ブロ ッ ク  RAM よ りかな り大き くなっています。

12. [Initialization ELF] を [BootLoop] に設定してビッ ト ス ト リームをダウンロード します。 

13. leds.elf をデバッグします。
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14. ターミナル ウ ィンド ウが開いて leds.elf を実行します。 アプリ ケーシ ョ ン コードを実行す

る と、 ターミナル ウ ィンド ウにデバッグ オプシ ョ ンが表示されます。

値を入力します。

15. さまざまな値を入力し、 LED が予測どおりに動作するかど うかを確認します。 

実行された処理

CIP ウ ィザードを使用してカスタム IP を作成しました。 タスクを完了するのに多数の手順を実行

する必要があ り ましたが、 これで手順を理解でき、今後 CIP ウ ィザードを効率的に使用できるよ う

になったはずです。 必要に応じて、 この章を参照してください。

次の操作

次の章では、 デュアル プロセッサ デザインを作成し、 EDK でデバッグします。

X-Ref Target - Figure 7-16

図 7-16 : HyperTerminal に表示されたデバッグ オプシ ョ ン
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MicroBlaze™ プロセッサはソフト  マイクロプロセッサであり 、FPGA に収まるだけの数の MicroBlaze
プロセッサを含めること ができます。 XPS (Xilinx® Platform Studio) の Base System Builder (BSB) で
デュアル プロセッサ システムを作成するのは、1 つの MicroBlaze プロセッサを含むシステムを作成す

るのと ほと んど同じです。 また、 ソフト ウェア開発キッ ト  (SDK) を使用すると 、 1 つまたは複数の

MicroBlaze プロセッサを含むエンベデッ ド  システムを簡単にデバッグできます。

BSB を使用したデュアル プロセッサ システムの作成

PowerPC® プロセッサを含む FPGA を使用する場合、同じ概念を適用できます。 BSB ウィ ザード を使

用して、 デュアル PowerPC デザイン  (FPGA に PowerPC プロセッサが 2 つ含まれている場合)、
PowerPC プロセッサと  MicroBlaze プロセッサを  1 つずつ含むデザインを作成できます。 Spartan®-3A
DSP ボード を使用する場合、 BSB ウィ ザード でデュアル MicroBlaze プロセッサ デザインを作成し、

XPS でさらに MicroBlaze プロセッサを追加できます。

チュート リアル :  2 つの MicroBlaze プロセッサを含むエンベデッ ド  
システムの作成

このチュート リ アルでは、Base System Builder ウ ィザードおよび ISE® Project Navigator を使用し

て、11 ページの「新規プロジェク トの作成」 と同様の方法でデュアル プロセッサ システムを作成し、

インプ リ メン ト します。

メモ : 1 つのエンベデッ ド  プロジェク トに複数のプロセッサを含むこ とができます。 このチュート

リ アルでは、 エンベデッ ド  プロジェク トに 2 つの MicroBlaze プロセッサを含めます。

1. 1 つのエンベデッ ド  プロセッサ ソースを含む ISE プロジェク ト を作成します。

XPS が開くのを待ちます。 これには少し時間がかかる場合があ り ます。

2. 「This project appears to be a blank project. Do you want to create a Base System using the BSB
Wizard?」 (このプロジェク トは空です。BSB ウ ィザードを使用して基本システムを作成します

か) という メ ッセージが表示されたら、 [Yes] をク リ ッ ク します。
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3. BSB で、次の表の指示に従ってプロジェク ト を作成します。表に設定またはコマンドがない場

合は、 デフォルト値をそのまま使用します。

4. デザインが完成したら、 XPS の [System Assembly View] でシステムを見てみます。

2 つのエンベデッ ド  プロセッサ システムは完全に独立しており、それぞれ独自のメモ リ  マップ

があ り ます。 例外は xps_mailbox_0 ペリ フェラルです。 このペリ フェラルはデュアル ポート

RAM で、1 つのポートは 1 つのプロセッサの PLBv46 バスに接続されており、も う  1 つのポー

トはも う  1 つのプロセッサの PLBv46 バスに接続されています。 [System Assembly View] で
xps_mailbox_0 ペリ フェラルを右ク リ ッ ク し、 [View PDF Datasheet] をク リ ッ クする と、 この

ペリ フェラルのデータシートが表示されます。

5. [Project] → [Export Hardware Design to SDK] をク リ ッ ク し、system.xml ファ イルを SDK に
エクスポート します。

6. デフォルトのディ レク ト リ をそのまま使用し、 [Export Only] をク リ ッ ク します。

7. ISE Project Navigator に戻り、 ISE プロジェク トに UCF ファ イルを追加します。

メモ : ISE プロジェク トへの UCF ファ イルの追加に関する詳細は、 第 4 章 「エンベデッ ド  プ
ラ ッ ト フォームの操作」 を参照してください。

8. [Generate Programming File] をダブルク リ ッ ク してデザインをインプ リ メン ト し、ビッ ト ス ト

リームを生成します。

これで、 ターゲッ ト  ハードウェアにダウンロードするビッ ト ス ト リームと  SDK で使用する

system.xml ファ イルの準備ができました。 

ウィザードのページ システム特性 設定または使用するコマンド

[System Configuration] システムのタイプ [Dual-Processor System] をオンにし

ます。

[Processor 
Configuration]

ローカル メモ リ  
([Local Memory])

両方のプロセッサに対して [8 KB] を
選択します。

[Peripheral 
Configuration]

• プロセッサ 1 ペリ フェ

ラル ([Processor 1 
(MicroBlaze) 
Peripherals])

• 共有ペリ フェラル 
([Shared Peripherals])

• プロセッサ 2 ペリ フェ

ラル ([Processor 2 
(MicroBlaze) 
Peripherals])

• デフォルトの リ ス トから次のペリ

フェラルを削除します。

- DIP_Switches_8Bit
- Ethernet_MAC
- LEDs_8Bit

プロセッサ 1 の残りのペリ フェラ

ルは、 DDR2_SDRAM、

RS232_Uart_1、 dlmb_cntlr、
ilmb_cntlr です。

• xps_mutex_0 を削除します。 残り

のペリ フェラルは xps_mailbox_0 
です。

• デフォルトの リ ス トから次のペリ

フェラルを削除します。

- Push_Buttons
- SPI_FLASH

プロセッサ 2 の残りのペリ フェラ

ルは、 dlmb_cntlr_1 および 
ilmb_cntlr_1 です。
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チュート リアル :  SDK を使用したデュアル プロセッサ システム用の
ソフ トウェアの開発

このチュート リ アルでは、 2 つのエンベデッ ド  プロセッサ用のソフ ト ウェアの開発およびデバッグ

に使用する  SDK プロジェク ト を作成します。

SDK を使用してデュアル プロセッサ システムをデバッグする手順は、第 5 章と第 6 章のチュート

リ アルで示したシングル プロセッサ システムのデバッグとほぼ同じです。

これまでに説明したとおり、SDK でソフ ト ウェアを開発するには、ソフ ト ウェア プラ ッ ト フォーム

を作成し、C または C++ アプリケーシ ョ ン プロジェク ト を作成します。 この手順は、システムにプ

ロセッサがいくつ含まれていても同じです。 ソフ ト ウェア プラ ッ ト フォームを作成する際、 プラ ッ

ト フォームで使用するプロセッサを指定する必要があ り ます。

1. SDK を起動します。

2. [Workspace Launcher] ダイアログ ボッ クスが表示されたら、 Dual_Processor_Workspace

という名前のワークスペースを作成し、 任意のディ レク ト リに保存します。

3. [New Hardware Specification File] ダイアログ ボッ クスで、 エクスポート した system.xml
ファ イルを指定します。 デフォルトのプロジェク ト  ロケーシ ョ ンを使用した場合は、 このファ

イルは <ISE Project Name>\system\SDK\SDK_Export\hw\system.xml にあ り ます。

[C/C++] パースペクティブが表示されます。 SDK でエンベデッ ド  システムに 2 つの

MicroBlaze プロセッサがあるこ とが認識され、 次の図のよ うに表示されます。

4. [File] → [New] → [Project] をク リ ッ ク し、[Software Platform] を選択して、次の設定を使用し

てソフ ト ウェア プラ ッ ト フォーム プロジェク ト を作成します。

♦ [Project Name] :  MicroBlaze_Platform_0

♦ [Processor] :  [microblaze_0 (microblaze)]

♦ [Platform Type] :  [standalone]

♦ [Project Location] :  [Use default] をオン

5. 同じ手順を使用して、2 つ目のソフ ト ウェア プラ ッ ト フォーム プロジェク ト を次の設定で作成

します。

♦ [Project Name] :  MicroBlaze_Platform_1

♦ [Processor] :  [microblaze_1 (microblaze)]

♦ [Platform Type] :  [standalone]

♦ [Project Location] :  [Use default] をオン

次の図に示すよ うに、各 MicroBlaze プロセッサに 1 つずつソフ ト ウェア プラ ッ ト フォームが

表示されます。

X-Ref Target - Figure 8-1

図 8-1 : エンベデッ ド  システムに表示される 2 つの MicroBlaze プロセッサ
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次に、各プロセッサに対して Managed C アプリケーシ ョ ン プロジェク ト を作成します。 この例

では、 各プロセッサ対して Hello World プロジェク ト を作成し、 変更します。

6. [File] → [New] → [Managed Make C Application Project] をク リ ッ ク し、 次の設定を使用して

Managed Make C アプリケーシ ョ ン プロジェク ト を作成します。

♦ [Project Name] :  hello_world_0

♦ [Software Platform] :  [MicroBlaze_Platform_0]

♦ [Project Location] :  [Use Default Location for Project] をオン

♦ [Sample Applications] :  [Hello World] を選択

7. 同じ手順を使用して、2 つ目の Managed Make C アプリ ケーシ ョ ン プロジェク ト を次の設定で

作成します。

♦ [Project Name] :  hello_world_1

♦ [Software Platform] :  [MicroBlaze_Platform_1]

♦ [Project Location] :  [Use Default Location for Project] をオン

♦ [Sample Applications] :  [Hello World] を選択

次の図に示すよう に、各プロセッ サに 1 つずつサンプル C アプリ ケーショ ンが作成されました。

X-Ref Target - Figure 8-2

図 8-2 : MicroBlaze プロセッサと関連付けられたソフ トウェア プラッ ト フォーム
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8. helloworld.c ファ イルを変更して、 どちらのプロセッサが実行されているかが示されるよ

うにします。 MicroBlaze_Platform_0 プロジェク トの helloworld.c ファ イルを開き、

コードを次のよ うに変更します。

print("Hello World\n\r");

上記のコードを次のコードで置換します。 

print("Hello From Processor 0!\n\r");

9. MicroBlaze_Platform_1 プロジェク トの helloworld.c ファ イルも同様に変更します。

10. 各ファイルを保存します。 保存する と、 SDK でファイルが自動的に構築されます。 [Console]
ビューの出力を確認してください。

************** Determining Size of ELF File **************

mb-size hello_world_1.elf
 text data bss dec hexfilename
 1958 296 2090 4344 10f8hello_world_1.elf

Build complete for project hello_world_1

X-Ref Target - Figure 8-3

図 8-3 : MicroBlaze プロセッサと関連付けられた Managed C アプリケーシ ョ ン プロジェク ト
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プログラムには、 アプ リケーシ ョ ンを実行するのに十分なメモ リが必要です。

このサンプル デザインでは、MicroBlaze_Platform_0 のみが外部 DDR2 メモ リにアクセス可能

で、MicroBlaze_Platform_1 は 8KB のオンチップ ブロッ ク  RAM にしかアクセスできません。

[Console] ビューの出力からわかるよ うに、 hello_world_1.elf のサイズは 4.344KB であ り

8KB 以下なので、 メモ リのサイズは十分です。

チュート リアル :  ソフ トウェア プラッ ト フォーム設定の変更
MicroBlaze_Platform_0 プロセッサは、stdin および stdout ペリ フェラルに UART を使用しま

すが、 MicroBlaze_Platform_1 プロセッ サには UART がないので、 stdin および stdout ペリ

フェラルに XMD と  MDM-UART を使用する必要があり ます。 そのため、MicroBlaze_Platform_1

のソフト ウェア  プラッ ト フォーム設定の変更が必要な場合があり ます。

1. [Tools] → [Software Platform Settings] をク リ ッ ク し、MicroBlaze_Platform_1 プロセッサ

の [Software Platform Setting] ダイアログ ボッ クスを開きます。

2. [OS and Libraries] ページで、 stdin および stdout の設定を確認します。 XMD を実行する

ハードウェアを MDM にする必要があ り ます。 デフォルト値は mdm_0 であ り、正しい設定になっ

ているこ とがわかり ます。

MicroBlaze_Platform_0 プロセッサの設定を確認する と、 stdin および stdout が 
xps_uartlite に設定されているはずです。

チュート リアル :  1 つの SDK [Debug] パースペクテ ィブを使用した複数
のプロセッサのデバッグ

デザインの各エンベデッ ド  プロセッ サには、 個別のバイナリ  ELF ファ イルが必要です。 ファ イルに

は、プロセッ サ名に基づいて自動的に名前が付けられます。 たと えば、MicroBlaze_Platform_0 プ
ロセッ サのバイナリ  ファ イルの名前は hello_world_0.elf であり 、 MicroBlaze_Platform_1

プロセッ サのバイナリ  ファ イルの名前は hello_world_1.elf です。

各バイナリ  ファ イルは、 個別にダウンロードできます。 その前に、 デュアル プロセッサ システ デ
ザインのビッ ト ス ト リームをターゲッ ト  ハード ウェアにダウンロードする必要があ り ます。

1. [Tools] → [Program FPGA] をク リ ッ ク し、 次の場所からビッ ト ス ト リームとブロ ッ ク  メモ リ

マップ ファ イルを選択します。

♦ <ISE Project Name>\system.bit

♦ <ISE Project Name>\edkBmmFile_bd.bmm

2. 各プロセッサの [Initialization EFL] が [BootLoop] に設定されているこ とを確認し、[Save and
Program] をク リ ッ ク します。

ターゲッ ト  ハードウェアがデュアル プロセッサ デザインのビッ ト ス ト リームでプログラムさ

れます。 

次に、 各プロセッサに ELF ファ イルをダウンロード します。

3. [C/C++ Projects] ビューの [hello_world_0 {MicroBlaze_Platform_0}] フォルダにある

[hello_world_0.elf] を右ク リ ッ ク し、 [Debug As] → [Debug on Hardware] をク リ ッ ク し

ます。

MicroBlaze_Platform_0 プロセッサの [Debug] パースペクティブが開きます。
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4. [C/C++] パースペクティブに戻り、 同じ手順を使用して hello_world_1.elf ファ イルを

MicroBlaze_Platform_1 にダウンロード します。

再び [Debug] パースペクティブが開きます。 [Debug] ビューに 2 つのデバッグ タスクがあるこ

とを確認します。

5. これらのプログラムをデバッグする前に、RS232 ケーブルでコンピュータ と ターゲッ ト  ボード

を接続し、 ターミナル ウ ィンド ウでコンソール I/O を確認します。

6. [XMD Console] ビューで 「terminal」 と入力し、 ターミナル I/O を MDM に送信します。 こ
のウ ィンド ウを使用して、 MicroBlaze_Platform_1 の出力を観察できます。 

メモ : [XMD Console] ビューが表示されていない場合は、[Window] → [Show View] → [Other]
をク リ ッ ク し、 [Xilinx] → [XMD Console] を選択します。

7. [Debug] ビューで hello_world_0 または hello_world_1 の呼び出しスタ ッ クをハイライ

ト し、 [Run] → [Resume] をク リ ッ ク します。

メモ : どちらの呼び出しスタ ッ ク も 「1 main() at...」 となっているはずです。

ターミナル ウ ィンド ウまたは [XMD Console] ビューのプロセッサ出力表示は、 次の図のよ うにな

り ます。

X-Ref Target - Figure 8-4

図 8-4 : [Debug] パースペクティブ
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SDK での複数プロセッサ デザインのデバッグは、 1 つのプロセッサ デザインのデバッグと同様に

実行できます。 これは単純な例でした。 コードの 1 行ずつの実行、ブレークポイン トの設定、レジス

タおよびメモ リの確認など、 その他のソフ ト ウェア開発タスク も  SDK で実行できます。

X-Ref Target - Figure 8-5

図 8-5 : ターミナル ウィンドウおよび [XMD Console] ビューのプロセッサ出力
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付録 A

Project Navigator での ModelSim を使用し
たシミ ュレーシ ョ ン

このマニュアルのチュート リ アルでは、すべての操作を  ISE® Project Navigator から開始しました。

エンベデッ ド  デザインのシ ミ ュレーシ ョ ンも  Project Navigator で実行できます。

シミ ュレーシ ョ ン

第 7 章 「独自の IP の作成」 のチュート リ アルで作成したデザインを使用します。 

チュート リアル :  エンベデッ ド  デザインのシミ ュレーシ ョ ン
このチュート リ アルでは、XPS で生成された VHDL ファ イルに変更を加えます。 この VHDL ファ

イルをエンベデッ ド  システム (system.xmp ファ イル) をインスタンシエートする最上位ファイル

と して使用します。 また、 デザインのブロ ッ ク  RAM に読み込む ELF ファ イルを指定します。

このチュート リ アルでは、Project Navigator でエンベデッ ド  デザインをシ ミ ュレーシ ョ ンする方法

を示すと共に、 エンベデッ ド  システムをインスタンシエートする最上位 VHDL ファ イルを作成す

る方法も示します。 この例は、 VHDL のみです。

Project Navigator でエンベデッ ド  デザインをシ ミ ュレーシ ョ ンするには、まずシ ミ ュレーシ ョ ン モ
デルの生成オプシ ョ ンを設定します。

1. 第 7 章 「独自の IP の作成」 で作成した ISE プロジェク ト を開きます。

2. XMP ソースをダブルク リ ッ クして XPS を開きます。

3. [Project] → [Project Options] をク リ ッ ク します。

4. [HDL and Simulation] タブをク リ ッ ク します。

5. 次のオプシ ョ ンを設定します。

♦ [HDL] :  [VHDL]

♦ [Simulation Test Bench] :  [Generate test bench template] をオフ

♦ [Simulation Models] :  [Behavioral]

次に、 シ ミ ュレーシ ョ ンする実行ファイルを選択します。

6. [Applications] タブで [Project: TestApp_Peripheral_microblaze_0] を右ク リ ッ ク し、 [Mark to
Initialize BRAMs] をク リ ッ ク します。 

7. [Project: TestApp_Peripheral_microblaze_0] を右ク リ ッ ク し 、[Build Project] をク リ ッ ク します。

8. XPS で [Simulation] → [Compile Simulation Libraries] をク リ ッ ク し、ウ ィザードの指示に従っ

てシ ミ ュレーシ ョ ン ラ イブラ リ をコンパイルまたはシ ミ ュレーシ ョ ン ライブラ リの場所を指

定します。 これには数分かかり ます。
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9. [Simulation] → [Generate Simulation HDL Files] をク リ ッ ク します。

これで、 ブロ ッ ク  RAM から実行される  C コード も含め、 エンベデッ ド  システム全体を表す

VHDL ファ イルが生成されました。

シ ミ ュレーシ ョ ン モデルの生成オプシ ョ ンを設定したので、最上位 VHDL ファ イルを作成し、プロ

セッサ サブシステムをインスタンシエート します。

1. ISE で、 <project name>/system/hdl ディ レク ト リにある  system_stub.vhd ソース

ファ イルを開きます。 このファ イルは、第 7 章でエンベデッ ド  システムのネッ ト リ ス ト を作成

したと きに自動的に生成されたものです。

2. [File] → [Save As] をク リ ッ ク し、 ファ イルを system_top.vhd とい う名前で保存します。

ファ イルはツールを実行する と上書きされるので、 異なる名前で保存するこ とは重要です。

3. [Project] → [Add Source] をク リ ッ ク します。

4. 先ほど作成したプロジェク トの system\hdl サブディ レク ト リにある  system_top.vhd
ファ イルを選択します。 [Adding Source Files] ダイアログ ボッ クスで [Association] を [All] に
設定します。

5. [Design] パネルの [Sources for] ド ロ ッ プダウン  リ スト で [Behavioral Simulation] を選択し

ます。

6. system_top.vhd ファ イルの最後 (#end architecture STRUCTURE 文の後) に次のコー

ドを追加します。 

-- synthesis translate_off
configuration system_conf_top of system_stub is
 for STRUCTURE

 for system_i : system
 use configuration work.system_conf;

 end for;
 end for;
end system_conf_top;
-- synthesis translate_on

このコードは、データで初期化する必要のあるブロ ッ ク  RAM を含む任意の VHDL デザインに

追加できます。

7. ファ イルを保存します。

次に、 シ ミ ュレーシ ョ ンを実行するよ う  Project Navigator を設定します。

1. ISE プロジェク トの最上位ディ レク ト リに pn.do ファ イル (このマニュアルの添付ファイル)
をコピーします。

メモ : 添付ファイルは、 Adobe Acrobat Reader の左下にある ク リ ップ アイコンをク リ ッ クす

る と表示されます。

2. [Design] パネルの [Processes] ペインで [ModelSim Simulator] → [Simulate Behavioral Model]
を右ク リ ッ ク し、 [Process Properties] をク リ ッ ク します。 

http://www.xilinx.com


EDK コンセプ ト、 ツール、 テクニッ ク japan.xilinx.com 87
UG683 EDK 11.1

シミ ュレーシ ョ ン

3. 次の手順に従って、 コピーした pn.do ファ イルを指定します。

♦ [Use Automatic Do File] をオフにします。

♦ [Use Custom Do File] をオンにし、 [Custom Do File] で pn.do を指定します。

4. [OK] をク リ ッ ク します。

5. [Simulate Behavioral Model] をダブルク リ ッ ク して ModelSim を実行します。

出力の観察

シ ミ ュレーシ ョ ンが読み込まれ、実行される と、ModelSim の [Wave] ウ ィンド ウにエンベデッ ド  デ
ザインの最上位信号が表示されます。

MicroBlaze™ プロセッサのコードは、ブロ ッ ク  RAM のロケーシ ョ ン 0x00000000 から開始しま

す。 これを表示するには、[Wave] ウ ィンド ウで signal/system/ilmb_lmb_abus (MicroBlaze
ローカル メモ リ  アドレス  バス) の 1400000ps 付近にスク ロールします。 アドレス  0、4、8... が表示

されます。 これらのアドレスでフェッチされる命令は /system/ilmb_lmb_readdbus ファ イル

にあ り ます。

X-Ref Target - Figure A-1

図 A-1 : [Process Properties] ダイアログ ボックスの [Simulation Properties] ページ
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実行された処理

XPS で構築および管理し、SDK で実行した TestApp_Memory_Microblaze ソフ ト ウェア プロ

ジェク ト を ModelSim でシ ミ ュレーシ ョ ンしました。 シ ミ ュレーシ ョ ン モデル生成ツールである

Simgen によ り、XPS の [Applications] タブで [Mark to Initialize BRAMs] をオンにしたプログラム

が認識され、 シ ミ ュレーシ ョ ン モデルが生成されます。

シ ミ ュレーシ ョ ンされた ELF ファ イル (executable.elf) は、 プロジェク ト  ディ レク ト リの

system\TestApp_Memory_Microblaze_0 サブディ レク ト リにあ り ます。

SDK で開発したアプリ ケーシ ョ ンをシ ミ ュレーシ ョ ンする場合は、 ELF ファ イルを \system\
TestApp_Memory_Microblaze_0 にコピーし、シ ミ ュレーシ ョ ン HDL ファ イルを再生成して

シ ミ ュレーシ ョ ンを再実行できます。

こ こに示した方法は、オンチップ ブロ ッ ク  RAM から実行されるソフ ト ウェア用です。 外部 DDR2
メモ リから実行されるコードのシ ミ ュレーシ ョ ンについては、 このマニュアルでは説明していませ

ん。 外部 DDR2 メモ リからのシ ミ ュレーシ ョ ン方法は、 http://japan.xilinx.com/support/
documentation/sw_manuals/xilinx11/manuals.pdf から『合成/シ ミ ュレーシ ョ ン デザイン ガイ ド』を

参照して ください。

エンベデッ ド  システムのシ ミ ュレーシ ョ ン環境を構築するには、 必要な手順が多数あ り ます。 シ

ミ ュレーシ ョ ン環境を一度設定する と、エンベデッ ド  システムと  FPGA のそれ以外の部分を両方シ

ミ ュレーシ ョ ンするために使用できます。

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx11/manuals.pdf
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx11/manuals.pdf
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付録 B

IP バス ファンクシ ョ ン モデル 
シミ ュレーシ ョ ン

この付録では、第 7 章「独自の IP の作成」の pwm_lights デザインおよびバス  ファンクシ ョ ン モ
デル (BFM) シ ミ ュレーシ ョ ン プラ ッ ト フォームを使用します。第 7 章 のチュート リ アルを実行し

ていない場合は、 戻ってデザインを完了させる必要があ り ます。

また、 EDK シ ミ ュレーシ ョ ン ラ イブラ リがコンパイルされているこ とが必要です。

BFM についてと使用する理由

バス  ファンクシ ョ ン モデルは、 バス  ト ランザクシ ョ ン (この場合は PLBv46) の動作をモデリ ング

するために使用するシ ミ ュレーシ ョ ン モデルです。 BFM は、通常カスタム IP の動作をモデリ ング

する目的でのみ使用されます。 また、BFM シ ミ ュレーシ ョ ンは合成後のシ ミ ュレーシ ョ ンまたはタ

イ ミ ング シ ミ ュレーシ ョ ンよ り も高速なので、複雑な ト ランザクシ ョ ンのシ ミ ュレーシ ョ ンを高速

化するためにも使用されます。

PLBv46 の仕様は長くて複雑です。 カスタム IP をバスに接続して、IP がバス仕様を満たすかど うか

を検証する必要がある場合があ り ます。 テス トベンチを作成して適切なスティ ミ ュラスを作成し、

正し く動作するかど うかを確認するのは非常に困難であ り、 テス トベンチが正し く記述されている

かど うかを確認する手段もあ り ません。

これを支援するため、 既知の適切なスティ ミ ュラス  モデルと して使用可能なバス  ファンクシ ョ ン

モデル (BFM) が作成されました。 PLBv46 マスタおよびスレーブ デバイスのモデルだけでなく、ト

ランザクシ ョ ンをキャプチャし、 正し く動作しているかど うかを検証するために使用可能なモニタ

モジュールも含まれています。

BFM コンパイラ  (BFC) も含まれており、 特定のデザイン言語を使用して、 一連の読み出しおよび

書き込みバス  ト ランザクシ ョ ンと予測される値を記述できます。 

概念的には簡単ですが、バス  ファンクシ ョ ン シ ミ ュレーシ ョ ンを実行するシ ミ ュレーシ ョ ン環境を

手動で設定するのは困難です。 CIP ウ ィザードでは、 必要な BFM シ ミ ュレーシ ョ ン モデルをテス

ト中の IP に自動的に接続できます。

メモ : bfm_system プロジェク ト を起動したと きに Version Management ウ ィザードが開いた場

合は、 必要なコアをアップデート してください。
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チュート リアル :  BFM の実行

チュート リ アルを開始する前に、 開いている  XPS プロジェク ト を閉じます。 BFM を作成するよ う

指定した場合、pcores\pwm_lights_v1_00_a\devl ディレク ト リに bfmsim というサブディ

レク ト リが作成され、bfm_system.xmp とい う  XPS BFM シ ミ ュレーシ ョ ン プロジェク トが保存

されています。

1. XPS で bfm_system.xmp プロジェク ト  ファ イルを開きます。 [Bus Interfaces] タブの表示

は、 次のよ うになり ます。

2. [Project] → [Project Options] → [HDL and Simulation] タブをク リ ッ ク します。

3. シ ミ ュレーシ ョ ンする  HDL 言語を選択します。 こ こでは、 デフォルトの [VHDL] をオンにし

ます。

4. BFM ではビヘイビア シ ミ ュレーシ ョ ンのみが可能なので、[Simulation Models] はデフォルト

の [Behavioral] をオンのままにします。

5. シ ミ ュレーシ ョ ン オプシ ョ ンの設定が終了したら、 [OK] をク リ ッ ク します。

6. [Simulation] → [Generate Simulation HDL Files] をク リ ッ ク し、 Simgen (Simulation Model
Generator) を実行します。

Simgen を実行する と、bfmsim ディレク ト リに simulation ディ レク ト リが作成されます。 この

ディ レク ト リには、 HDL ラ ッパ ファイルとビヘイビア シ ミ ュレーシ ョ ンの実行に必要な DO
スク リプ ト  ファ イルが含まれています。

7. ツールバーの [Custom Button 1] をク リ ッ ク します。 CIP ウ ィザードによ り、 BFM シ ミ ュレー

シ ョ ン プロジェク トが作成されたと きにこのツールバー ボタンが設定されています。 

[Custom Button 1] をク リ ッ クする と、 次の処理が実行されます。

♦ Bash シェルが起動し、 makefile が実行されます。

♦ 設定したシミ ュレーショ ン  オプショ ンを使用して、 sample.bfl ファ イルに対して  
CoreConnect™ ツールキッ ト  バス  ファンク ショ ン  コンパイラ  (BFC) が実行されます (詳
細は <project name>\pcores\pwm_lights_v1_00_a\devl\bfmsim\scripts\sample.bfl

を参照)。

♦ BFC 出力コマンド  ファ イル (シ ミ ュレータによって INCLUDE または DO ファ イル) を使

用してシ ミ ュレータが実行され、 sample.bfl ファ イルのコマンドが実行されます。 

X-Ref Target - Figure B-1

図 B-1 : XPS BFM ユーザー pcore シミ ュレーシ ョ ン プロジェク ト
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次に示すよ う なシ ミ ュレータ波形が表示されます。

実行された処理

CIP ウ ィザードは、 シ ミ ュレーシ ョ ンを実行する前に次の処理を実行します。

CIP ウィザードでテス ト  
プロジェク ト を作成

• HDL テンプレート  ファ イルを生成します。このテンプレート を変更する と、機能する  pcore を
作成できます。

• テス ト  プロジェク ト を生成します。 pcore が独立したものになるので、 システムに統合する前

にバスとの動作を検証できます。

こ のプ ロ ジ ェ ク ト は、 <project_name>\pcores\pwm_lights_v1_00_a\devl\bfmsim

ディ レク ト リに作成されます。

このテス ト  プロジェク トでは、CoreConnect ツールキッ トで提供される複数の BFM が使用されま

す。 こ こでは、 プロセッサ、 バス、 メモ リ、 およびバス  モニタのモデルがあ り、 すべてコアに接続

されます。

XPS ツールの利点 XPS を使用する と、 これらのモデルを手動で作成する必要がなく、すべて自動的に正し く接続され

ます。

シ ミ ュレーシ ョ ン プラ ッ ト フォームを生成した後、 [Custom Button 1] を使用するこ とによ り、 シ

ミ ュレーシ ョ ン プロセスのいくつかの面倒な手順が自動化されます。 CoreConnect バス  ファンク

シ ョ ン コンパイラを使用して sample.bfl が実行され、シ ミ ュレータで使用するコマンド  ファ イ

ルが生成されます。

X-Ref Target - Figure B-2

図 B-2 : sample.bfl の BFM 波形シミ ュレーシ ョ ン結果
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カスタム ボタンの詳細は、[Project] → [Customize Buttons] をク リ ッ ク し、F1 キーを押してくださ

い。 使用する  makefile の場所は、 次のチュート リ アルで示します。

[Custom Button 1] によ り実行される  makefile は、BFL のコンパイルに加え、コマンド  ファ イルを

使用してシ ミ ュレータを起動し、 シ ミ ュレーシ ョ ンを開始します。 シ ミ ュレーシ ョ ンの開始と コン

パイル プロセスを 1 つのボタンのク リ ッ クで実行できます。

チュート リアル :  バス ト ランザクシ ョ ンを実行するスクリプ トの記述

BFM スク リプ トの構文は直感的に理解できるものではあ り ませんが、 完成したスク リプ ト を参照

するこ とによ り、 簡単に機能を拡張できます。

1. XPS で [File] → [Open] をク リ ッ ク し、 <project name>\pcores\

wm_lights_v1_00_a\devl\bfmsim\scripts ディ レク ト リに移動します。

2. sample.bfl ファ イルを開きます。

このファ イルをこのマニュアルに添付されている  sample.bfl ファ イルで置換するこ と もで

きます。 その場合は、 手順 5 に進んでください。

コードの最初の約 160 行では、 コマンド  ラ インを解読しやすくするためのコマンド  エイ リア

スが設定されています。 これらのコマンドはソースおよびデスティネーシ ョ ン メ  モリに自動的

に値を設定し、 さまざまなコア機能をテス ト します。 コアの要件に応じてコマンドを追加また

は削除したり、 まった く新しい BFL コマンド  ファ イルを作成できます。

BFL コマン ドの情報 メモ : 新しい BFL ファ イルを作成する場合は、 bfmsim ディ レク ト リにある  
bfm_sim_xps.make ファ イルを変更する必要があ り ます。 BFL コマンドの詳細は、

$XILINX_EDK\third_party\doc の PLBToolkit.pdf ファ イルを参照して ください。

次に、BFM コードを変更して pwm_lights の実際のシ ミ ュレーシ ョ ンを実行し、バス  ファン

クシ ョ ン シ ミ ュレーシ ョ ンの高度な機能を見てみます。

完成した sample.bfl ファ イルは、 このマニュアルに添付されています。 この添付ファイル

は、 このチュート リ アルで変更したファイルと比較するのに使用するか、 またはこ こで作成す

る  sample.bfl と置換できます。 このチュート リ アルでのコピー作業を簡単にするため、

sample.bfl ファ イルに追加するコマンドが、 このマニュアルに添付されている  
bus_transaction_bfl_code.txt とい うテキス ト  ファ イルに含まれています。

メモ : 添付ファイルは、 Adobe Acrobat Reader の左下にある ク リ ップ アイコンをク リ ッ クす

る と表示されます。

sample.bfl にコマン ド
を追加

3. sample.bfl テンプレートで、175 行目付近にある 「configure」 で開始する行を次のよ うに

変更します。

configure(msize = 01)
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4. ファ イルの最後の方にある 「Start Testing」 セクシ ョ ンの後に、

bus_transaction_bfl_code.txt. から次のコードを追加します。 これらのコマンドで、

バス  ト ランザクシ ョ ンが生成されます。

--
-- Define several bus transactions for pwm_lights
-- Memory updates are 64 bits write, bus transactions are 32 bits wide.
--
--
-- Write value of 22 hex to LED register
--
mem_update(addr=30000010,data=22222222_22222222)
write (addr=30000010,size=0000,be=11110000)
-- Read status register, expect to get F0F02207
read (addr=30000000,size=0000,be=11110000) 
-- Write to offset 0, then read status, expect to get F0F02208
mem_update(addr=30000000,data=00000000_00000000)
write (addr=30000000,size=0000,be=11110000)
read (addr=30000000,size=0000,be=11110000) 
-- Write to offset 4, then read status, expect to get F0F02200
--mem_update(addr=30000000,data=00000000_00000000)
write (addr=30000004,size=0000,be=00001111)
read (addr=30000000,size=0000,be=00001111) 
-- Write to offset 8, then read status, expect to get F0F02208
mem_update(addr=30000008,data=00000000_00000000)
write (addr=30000008,size=0000,be=11110000)
read (addr=30000000,size=0000,be=11110000) 
-- Write to offset C, then read status, expect to get F0F02200
--mem_update(addr=30000000,data=00000000_00000000)
write (addr=3000000C,size=0000,be=00001111)
read (addr=30000000,size=0000,be=00001111)
001111)

このコードで実行される処理は、 次のとおりです。

♦ mem_update は、 書き込むアドレスに書き込みデータ値を設定します。 

♦ write コマンドは PLB 書き込みを開始し、 read コマンドは PLB 読み出しを開始します。

♦ size=0000 は、 シングル ト ランザクシ ョ ンであるこ とを示します。

♦ be (バイ ト  イネーブル) 設定は、 64 ビッ ト  バスに対応します。

♦ 0、 8、 などに揃えられているアドレスは、 バイ ト  イネーブルを 11110000 に設定します。

♦ 4、 c、 などに揃えられているアドレスは、 バイ ト  イネーブルを 00001111 に設定します。

5. マニュアルに添付されている  sample.bfl ファ イルを開きます。

6. こ こで作成した sample.bfl ファ イルが添付ファイルと同じであるかど うかを確認し、 ファ

イルを保存します。

7. [Custom Button 1] をク リ ッ ク します。

8. ModelSim の波形ウ ィンド ウで、 信号リ ス トの最後にスクロールします。 最後にリ ス ト されて

いる信号は user_logic の信号で、 pwm_logic pcore のカスタム信号です。
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実行された処理

BFM スク リプ トは、pcore に対して書き込みと読み出しを交互に 5 回実行します。 BFM スク リプ ト

を参照し、 書き込みが実行される順序を確認してください。

♦ ip2bus_rdack が High の場合、 ip2bus_data 信号には pwm_lights から リード

バッ ク された値が含まれます。

♦ シ ミ ュレーシ ョ ンでは、 コアへの書き込みの順序は F0F02207、 F0F02208、 FF002200、

FF002204、 FF002205 と示されます。 

この情報をシ ミ ュレーシ ョ ンで確認してください。 最初の値のリードバッ クは、 450ns で発生しま

す。 これは、 これらの特定の値がリードバッ ク される理由を理解するのに役立ちます。

CIP ウ ィザードでは、 BFL ファ イルに加え、 bfmsim プロジェク ト  ディ レク ト リの下に対応する

pcores ディレク ト リ も作成されます。このディ レク ト リには、BFM テス トベンチのテンプレート

が含まれます。

コア ロジッ クの要件に応じて、 テンプレート  テス トベンチに追加できます。

バス  ファンクシ ョ ン シ ミ ュレーシ ョ ンの高度な機能と、 XPS で自動的に実行される処理を活用す

る方法を学びました。 カスタム IP を作成する際に BFM シ ミ ュレーシ ョ ンを実行する と、テス ト時

間を短縮し、 IP が予測どおりに機能するこ とを確実にできます。
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B

BBD ファイル

ブラ ッ ク  ボッ クス定義ファ イル。 ペリ フェラルで使用されるネッ ト リ ス ト

ファ イルを リ ス ト します。

BFL
Bus Functional Language (バス  ファンクシ ョ ン言語) の略。

BFM
Bus Functional Model (バス  ファンクシ ョ ン モデル) の略。

BIT ファイル

ビッ ト ス ト リーム ファ イル。

BitInit
Bitstream Initializer の略。 FPGA 上のプロセッサの命令メモ リ を初期化し、

ブロ ッ ク  RAM の命令メモリに格納するツールです。

BMM ファイル

ブロ ッ ク  RAM のマップ ファ イル。 各ブロッ ク  RAM がどのよ うに連続した

論理データ空間を構成するかが記述されています。 Data2MEM は、このファ

イルを使用してデータを最適な初期化形式に変換します。 BMM ファ イルは

テキス ト  ファ イルなので、 直接編集可能です。

BSB
Base System Builder の略。 EDK デザインを作成するためのウ ィザードです。

Base System Builder で使用されるファ イル タイプも  BSB です。

BSP
「Standalone BSP」 を参照して ください。
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C

CFI
Common Flash Interface (共通フラ ッシュ  インターフェイス) の略。

D

DCM
Digital Clock Manager (デジタル クロ ッ ク  マネージャ ) の略。

DCR
デバイス  コン ト ロール レジスタ。

DLMB
データ側のローカル メモ リ  バス。 「LMB」 も参照して ください。

DMA
Direct Memory Access の略。

DOPB
データ側のオンチップ ペリ フェラル バス。 「OPB」 も参照してください。

DRC
デザイン ルール チェッ ク。

DSPLB
データ側のプロセッサ ローカル バス。 「ISPLB」 も参照してください。

E

EDIF ファイル

Electronic Data Interchange Format の略。 業界標準のネッ ト リ ス ト  ファ イル

形式です。

EDK
ザイ リ ンクス  エンベデッ ド開発キッ ト

ELF ファイル

Executable and Linked Format の略。 CPU 実行コードのイ メージを含む、

CPU 上で実行可能なバイナリ  データ  ファ イル。コンパイラ / リ ンカによって

作成されます。ELF ファ イルは基本的なデータ入力形式であ り、Data2MEM
で使用されます。 Data2MEM には、 ELF ファ イルの内容を確認する機能も

備わっています。
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EMC
External Memory Controller の略。 外部メモリ  コン ト ローラ。

EST
エンベデッ ド  システム ツール。

F

FATfs (XilFATfs)
LibXil FATFile システム。 XilFATfs ファ イル システムのアクセス  ライブラ

リ を使用する と、 ザイ リ ンクス  System ACE のコンパク ト  フラ ッシュまた

は IBM のマイク ロ ド ライブ デバイスに保存されたファイルに対して読み出

し /書き込みを実行できます。

Flat View
[IP Catalog] タブおよび [System Assembly View] で、項目をグループ化せず

にすべてフラ ッ トに表示するビューです。 

FPGA
Field Programmable Gate Array の略。 ザイ リ ンクスが開発した集積回路で、

IC を製造、 出荷した後、 エンド  ユーザーがザイ リ ンクスの開発システム ソ
フ ト ウェアを使用し、 ロジッ ク  ファンクシ ョ ンを定義します。ザイ リ ンクス

では、 RAM ベースの FPGA デバイスを提供しています。

FSL
MicroBlaze™ の高速シンプレッ クス  リ ンク。 単一方向のポイン ト  ト ゥ  ポイ

ン ト  (PPP) データ  ス ト リーミ ング インターフェイスで、 ハード ウェア間で

のデータ送信を高速にします。 MicroBlaze プロセッサには、 FSL インター

フェイスが直接接続されています。

G

GDB
GNU デバッガ。

GPIO
汎用入出力。 オンチップ ペリ フェラル バスに接続される  32 ビッ ト のペリ

フェラルです。
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H

HDL 言語

ハードウェア記述言語。

Hierarchical View 
[IP Catalog] タブおよび [System Assembly View] タブの両方でのデフォル

トの表示方法で、IP インスタンスごとにグループ化されています。 IP インス

タンスは、 分類条件 (上からプロセッサ、 バス、 バス  ブリ ッジ、 ペリ フェラ

ル、汎用 IP) に基づいて リ ス ト されています。 同じ種類の IP インスタンスは、

アルファベッ ト順に表示されます。 IP 別に表示する と、IP インスタンスに関

連するデータすべてを簡単に確認できます。 この表示は、 ハード ウェア プ
ラ ッ ト フォームに IP インスタンスを追加する場合に特に便利です。 

I

IBA
Integrated Bus Analyzer の略。

IDE
Integrated Design Environment の略。

ILA
Integrated Logic Analyzer の略。

ILMB
命令側のローカル メモ リ  バス。 「LMB」 も参照して ください。

IOPB
命令側のオンチップ ペリ フェラル バス。 「OPB」 も参照してください。

IPIC
IP インターコネク ト 。

IPIF
IP インターフェイス。

ISA
命令セッ ト  アーキテクチャ。 プロセッサの命令セッ ト 、レジスタ、割り込み、

例外、 アドレスなどをプログラマに対してどのよ うに表示するかが記述され

ています。

ISC
割り込みソース  コン ト ローラ。
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ISE ファイル

ザイ リ ンクス  ISE® (Integrated Software Environment) の Project Navigator
プロジェク ト  ファ イル。

ISOCM 
命令側のオンチップ メモ リ。

ISPLB
命令側のプロセッサ ローカル バス。 「DSPLB」 も参照してください。

ISS
命令セッ ト  シ ミ ュレータ。

J

JTAG
Joint Test Action Group の略。

L

Libgen
XPS (Xilinx® Platform Studio™) に含まれる  Library Generator の略。

LibXil 標準 C ライブラリ

標準 C ライブラ リ関数、およびペリ フェラルにアクセスするための関数を含

む EDK ライブラ リ とデバイス  ド ラ イバ。 EDK ライブラ リは、 MSS ファ イ

ルの情報を基に Libgen で自動的にコンフ ィギュレーシ ョ ンされます。 

LMB
ローカル メモ リ  バス。 主にオンチップ ブロ ッ ク  RAM にアクセスするのに

使用する レ イテンシの低い同期バスです。 MicroBlaze プロセッ サには、

ILMB バス と  DLMB バスが含まれます。

M

MDD ファイル

Microprocessor Driver Definition の略。

MDM
Microprocessor Debug Module の略。
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MFS ファイル

LibXil Memory File System の略。 ファ イル ハンドルの形式で、 ユーザーが

プログラム メモ リ を管理できます。

MHS ファイル

Microprocessor Hardware Specification の略。 バス、ペリ フェラル、プロセッ

サ、接続、アドレス空間などのエンベデッ ド  プロセッサ システムのコンフ ィ

ギュレーシ ョ ンを定義するファイルです。

MLD ファイル

Microprocessor Library Definition の略。

MOST®

Media Oriented Systems Transport の略。 オートモーティブネ ッ  ト ワーク  デ
バイスの開発規格です。

MPD ファイル

Microprocessor Peripheral Definition の略。 ペリ フェラルで使用可能なポー

トおよびハードウェア パラ メータがすべて含まれます。

MSS ファイル

Microprocessor Software Specification の略。

MVS ファイル

Microprocessor Verification Specification の略。

N

NCF ファイル

ネッ ト リ ス ト制約ファイル。

NGC ファイル

論理デザイン データ と制約の情報を含むネッ ト リ ス ト  ファ イル。 EDIF およ

び NCF ファ イルからの情報がこのファイルに含まれています。

NGD ファイル

Native Generic Database の略。 ザイ リ ンクス プリ ミ ティブで記述された論理

的デザイン ファ イル。

NGO ファイル

ザイ リ ンクス特定のフォーマッ トのバイナリ  ファ イルで、オ リジナルのコン

ポーネン ト と階層によるデザインの論理記述が含まれます。
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NPI
Native Port Interface の略。 ネイティブ ポート  インターフェイス。

ISE ファイル

ザイ リ ンクス  ISE Project Navigator の以前のプロジェク ト  ファ イル。

O

OCM
オンチップ メモ リ。

OPB
オンチップ ペリ フェラル バス。

P

PACE
Pinout and Area Constraints Editor の略。

PAO ファイル

Peripheral Analyze Order ファ イル。 合成およびシ ミ ュレーシ ョ ンに必要な

HDL ファ イルの解析順を定義します。

PBD ファイル

Processor Block Diagram ファ イル。

Platgen
XPS に含まれる  Hardware Platform Generator の略。

PLB
プロセッサ ローカル バス。

PROM
Programmable Read-Only Memory の略で、 プログラム可能な読み取り専用

のメモ リです。

PSF
Platform Specification Format の略。 EDK ツールを駆動するデータ  ファ イル

の形式です。
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S

SDF ファイル

Standard Data Format ファ イル。 プログラム間のデータを転送するために固

定長フィールドを使用するデータ形式です。

SDK
ソフ ト ウェア開発キッ ト 。

SDMA
Soft Direct Memory Access の略。

Simgen
XPS に含まれる  Simulation Generator の略。

SPI
Serial Peripheral Interface (シ リ アル ペリ フェラル インターフェイス) の略。

Standalone BSP
スタンドアロン ボード  サポート  パッケージ。 プロセッサに特有の関数にア

クセスするソフ ト ウェア モジュールのセッ トで、 アプリケーシ ョ ンがボード

またはプロセッサ機能に直接 (OS レイヤなしで) アクセスする際に使用され

ます。

SVF ファイル

Serial Vector Format ファ イル。 スティ ミ ュラスで表現されたテス ト  パター

ン、予測される応答、 IEEE 1149.1 ベースのテス ト用のマスク  データを記述

する  ASCII 形式のファイル。さまざまなシ ミ ュレーシ ョ ン ソフ ト ウェア、テ

ス ト装置で使用できます。

U

UART
Universal Asynchronous Receiver-Transmitter の略。

UCF
ユーザー制約ファイル。

V

VHDL
VHSIC ハードウェア記述言語。

http://www.xilinx.com


EDK コンセプ ト、 ツール、 テクニッ ク japan.xilinx.com 103
UG683 EDK 11.1

EDK で使用される用語

X

XBD ファイル

ザイ リ ンクス  ボード定義ファイル。

XCL
Xilinx CacheLink の略。 MicroBlaze プロセッサで使用可能な高パフォーマ

ンスの外部メモ リ  キャ ッシュ  インターフェイスです。

Xilkernel
EDK に含まれるザイ リ ンクス  エンベデッ ド  カーネル。 ザイ リ ンクス  エンベ

デッ ド  ソフ ト ウェア プラ ッ ト フォーム用のコンフ ィギュレーシ ョ ン可能な

モジュール型の小型 RTOS です。

XMD
Xilinx Microprocessor Debugger の略。

XMP ファイル

Xilinx Microprocessor Project の略。 EDK デザインの最上位のプロジェク ト

ファ イルです。

XPS
Xilinx Platform Studio の略。 エンベデッ ド  デザインを開発する  GUI 環境です。

XST
Xilinx Synthesis Technology の略。

Z

ZBT
Zero Bus Turnaround™ の略。

さ

ソフ トウェア プラッ ト フォーム

ソフ ト ウェア プラ ッ ト フォームは、アプ リケーシ ョ ンを構築するソフ ト ウェ

ア ド ラ イバおよび OS をま とめたものです。 ハード ウェア プラ ッ ト フォーム

の流動性およびザイ リ ンク スおよびサードパーティ  パートナーのサポート

によ り、 各ハード ウェア プラ ッ ト フォームに対して複数のソフ ト ウェア プ
ラ ッ ト フォームを作成できます。

http://japan.xilinx.com


104 japan.xilinx.com EDK コンセプ ト、 ツール、 テクニッ ク
UG683 EDK 11.1

付録 C : 用語集

は

ブロック  RAM (BRAM)
デバイスに組み込まれた LUT ベースのランダム アクセス  メモ リ  (RAM) の
ブロ ッ ク。 分散 RAM とは区別されます。

ハードウェア プラッ ト フォーム

ザイ リ ンクスの FPGA 技術を使用する と、 プロセッサ サブシステムのハー

ド ウェア ロジッ クをカスタマイズ可能です。 標準的なマイ ク ロプロセッサ

チップまたはコン ト ローラ  チップでは、このよ う なカスタマイズは不可能で

す。 ハードウェア プラ ッ ト フォームは、 ザイ リ ンクスの技術を使用して作成

するエンベデッ ド  プロセッサ サブシステムです。
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------------------------------------------------------------------------------
-- user_logic.vhd - entity/architecture pair
------------------------------------------------------------------------------
--
-- ***************************************************************************
-- ** Copyright (c) 1995-2009 Xilinx, Inc.  All rights reserved.            **
-- **                                                                       **
-- ** Xilinx, Inc.                                                          **
-- ** XILINX IS PROVIDING THIS DESIGN, CODE, OR INFORMATION "AS IS"         **
-- ** AS A COURTESY TO YOU, SOLELY FOR USE IN DEVELOPING PROGRAMS AND       **
-- ** SOLUTIONS FOR XILINX DEVICES.  BY PROVIDING THIS DESIGN, CODE,        **
-- ** OR INFORMATION AS ONE POSSIBLE IMPLEMENTATION OF THIS FEATURE,        **
-- ** APPLICATION OR STANDARD, XILINX IS MAKING NO REPRESENTATION           **
-- ** THAT THIS IMPLEMENTATION IS FREE FROM ANY CLAIMS OF INFRINGEMENT,     **
-- ** AND YOU ARE RESPONSIBLE FOR OBTAINING ANY RIGHTS YOU MAY REQUIRE      **
-- ** FOR YOUR IMPLEMENTATION.  XILINX EXPRESSLY DISCLAIMS ANY              **
-- ** WARRANTY WHATSOEVER WITH RESPECT TO THE ADEQUACY OF THE               **
-- ** IMPLEMENTATION, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OR        **
-- ** REPRESENTATIONS THAT THIS IMPLEMENTATION IS FREE FROM CLAIMS OF       **
-- ** INFRINGEMENT, IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS       **
-- ** FOR A PARTICULAR PURPOSE.                                             **
-- **                                                                       **
-- ***************************************************************************
--
------------------------------------------------------------------------------
-- Filename:          user_logic.vhd
-- Version:           1.00.a
-- Description:       User logic.
-- Date:              Tue Mar 03 13:22:55 2009 (by Create and Import Peripheral Wizard)
-- VHDL Standard:     VHDL'93
------------------------------------------------------------------------------
-- Naming Conventions:
--   active low signals:                    "*_n"
--   clock signals:                         "clk", "clk_div#", "clk_#x"
--   reset signals:                         "rst", "rst_n"
--   generics:                              "C_*"
--   user defined types:                    "*_TYPE"
--   state machine next state:              "*_ns"
--   state machine current state:           "*_cs"
--   combinatorial signals:                 "*_com"
--   pipelined or register delay signals:   "*_d#"
--   counter signals:                       "*cnt*"
--   clock enable signals:                  "*_ce"
--   internal version of output port:       "*_i"
--   device pins:                           "*_pin"
--   ports:                                 "- Names begin with Uppercase"
--   processes:                             "*_PROCESS"
--   component instantiations:              "<ENTITY_>I_<#|FUNC>"
------------------------------------------------------------------------------

-- DO NOT EDIT BELOW THIS LINE --------------------
library ieee;
use ieee.std_logic_1164.all;
use ieee.std_logic_arith.all;
use ieee.std_logic_unsigned.all;

library proc_common_v3_00_a;
use proc_common_v3_00_a.proc_common_pkg.all;

-- DO NOT EDIT ABOVE THIS LINE --------------------

--USER libraries added here

------------------------------------------------------------------------------
-- Entity section
------------------------------------------------------------------------------
-- Definition of Generics:
--   C_SLV_DWIDTH                 -- Slave interface data bus width
--   C_NUM_REG                    -- Number of software accessible registers
--
-- Definition of Ports:
--   Bus2IP_Clk                   -- Bus to IP clock
--   Bus2IP_Reset                 -- Bus to IP reset
--   Bus2IP_Addr                  -- Bus to IP address bus
--   Bus2IP_Data                  -- Bus to IP data bus
--   Bus2IP_BE                    -- Bus to IP byte enables
--   Bus2IP_RdCE                  -- Bus to IP read chip enable
--   Bus2IP_WrCE                  -- Bus to IP write chip enable
--   IP2Bus_Data                  -- IP to Bus data bus
--   IP2Bus_RdAck                 -- IP to Bus read transfer acknowledgement
--   IP2Bus_WrAck                 -- IP to Bus write transfer acknowledgement
--   IP2Bus_Error                 -- IP to Bus error response
------------------------------------------------------------------------------

entity user_logic is
  generic
  (
    -- ADD USER GENERICS BELOW THIS LINE ---------------
    --USER generics added here
    -- ADD USER GENERICS ABOVE THIS LINE ---------------

    -- DO NOT EDIT BELOW THIS LINE ---------------------
    -- Bus protocol parameters, do not add to or delete
    C_SLV_DWIDTH                   : integer              := 32;
    C_NUM_REG                      : integer              := 1
    -- DO NOT EDIT ABOVE THIS LINE ---------------------
  );
  port
  (
    -- ADD USER PORTS BELOW THIS LINE ------------------
    LEDs                           : out std_logic_vector (0 to 7);
    -- ADD USER PORTS ABOVE THIS LINE ------------------

    -- DO NOT EDIT BELOW THIS LINE ---------------------
    -- Bus protocol ports, do not add to or delete
    Bus2IP_Clk                     : in  std_logic;
    Bus2IP_Reset                   : in  std_logic;
    Bus2IP_Addr                    : in  std_logic_vector(0 to 31);
    Bus2IP_Data                    : in  std_logic_vector(0 to C_SLV_DWIDTH-1);
    Bus2IP_BE                      : in  std_logic_vector(0 to C_SLV_DWIDTH/8-1);
    Bus2IP_RdCE                    : in  std_logic_vector(0 to C_NUM_REG-1);
    Bus2IP_WrCE                    : in  std_logic_vector(0 to C_NUM_REG-1);
    IP2Bus_Data                    : out std_logic_vector(0 to C_SLV_DWIDTH-1);
    IP2Bus_RdAck                   : out std_logic;
    IP2Bus_WrAck                   : out std_logic;
    IP2Bus_Error                   : out std_logic
    -- DO NOT EDIT ABOVE THIS LINE ---------------------
  );

  attribute SIGIS : string;
  attribute SIGIS of Bus2IP_Clk    : signal is "CLK";
  attribute SIGIS of Bus2IP_Reset  : signal is "RST";

end entity user_logic;

------------------------------------------------------------------------------
-- Architecture section
------------------------------------------------------------------------------

architecture IMP of user_logic is

signal count:                std_logic_vector (28 downto 0);
constant slow_clock_tap:     integer := 24;
signal PWM_clock:            std_logic;
constant PWM_tap:            integer := 16;
signal all_off:              std_logic;
signal run:                  std_logic;
signal linear:               std_logic_vector (1 downto 0);  -- 00 = log, 01 = linear, 1x - register
signal PWM_value:            std_logic_vector (7 downto 0);

signal reg_value:            std_logic_vector (7 downto 0);

begin

--
-- Clock generator block
-- Assume clock frequency is 125Mhz
-- Tap 16 yields about 975Hz (PWM clock)
-- Tap 24 yields about 4Hz (Update clock)
--
clock_divider: process(BUS2IP_Clk)
    begin
        if (BUS2IP_Clk 'event and BUS2IP_Clk = '1') then
            count <= count + 1;
        end if;
end process clock_divider;        
--
-- decode bus logic
-- write to address 0 turns LEDs off
-- write to address 4 turns LEDs on
-- write to address 8 lights LEDs with a log pattern (looks smooth)
-- write to address C lights LEDs with a linear patterm (not smooth)

-- write to address 10 - 1C lights LEDs with register value (0 to 255)
--
decode: process(BUS2IP_Clk, Bus2IP_Reset, Bus2IP_WrCE, Bus2IP_Addr(28 to 29))
    begin
         if (BUS2IP_Clk 'event and BUS2IP_Clk = '1') then
            if ((Bus2IP_Reset = '0') and (Bus2IP_WrCE(0) = '1') and (Bus2IP_Addr(27 to 29) = "000")) then
                all_off <= '1';
                run <= '0';
                linear <= "00";
            end if;
            if ((Bus2IP_Reset = '0') and (Bus2IP_WrCE(0) = '1') and (Bus2IP_Addr(27 to 29) = "001")) then
                all_off <= '0';
                run <= '0';
                linear <= "00";
            end if;
            if ((Bus2IP_Reset = '0') and (Bus2IP_WrCE(0) = '1') and (Bus2IP_Addr(27 to 29) = "010")) then
                all_off <= '0';
                run <= '1';
                linear <= "00";
            end if;
            if ((Bus2IP_Reset = '0') and (Bus2IP_WrCE(0) = '1') and (Bus2IP_Addr(27 to 29) = "011")) then
                all_off <= '0';
                run <= '1';
                linear <= "01";

            end if;                

            if ((Bus2IP_Reset = '0') and (Bus2IP_WrCE(0) = '1') and (Bus2IP_Addr(27) = '1')) then
                all_off <= '0';
                run <= '1';
                linear <= "11";

                reg_value (7 downto 0) <= Bus2IP_Data(0 to 7);
            end if;
        end if;
end process decode;
            
--
-- Define linear / log patterns
--
PWM: process(count,linear)
    begin
        if linear = "00" then
            case (count (slow_clock_tap+3 downto slow_clock_tap)) is
                when "0000" => PWM_value <= "00000001";  -- 1
                when "0001" => PWM_value <= "00000010";  -- 4
                when "0010" => PWM_value <= "00001001";  -- 9
                when "0011" => PWM_value <= "00010000";  -- 16
                when "0100" => PWM_value <= "00011001";  -- 25  
                when "0101" => PWM_value <= "00100010";  -- 36
                when "0110" => PWM_value <= "00110001";  -- 49
                when "0111" => PWM_value <= "01000000";  -- 64
                when "1000" => PWM_value <= "01010001";  -- 81
                when "1001" => PWM_value <= "01100100";  -- 100
                when "1010" => PWM_value <= "01111001";  -- 121
                when "1011" => PWM_value <= "10010000";  -- 144
                when "1100" => PWM_value <= "10101001";  -- 169
                when "1101" => PWM_value <= "11000100";  -- 196
                when "1110" => PWM_value <= "11100001";  -- 225
                when others => PWM_value <= "11111111";  -- 255
            end case;
        elsif linear = "01" then
            case (count (slow_clock_tap+3 downto slow_clock_tap)) is
                when "0000" => PWM_value <= "00010000";  -- 16
                when "0001" => PWM_value <= "00100000";  -- 32
                when "0010" => PWM_value <= "00110000";  -- 48
                when "0011" => PWM_value <= "01000000";  -- 64
                when "0100" => PWM_value <= "01010000";  -- 80 
                when "0101" => PWM_value <= "01100000";  -- 96
                when "0110" => PWM_value <= "01110000";  -- 112
                when "0111" => PWM_value <= "10000000";  -- 128
                when "1000" => PWM_value <= "10010000";  -- 144
                when "1001" => PWM_value <= "10100000";  -- 160
                when "1010" => PWM_value <= "10110000";  -- 176
                when "1011" => PWM_value <= "11000000";  -- 192
                when "1100" => PWM_value <= "11010000";  -- 208
                when "1101" => PWM_value <= "11100000";  -- 224
                when "1110" => PWM_value <= "11110000";  -- 240
                when others => PWM_value <= "11111111";  -- 255
            end case;

        else

                PWM_value <= reg_value;
        end if;
end process PWM;
--
-- Drive LEDs (one is on, zero is off)
-- 

 
LEDs(0 to 7) <= "00000000" when (all_off = '1') else                         -- off

                "11111111" when (run = '0') else                             -- on

                "11111111" when (PWM_value >= count(15 downto 8)) else       -- PWM or reg_value

                "00000000";

                
--
-- Read back something on the data bus

-- Read back F0F0, then the register value, followed by "0000, all_off, run, linear (2 bits)";



IP2Bus_Data <= "1111000011110000" & reg_value & "0000" & all_off & run & linear when

                ((Bus2IP_Reset = '0') and (Bus2IP_RdCE(0) = '1')) else

                (others => '0');


--
-- Drive IP to Bus signals
--
  IP2Bus_WrAck <= Bus2IP_WrCE(0);
  IP2Bus_RdAck <= Bus2IP_RdCE(0);
  IP2Bus_Error <= '0';

end IMP;



--

-- Define several bus transactions for pwm_lights

-- Memory updates are 64 bits write, bus transactions are 32 bits wide.

--

--

-- Write value of 22 hex to LED register

--

mem_update(addr=30000010,data=22222222_22222222)

write (addr=30000010,size=0000,be=11110000)

-- Read status register, expect to get F0F02207

read (addr=30000000,size=0000,be=11110000) 

-- Write to offset 0, then read status, expect to get F0F02208

mem_update(addr=30000000,data=00000000_00000000)

write (addr=30000000,size=0000,be=11110000)

read (addr=30000000,size=0000,be=11110000) 

-- Write to offset 4, then read status, expect to get F0F02200

--mem_update(addr=30000000,data=00000000_00000000)

write (addr=30000004,size=0000,be=00001111)

read (addr=30000000,size=0000,be=00001111) 

-- Write to offset 8, then read status, expect to get F0F02208

mem_update(addr=30000008,data=00000000_00000000)

write (addr=30000008,size=0000,be=11110000)

read (addr=30000000,size=0000,be=11110000) 

-- Write to offset C, then read status, expect to get F0F02200

--mem_update(addr=30000000,data=00000000_00000000)

write (addr=3000000C,size=0000,be=00001111)

read (addr=30000000,size=0000,be=00001111)

001111)


/*************************************************************

* This program drives the LEDs using the custom circuit.     *

*************************************************************/



#include "xparameters.h"

#include "mb_interface.h" 

#include "stdio.h"

#include "xutil.h"

#include "stdlib.h"



int main() {

    

  int offset = 0;

  int *addr_ptr; 

  char keyboard;

  int LED_value = 0;

  int status; 

  int reg_value;

  int all_off_value;

  int run_value;

  int linear_value; 



  while(1) {



/*  Print initialization message, and prompt for user input. */

  xil_printf ("*********************************************\r\n");

  xil_printf ("* --> Hyperterm window must be selected <-- *\r\n");

  xil_printf ("*                                           *\r\n");

  xil_printf ("* Enter value and Carriage Return           *\r\n");     

  xil_printf ("* Enter 0 to read status                    *\r\n");

  xil_printf ("* Enter 1 for LEDs off.                     *\r\n");

  xil_printf ("* Enter 2 for LEDs on.                      *\r\n");

  xil_printf ("* Enter 3 for Log scale.                    *\r\n");

  xil_printf ("* Enter 4 for Linear scale.                 *\r\n");

  xil_printf ("* Enter 5 for Constant value.               *\r\n");

  xil_printf ("* Enter 6 to exit program.                  *\r\n"); 

  xil_printf ("*********************************************\r\r\n");



/* Read the keyboard, print the entry.  */  

  keyboard = XUartLite_RecvByte(XPAR_RS232_UART_1_BASEADDR);

  xil_printf ("%c \r\r\n", keyboard);

 

 /* Perform requested action. */ 

  switch ( keyboard ) {

  	

  	case '0': {    /* Print the status as read from the circuit */

  	  addr_ptr = XPAR_PWM_LIGHTS_0_BASEADDR;

  	  status = *addr_ptr; 

  	  reg_value = (status & 0x0000ff00) >> 8;

  	  all_off_value = (status & 0x00000008) >> 3;

  	  run_value = (status & 0x00000004) >> 2;

  	  linear_value = (status & 0x00000003); 	  

   	  xil_printf ("Raw status read = %x \r\n", status); 

   	  xil_printf ("Register value  = %d \r\n", reg_value);	

   	  xil_printf ("All_off value   = %d \r\n", all_off_value);	

   	  xil_printf ("Run value       = %d \r\n", run_value);	

   	  xil_printf ("Linear value    = %d \r\r\n", linear_value); }   	    

  	  break;

  	  

  	case '1': {    /* Turn off LEDs */

  	  addr_ptr = XPAR_PWM_LIGHTS_0_BASEADDR;

  	  *addr_ptr = 0x00000000; }

  	  break;

  	   

  	case '2': {   /* Turn on LEDs */

  	  addr_ptr = XPAR_PWM_LIGHTS_0_BASEADDR + 4;

  	  *addr_ptr = 0x00000000; }

  	  break;

  	  

  	case '3': {   /* Use log drive for LEDs */

  	  addr_ptr = XPAR_PWM_LIGHTS_0_BASEADDR + 8;

  	  *addr_ptr = 0x00000000; }

  	  break;

  	  

  	case '4': {   /* Use linear drive for LEDs */

  	  addr_ptr = XPAR_PWM_LIGHTS_0_BASEADDR + 12;

  	  *addr_ptr = 0x00000000; }

  	  break;

  	  

  	case '5': {   /* Drive LEDs with register value */

  	  addr_ptr = XPAR_PWM_LIGHTS_0_BASEADDR + 16;

  	  xil_printf ("* Enter LED intensity value (0 to 255) and CR:     *\r\n");

  	  scanf ("%d", &LED_value);

  	  if (LED_value > 255) LED_value = 255;

  	  xil_printf ("%d \r\r\n", LED_value);

  	  *addr_ptr = LED_value << 24; }

  	  break;

  	  

  	case '6':   /* Exit program */

  	  xil_printf ("That was exciting, wasn't it? \r\r\n");

  	  exit(0);

  	  break;

  	default: {

  	  addr_ptr = XPAR_PWM_LIGHTS_0_BASEADDR;

   	  *addr_ptr = 0x00000000; } 	  

  	  break;

    }  

  }

}




cd system/simulation/behavioral

do system.do

#Some Modelsim installs do not require the “glbl” to be part of the 

#VSIM command below. If you get errors when the simulation 

#is loaded, remove “glbl” from the VSIM command

vsim -L unisims_ver -novopt -t ps system_conf glbl

add wave *



proc clk_setup {} {

if { [info exists PathSeparator] } { set ps $PathSeparator } else { set ps "/" }

if { ![info exists tbpath] } { set tbpath "${ps}system" }

force -freeze $tbpath${ps}fpga_0_clk_1_sys_clk_pin 0, 1 {4 ns} -rep 8 ns

}



clk_setup



# Set up reset waveforms



proc rst_setup {} {

if { [info exists PathSeparator] } { set ps $PathSeparator } else { set ps "/" }

if { ![info exists tbpath] } { set tbpath "${ps}system" }

force -freeze $tbpath${ps}fpga_0_rst_1_sys_rst_pin 0, 1 {128 ns}

}



rst_setup



run 128 us




------------------------------------------------------------------------------
-- pwm_lights.vhd - entity/architecture pair
------------------------------------------------------------------------------
-- IMPORTANT:
-- DO NOT MODIFY THIS FILE EXCEPT IN THE DESIGNATED SECTIONS.
--
-- SEARCH FOR --USER TO DETERMINE WHERE CHANGES ARE ALLOWED.
--
-- TYPICALLY, THE ONLY ACCEPTABLE CHANGES INVOLVE ADDING NEW
-- PORTS AND GENERICS THAT GET PASSED THROUGH TO THE INSTANTIATION
-- OF THE USER_LOGIC ENTITY.
------------------------------------------------------------------------------
--
-- ***************************************************************************
-- ** Copyright (c) 1995-2009 Xilinx, Inc.  All rights reserved.            **
-- **                                                                       **
-- ** Xilinx, Inc.                                                          **
-- ** XILINX IS PROVIDING THIS DESIGN, CODE, OR INFORMATION "AS IS"         **
-- ** AS A COURTESY TO YOU, SOLELY FOR USE IN DEVELOPING PROGRAMS AND       **
-- ** SOLUTIONS FOR XILINX DEVICES.  BY PROVIDING THIS DESIGN, CODE,        **
-- ** OR INFORMATION AS ONE POSSIBLE IMPLEMENTATION OF THIS FEATURE,        **
-- ** APPLICATION OR STANDARD, XILINX IS MAKING NO REPRESENTATION           **
-- ** THAT THIS IMPLEMENTATION IS FREE FROM ANY CLAIMS OF INFRINGEMENT,     **
-- ** AND YOU ARE RESPONSIBLE FOR OBTAINING ANY RIGHTS YOU MAY REQUIRE      **
-- ** FOR YOUR IMPLEMENTATION.  XILINX EXPRESSLY DISCLAIMS ANY              **
-- ** WARRANTY WHATSOEVER WITH RESPECT TO THE ADEQUACY OF THE               **
-- ** IMPLEMENTATION, INCLUDING BUT NOT LIMITED TO ANY WARRANTIES OR        **
-- ** REPRESENTATIONS THAT THIS IMPLEMENTATION IS FREE FROM CLAIMS OF       **
-- ** INFRINGEMENT, IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS       **
-- ** FOR A PARTICULAR PURPOSE.                                             **
-- **                                                                       **
-- ***************************************************************************
--
------------------------------------------------------------------------------
-- Filename:          pwm_lights.vhd
-- Version:           1.00.a
-- Description:       Top level design, instantiates library components and user logic.
-- Date:              Wed Mar 18 12:15:18 2009 (by Create and Import Peripheral Wizard)
-- VHDL Standard:     VHDL'93
------------------------------------------------------------------------------
-- Naming Conventions:
--   active low signals:                    "*_n"
--   clock signals:                         "clk", "clk_div#", "clk_#x"
--   reset signals:                         "rst", "rst_n"
--   generics:                              "C_*"
--   user defined types:                    "*_TYPE"
--   state machine next state:              "*_ns"
--   state machine current state:           "*_cs"
--   combinatorial signals:                 "*_com"
--   pipelined or register delay signals:   "*_d#"
--   counter signals:                       "*cnt*"
--   clock enable signals:                  "*_ce"
--   internal version of output port:       "*_i"
--   device pins:                           "*_pin"
--   ports:                                 "- Names begin with Uppercase"
--   processes:                             "*_PROCESS"
--   component instantiations:              "<ENTITY_>I_<#|FUNC>"
------------------------------------------------------------------------------

library ieee;
use ieee.std_logic_1164.all;
use ieee.std_logic_arith.all;
use ieee.std_logic_unsigned.all;

library proc_common_v3_00_a;
use proc_common_v3_00_a.proc_common_pkg.all;
use proc_common_v3_00_a.ipif_pkg.all;

library plbv46_slave_single_v1_01_a;
use plbv46_slave_single_v1_01_a.plbv46_slave_single;

library pwm_lights_v1_00_a;
use pwm_lights_v1_00_a.user_logic;

------------------------------------------------------------------------------
-- Entity section
------------------------------------------------------------------------------
-- Definition of Generics:
--   C_BASEADDR                   -- PLBv46 slave: base address
--   C_HIGHADDR                   -- PLBv46 slave: high address
--   C_SPLB_AWIDTH                -- PLBv46 slave: address bus width
--   C_SPLB_DWIDTH                -- PLBv46 slave: data bus width
--   C_SPLB_NUM_MASTERS           -- PLBv46 slave: Number of masters
--   C_SPLB_MID_WIDTH             -- PLBv46 slave: master ID bus width
--   C_SPLB_NATIVE_DWIDTH         -- PLBv46 slave: internal native data bus width
--   C_SPLB_P2P                   -- PLBv46 slave: point to point interconnect scheme
--   C_SPLB_SUPPORT_BURSTS        -- PLBv46 slave: support bursts
--   C_SPLB_SMALLEST_MASTER       -- PLBv46 slave: width of the smallest master
--   C_SPLB_CLK_PERIOD_PS         -- PLBv46 slave: bus clock in picoseconds
--   C_INCLUDE_DPHASE_TIMER       -- PLBv46 slave: Data Phase Timer configuration; 0 = exclude timer, 1 = include timer
--   C_FAMILY                     -- Xilinx FPGA family
--
-- Definition of Ports:
--   SPLB_Clk                     -- PLB main bus clock
--   SPLB_Rst                     -- PLB main bus reset
--   PLB_ABus                     -- PLB address bus
--   PLB_UABus                    -- PLB upper address bus
--   PLB_PAValid                  -- PLB primary address valid indicator
--   PLB_SAValid                  -- PLB secondary address valid indicator
--   PLB_rdPrim                   -- PLB secondary to primary read request indicator
--   PLB_wrPrim                   -- PLB secondary to primary write request indicator
--   PLB_masterID                 -- PLB current master identifier
--   PLB_abort                    -- PLB abort request indicator
--   PLB_busLock                  -- PLB bus lock
--   PLB_RNW                      -- PLB read/not write
--   PLB_BE                       -- PLB byte enables
--   PLB_MSize                    -- PLB master data bus size
--   PLB_size                     -- PLB transfer size
--   PLB_type                     -- PLB transfer type
--   PLB_lockErr                  -- PLB lock error indicator
--   PLB_wrDBus                   -- PLB write data bus
--   PLB_wrBurst                  -- PLB burst write transfer indicator
--   PLB_rdBurst                  -- PLB burst read transfer indicator
--   PLB_wrPendReq                -- PLB write pending bus request indicator
--   PLB_rdPendReq                -- PLB read pending bus request indicator
--   PLB_wrPendPri                -- PLB write pending request priority
--   PLB_rdPendPri                -- PLB read pending request priority
--   PLB_reqPri                   -- PLB current request priority
--   PLB_TAttribute               -- PLB transfer attribute
--   Sl_addrAck                   -- Slave address acknowledge
--   Sl_SSize                     -- Slave data bus size
--   Sl_wait                      -- Slave wait indicator
--   Sl_rearbitrate               -- Slave re-arbitrate bus indicator
--   Sl_wrDAck                    -- Slave write data acknowledge
--   Sl_wrComp                    -- Slave write transfer complete indicator
--   Sl_wrBTerm                   -- Slave terminate write burst transfer
--   Sl_rdDBus                    -- Slave read data bus
--   Sl_rdWdAddr                  -- Slave read word address
--   Sl_rdDAck                    -- Slave read data acknowledge
--   Sl_rdComp                    -- Slave read transfer complete indicator
--   Sl_rdBTerm                   -- Slave terminate read burst transfer
--   Sl_MBusy                     -- Slave busy indicator
--   Sl_MWrErr                    -- Slave write error indicator
--   Sl_MRdErr                    -- Slave read error indicator
--   Sl_MIRQ                      -- Slave interrupt indicator
------------------------------------------------------------------------------

entity pwm_lights is
  generic
  (
    -- ADD USER GENERICS BELOW THIS LINE ---------------
    --USER generics added here
    -- ADD USER GENERICS ABOVE THIS LINE ---------------

    -- DO NOT EDIT BELOW THIS LINE ---------------------
    -- Bus protocol parameters, do not add to or delete
    C_BASEADDR                     : std_logic_vector     := X"FFFFFFFF";
    C_HIGHADDR                     : std_logic_vector     := X"00000000";
    C_SPLB_AWIDTH                  : integer              := 32;
    C_SPLB_DWIDTH                  : integer              := 128;
    C_SPLB_NUM_MASTERS             : integer              := 8;
    C_SPLB_MID_WIDTH               : integer              := 3;
    C_SPLB_NATIVE_DWIDTH           : integer              := 32;
    C_SPLB_P2P                     : integer              := 0;
    C_SPLB_SUPPORT_BURSTS          : integer              := 0;
    C_SPLB_SMALLEST_MASTER         : integer              := 32;
    C_SPLB_CLK_PERIOD_PS           : integer              := 10000;
    C_INCLUDE_DPHASE_TIMER         : integer              := 0;
    C_FAMILY                       : string               := "virtex5"
    -- DO NOT EDIT ABOVE THIS LINE ---------------------
  );
  port
  (
    -- ADD USER PORTS BELOW THIS LINE ------------------
    LEDs                           : out std_logic_vector(0 to 7);
    -- ADD USER PORTS ABOVE THIS LINE ------------------

    -- DO NOT EDIT BELOW THIS LINE ---------------------
    -- Bus protocol ports, do not add to or delete
    SPLB_Clk                       : in  std_logic;
    SPLB_Rst                       : in  std_logic;
    PLB_ABus                       : in  std_logic_vector(0 to 31);
    PLB_UABus                      : in  std_logic_vector(0 to 31);
    PLB_PAValid                    : in  std_logic;
    PLB_SAValid                    : in  std_logic;
    PLB_rdPrim                     : in  std_logic;
    PLB_wrPrim                     : in  std_logic;
    PLB_masterID                   : in  std_logic_vector(0 to C_SPLB_MID_WIDTH-1);
    PLB_abort                      : in  std_logic;
    PLB_busLock                    : in  std_logic;
    PLB_RNW                        : in  std_logic;
    PLB_BE                         : in  std_logic_vector(0 to C_SPLB_DWIDTH/8-1);
    PLB_MSize                      : in  std_logic_vector(0 to 1);
    PLB_size                       : in  std_logic_vector(0 to 3);
    PLB_type                       : in  std_logic_vector(0 to 2);
    PLB_lockErr                    : in  std_logic;
    PLB_wrDBus                     : in  std_logic_vector(0 to C_SPLB_DWIDTH-1);
    PLB_wrBurst                    : in  std_logic;
    PLB_rdBurst                    : in  std_logic;
    PLB_wrPendReq                  : in  std_logic;
    PLB_rdPendReq                  : in  std_logic;
    PLB_wrPendPri                  : in  std_logic_vector(0 to 1);
    PLB_rdPendPri                  : in  std_logic_vector(0 to 1);
    PLB_reqPri                     : in  std_logic_vector(0 to 1);
    PLB_TAttribute                 : in  std_logic_vector(0 to 15);
    Sl_addrAck                     : out std_logic;
    Sl_SSize                       : out std_logic_vector(0 to 1);
    Sl_wait                        : out std_logic;
    Sl_rearbitrate                 : out std_logic;
    Sl_wrDAck                      : out std_logic;
    Sl_wrComp                      : out std_logic;
    Sl_wrBTerm                     : out std_logic;
    Sl_rdDBus                      : out std_logic_vector(0 to C_SPLB_DWIDTH-1);
    Sl_rdWdAddr                    : out std_logic_vector(0 to 3);
    Sl_rdDAck                      : out std_logic;
    Sl_rdComp                      : out std_logic;
    Sl_rdBTerm                     : out std_logic;
    Sl_MBusy                       : out std_logic_vector(0 to C_SPLB_NUM_MASTERS-1);
    Sl_MWrErr                      : out std_logic_vector(0 to C_SPLB_NUM_MASTERS-1);
    Sl_MRdErr                      : out std_logic_vector(0 to C_SPLB_NUM_MASTERS-1);
    Sl_MIRQ                        : out std_logic_vector(0 to C_SPLB_NUM_MASTERS-1)
    -- DO NOT EDIT ABOVE THIS LINE ---------------------
  );

  attribute SIGIS : string;
  attribute SIGIS of SPLB_Clk      : signal is "CLK";
  attribute SIGIS of SPLB_Rst      : signal is "RST";

end entity pwm_lights;

------------------------------------------------------------------------------
-- Architecture section
------------------------------------------------------------------------------

architecture IMP of pwm_lights is

  ------------------------------------------
  -- Array of base/high address pairs for each address range
  ------------------------------------------
  constant ZERO_ADDR_PAD                  : std_logic_vector(0 to 31) := (others => '0');
  constant USER_SLV_BASEADDR              : std_logic_vector     := C_BASEADDR;
  constant USER_SLV_HIGHADDR              : std_logic_vector     := C_HIGHADDR;

  constant IPIF_ARD_ADDR_RANGE_ARRAY      : SLV64_ARRAY_TYPE     := 
    (
      ZERO_ADDR_PAD & USER_SLV_BASEADDR,  -- user logic slave space base address
      ZERO_ADDR_PAD & USER_SLV_HIGHADDR   -- user logic slave space high address
    );

  ------------------------------------------
  -- Array of desired number of chip enables for each address range
  ------------------------------------------
  constant USER_SLV_NUM_REG               : integer              := 1;
  constant USER_NUM_REG                   : integer              := USER_SLV_NUM_REG;

  constant IPIF_ARD_NUM_CE_ARRAY          : INTEGER_ARRAY_TYPE   := 
    (
      0  => pad_power2(USER_SLV_NUM_REG)  -- number of ce for user logic slave space
    );

  ------------------------------------------
  -- Ratio of bus clock to core clock (for use in dual clock systems)
  -- 1 = ratio is 1:1
  -- 2 = ratio is 2:1
  ------------------------------------------
  constant IPIF_BUS2CORE_CLK_RATIO        : integer              := 1;

  ------------------------------------------
  -- Width of the slave data bus (32 only)
  ------------------------------------------
  constant USER_SLV_DWIDTH                : integer              := C_SPLB_NATIVE_DWIDTH;

  constant IPIF_SLV_DWIDTH                : integer              := C_SPLB_NATIVE_DWIDTH;

  ------------------------------------------
  -- Index for CS/CE
  ------------------------------------------
  constant USER_SLV_CS_INDEX              : integer              := 0;
  constant USER_SLV_CE_INDEX              : integer              := calc_start_ce_index(IPIF_ARD_NUM_CE_ARRAY, USER_SLV_CS_INDEX);

  constant USER_CE_INDEX                  : integer              := USER_SLV_CE_INDEX;

  ------------------------------------------
  -- IP Interconnect (IPIC) signal declarations
  ------------------------------------------
  signal ipif_Bus2IP_Clk                : std_logic;
  signal ipif_Bus2IP_Reset              : std_logic;
  signal ipif_IP2Bus_Data               : std_logic_vector(0 to IPIF_SLV_DWIDTH-1);
  signal ipif_IP2Bus_WrAck              : std_logic;
  signal ipif_IP2Bus_RdAck              : std_logic;
  signal ipif_IP2Bus_Error              : std_logic;
  signal ipif_Bus2IP_Addr               : std_logic_vector(0 to C_SPLB_AWIDTH-1);
  signal ipif_Bus2IP_Data               : std_logic_vector(0 to IPIF_SLV_DWIDTH-1);
  signal ipif_Bus2IP_RNW                : std_logic;
  signal ipif_Bus2IP_BE                 : std_logic_vector(0 to IPIF_SLV_DWIDTH/8-1);
  signal ipif_Bus2IP_CS                 : std_logic_vector(0 to ((IPIF_ARD_ADDR_RANGE_ARRAY'length)/2)-1);
  signal ipif_Bus2IP_RdCE               : std_logic_vector(0 to calc_num_ce(IPIF_ARD_NUM_CE_ARRAY)-1);
  signal ipif_Bus2IP_WrCE               : std_logic_vector(0 to calc_num_ce(IPIF_ARD_NUM_CE_ARRAY)-1);
  signal user_Bus2IP_RdCE               : std_logic_vector(0 to USER_NUM_REG-1);
  signal user_Bus2IP_WrCE               : std_logic_vector(0 to USER_NUM_REG-1);
  signal user_IP2Bus_Data               : std_logic_vector(0 to USER_SLV_DWIDTH-1);
  signal user_IP2Bus_RdAck              : std_logic;
  signal user_IP2Bus_WrAck              : std_logic;
  signal user_IP2Bus_Error              : std_logic;

begin

  ------------------------------------------
  -- instantiate plbv46_slave_single
  ------------------------------------------
  PLBV46_SLAVE_SINGLE_I : entity plbv46_slave_single_v1_01_a.plbv46_slave_single
    generic map
    (
      C_ARD_ADDR_RANGE_ARRAY         => IPIF_ARD_ADDR_RANGE_ARRAY,
      C_ARD_NUM_CE_ARRAY             => IPIF_ARD_NUM_CE_ARRAY,
      C_SPLB_P2P                     => C_SPLB_P2P,
      C_BUS2CORE_CLK_RATIO           => IPIF_BUS2CORE_CLK_RATIO,
      C_SPLB_MID_WIDTH               => C_SPLB_MID_WIDTH,
      C_SPLB_NUM_MASTERS             => C_SPLB_NUM_MASTERS,
      C_SPLB_AWIDTH                  => C_SPLB_AWIDTH,
      C_SPLB_DWIDTH                  => C_SPLB_DWIDTH,
      C_SIPIF_DWIDTH                 => IPIF_SLV_DWIDTH,
      C_INCLUDE_DPHASE_TIMER         => C_INCLUDE_DPHASE_TIMER,
      C_FAMILY                       => C_FAMILY
    )
    port map
    (
      SPLB_Clk                       => SPLB_Clk,
      SPLB_Rst                       => SPLB_Rst,
      PLB_ABus                       => PLB_ABus,
      PLB_UABus                      => PLB_UABus,
      PLB_PAValid                    => PLB_PAValid,
      PLB_SAValid                    => PLB_SAValid,
      PLB_rdPrim                     => PLB_rdPrim,
      PLB_wrPrim                     => PLB_wrPrim,
      PLB_masterID                   => PLB_masterID,
      PLB_abort                      => PLB_abort,
      PLB_busLock                    => PLB_busLock,
      PLB_RNW                        => PLB_RNW,
      PLB_BE                         => PLB_BE,
      PLB_MSize                      => PLB_MSize,
      PLB_size                       => PLB_size,
      PLB_type                       => PLB_type,
      PLB_lockErr                    => PLB_lockErr,
      PLB_wrDBus                     => PLB_wrDBus,
      PLB_wrBurst                    => PLB_wrBurst,
      PLB_rdBurst                    => PLB_rdBurst,
      PLB_wrPendReq                  => PLB_wrPendReq,
      PLB_rdPendReq                  => PLB_rdPendReq,
      PLB_wrPendPri                  => PLB_wrPendPri,
      PLB_rdPendPri                  => PLB_rdPendPri,
      PLB_reqPri                     => PLB_reqPri,
      PLB_TAttribute                 => PLB_TAttribute,
      Sl_addrAck                     => Sl_addrAck,
      Sl_SSize                       => Sl_SSize,
      Sl_wait                        => Sl_wait,
      Sl_rearbitrate                 => Sl_rearbitrate,
      Sl_wrDAck                      => Sl_wrDAck,
      Sl_wrComp                      => Sl_wrComp,
      Sl_wrBTerm                     => Sl_wrBTerm,
      Sl_rdDBus                      => Sl_rdDBus,
      Sl_rdWdAddr                    => Sl_rdWdAddr,
      Sl_rdDAck                      => Sl_rdDAck,
      Sl_rdComp                      => Sl_rdComp,
      Sl_rdBTerm                     => Sl_rdBTerm,
      Sl_MBusy                       => Sl_MBusy,
      Sl_MWrErr                      => Sl_MWrErr,
      Sl_MRdErr                      => Sl_MRdErr,
      Sl_MIRQ                        => Sl_MIRQ,
      Bus2IP_Clk                     => ipif_Bus2IP_Clk,
      Bus2IP_Reset                   => ipif_Bus2IP_Reset,
      IP2Bus_Data                    => ipif_IP2Bus_Data,
      IP2Bus_WrAck                   => ipif_IP2Bus_WrAck,
      IP2Bus_RdAck                   => ipif_IP2Bus_RdAck,
      IP2Bus_Error                   => ipif_IP2Bus_Error,
      Bus2IP_Addr                    => ipif_Bus2IP_Addr,
      Bus2IP_Data                    => ipif_Bus2IP_Data,
      Bus2IP_RNW                     => ipif_Bus2IP_RNW,
      Bus2IP_BE                      => ipif_Bus2IP_BE,
      Bus2IP_CS                      => ipif_Bus2IP_CS,
      Bus2IP_RdCE                    => ipif_Bus2IP_RdCE,
      Bus2IP_WrCE                    => ipif_Bus2IP_WrCE
    );

  ------------------------------------------
  -- instantiate User Logic
  ------------------------------------------
  USER_LOGIC_I : entity pwm_lights_v1_00_a.user_logic
    generic map
    (
      -- MAP USER GENERICS BELOW THIS LINE ---------------
      --USER generics mapped here
      -- MAP USER GENERICS ABOVE THIS LINE ---------------

      C_SLV_DWIDTH                   => USER_SLV_DWIDTH,
      C_NUM_REG                      => USER_NUM_REG
    )
    port map
    (
      -- MAP USER PORTS BELOW THIS LINE ------------------
      LEDs(0 to 7)                   => LEDs(0 to 7),
      -- MAP USER PORTS ABOVE THIS LINE ------------------

      Bus2IP_Clk                     => ipif_Bus2IP_Clk,
      Bus2IP_Reset                   => ipif_Bus2IP_Reset,
      Bus2IP_Addr                    => ipif_Bus2IP_Addr,
      Bus2IP_Data                    => ipif_Bus2IP_Data,
      Bus2IP_BE                      => ipif_Bus2IP_BE,
      Bus2IP_RdCE                    => user_Bus2IP_RdCE,
      Bus2IP_WrCE                    => user_Bus2IP_WrCE,
      IP2Bus_Data                    => user_IP2Bus_Data,
      IP2Bus_RdAck                   => user_IP2Bus_RdAck,
      IP2Bus_WrAck                   => user_IP2Bus_WrAck,
      IP2Bus_Error                   => user_IP2Bus_Error
    );

  ------------------------------------------
  -- connect internal signals
  ------------------------------------------
  ipif_IP2Bus_Data <= user_IP2Bus_Data;
  ipif_IP2Bus_WrAck <= user_IP2Bus_WrAck;
  ipif_IP2Bus_RdAck <= user_IP2Bus_RdAck;
  ipif_IP2Bus_Error <= user_IP2Bus_Error;

  user_Bus2IP_RdCE <= ipif_Bus2IP_RdCE(USER_CE_INDEX to USER_CE_INDEX+USER_NUM_REG-1);
  user_Bus2IP_WrCE <= ipif_Bus2IP_WrCE(USER_CE_INDEX to USER_CE_INDEX+USER_NUM_REG-1);

end IMP;



------------------------------------------------------------------------------

-- Filename:          C:\projects11\cip_mb_ctt_s3a_dsp\system/pcores/pwm_lights_v1_00_a/devl/bfmsim/scripts/sample.bfl

-- Description:       Sample BFL command script to test peripheral

-- Date:              Mon Mar 23 14:48:25 2009 (by Create and Import Peripheral Wizard)

------------------------------------------------------------------------------





------------------------------

-- Define Alias

------------------------------



-- Byte Enable Alias

set_alias(IGNOR = 00000000_00000000)

set_alias(BYTE0 = 10000000_00000000)

set_alias(BYTE1 = 01000000_00000000)

set_alias(BYTE2 = 00100000_00000000)

set_alias(BYTE3 = 00010000_00000000)

set_alias(BYTE4 = 00001000_00000000)

set_alias(BYTE5 = 00000100_00000000)

set_alias(BYTE6 = 00000010_00000000)

set_alias(BYTE7 = 00000001_00000000)

set_alias(BYTE8 = 00000000_10000000)

set_alias(BYTE9 = 00000000_01000000)

set_alias(BYTEA = 00000000_00100000)

set_alias(BYTEB = 00000000_00010000)

set_alias(BYTEC = 00000000_00001000)

set_alias(BYTED = 00000000_00000100)

set_alias(BYTEE = 00000000_00000010)

set_alias(BYTEF = 00000000_00000001)

set_alias(HWRD0 = 11000000_00000000)

set_alias(HWRD2 = 00110000_00000000)

set_alias(HWRD4 = 00001100_00000000)

set_alias(HWRD6 = 00000011_00000000)

set_alias(HWRD8 = 00000000_11000000)

set_alias(HWRDA = 00000000_00110000)

set_alias(HWRDC = 00000000_00001100)

set_alias(HWRDE = 00000000_00000011)

set_alias(WORD0 = 11110000_00000000)

set_alias(WORD4 = 00001111_00000000)

set_alias(WORD8 = 00000000_11110000)

set_alias(WORDC = 00000000_00001111)

set_alias(DWRD0 = 11111111_00000000)

set_alias(DWRD8 = 00000000_11111111)

set_alias(QWORD = 11111111_11111111)



-- PLB BE aliases (fixed length burst)

set_alias(IBURST   = 00000000_00000000)

set_alias(FBURST2  = 00010000_00000000)

set_alias(FBURST3  = 00100000_00000000)

set_alias(FBURST4  = 00110000_00000000)

set_alias(FBURST5  = 01000000_00000000)

set_alias(FBURST6  = 01010000_00000000)

set_alias(FBURST7  = 01100000_00000000)

set_alias(FBURST8  = 01110000_00000000)

set_alias(FBURST9  = 10000000_00000000)

set_alias(FBURST10 = 10010000_00000000)

set_alias(FBURST11 = 10100000_00000000)

set_alias(FBURST12 = 10110000_00000000)

set_alias(FBURST13 = 11000000_00000000)

set_alias(FBURST14 = 11010000_00000000)

set_alias(FBURST15 = 11100000_00000000)

set_alias(FBURST16 = 11110000_00000000)



-- PLB Size Alias

set_alias(SINGLE_NORMAL  = 0000)

set_alias(CACHELN_4WRD   = 0001)

set_alias(CACHELN_8WRD   = 0010)

set_alias(CACHELN_16WRD  = 0011)

set_alias(BYTE_BURST     = 1000)

set_alias(HLFWORD_BURST  = 1001)

set_alias(WORD_BURST     = 1010)

set_alias(DBLWORD_BURST  = 1011)

set_alias(QUADWORD_BURST = 1100)

set_alias(OCTWORD_BURST  = 1101)



-- UUT Address Space Alias

set_alias(USER_SLV_BASEADDR    = 30000000)



-- System Memory Address Alias

set_alias(SYS_MEM0_BASEADDR = 10000000)

set_alias(SYS_MEM1_BASEADDR = 20000000)



------------------------------

-- Data Alias

------------------------------



-- Common Data

set_alias(ALL_CLEARED         = 00000000)



------------------------------

-- BFL/VHDL communication alias

------------------------------



set_alias(NOP        = 0)

set_alias(START      = 1)

set_alias(STOP       = 2)

set_alias(WAIT_IN    = 3)

set_alias(WAIT_OUT   = 4)

set_alias(ASSERT_IN  = 5)

set_alias(ASSERT_OUT = 6)

set_alias(ASSIGN_IN  = 7)

set_alias(ASSIGN_OUT = 8)

set_alias(RESET_WDT  = 9)

set_alias(MST_ERROR  = 30)

set_alias(INTERRUPT  = 31)



------------------------------

-- Initialize the PLB Slave as 128-bit slave memory ...

--

-- Note:

--

-- 	The instance name for bfm_memory is duplicated in the path due to the

-- 	wrapper level inserted by SimGen to support mixed language simulation.

------------------------------



set_device(path = /bfm_system/bfm_memory/bfm_memory/slave, device_type = plb_slave)

configure

(

  ssize = 10,

  fixed_burst_mode = 1,

  read_addr_pipeline_disable=1,

  write_addr_pipeline_disable=1,

  data_pipeline_mode=1,

  burst_term_mode=CYCLE,

  aack_delay = 1

)



-- initialize the source data memory (first 16 locations) ...

mem_init(addr = 10000000, data = 00010203_04050607_08090A0B_0C0D0E0F)

mem_init(addr = 10000010, data = 10111213_14151617_18191A1B_1C1D1E1F)

mem_init(addr = 10000020, data = 20212223_24252627_28292A2B_2C2D2E2F)

mem_init(addr = 10000030, data = 30313233_34353637_38393A3B_3C3D3E3F)

mem_init(addr = 10000040, data = 40414243_44454647_48494A4B_4C4D4E4F)

mem_init(addr = 10000050, data = 50515253_54555657_58595A5B_5C5D5E5F)

mem_init(addr = 10000060, data = 60616263_64656667_68696A6B_6C6D6E6F)

mem_init(addr = 10000070, data = 70717273_74757677_78797A7B_7C7D7E7F)

mem_init(addr = 10000080, data = 80818283_84858687_88898A8B_8C8D8E8F)

mem_init(addr = 10000090, data = 90919293_94959697_98999A9B_9C9D9E9F)

mem_init(addr = 100000A0, data = A0A1A2A3_A4A5A6A7_A8A9AAAB_ACADAEAF)

mem_init(addr = 100000B0, data = B0B1B2B3_B4B5B6B7_B8B9BABB_BCBDBEBF)

mem_init(addr = 100000C0, data = C0C1C2C3_C4C5C6C7_C8C9CACB_CCCDCECF)

mem_init(addr = 100000D0, data = D0D1D2D3_D4D5D6D7_D8D9DADB_DCDDDEDF)

mem_init(addr = 100000E0, data = E0E1E2E3_E4E5E6E7_E8E9EAEB_ECEDEEEF)

mem_init(addr = 100000F0, data = F0F1F2F3_F4F5F6F7_F8F9FAFB_FCFDFEFF)



-- initialize the destination data memory (first 16 locations) ...

mem_init(addr = 20000000, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000010, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000020, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000030, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000040, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000050, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000060, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000070, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000080, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 20000090, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 200000A0, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 200000B0, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 200000C0, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 200000D0, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 200000E0, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)

mem_init(addr = 200000F0, data = DEADBEEF_DEADBEEF_DEADBEEF_DEADBEEF)



------------------------------

-- Initialize the PLB Master as 128-bit master processor ...

--

-- Note:

--

-- 	The instance name for bfm_processor is duplicated in the path due to the

-- 	wrapper level inserted by SimGen to support mixed language simulation.

------------------------------



set_device(path = /bfm_system/bfm_processor/bfm_processor/master, device_type = plb_master)

configure(msize = 01)



------------------------------

-- Start Testing ...

------------------------------

-- Define several bus transactions for pwm_lights

--

--

-- Write value of 22 hex to LED register

--

mem_update(addr=30000010,data=22222222_22222222)

write (addr=30000010,size=0000,be=11110000)

-- Read status register, expect to get FOFO2207

read (addr=30000000,size=0000,be=11110000)

-- Write to offset 0, then read status, expect to get FOFO2208

mem_update(addr=30000000,data=00000000_00000000)

write (addr=30000000,size=0000,be=11110000)

read (addr=30000000,size=0000,be=11110000)

-- Write to offset 4, then read status, expect to get FOFO2200

--mem_update(addr=30000004,data=00000000_00000000)

write (addr=30000004,size=0000,be=00001111)

read (addr=30000000,size=0000,be=00001111)

-- Write to offset 8, then read status, expect to get FOFO2204

--mem_update(addr=30000008,data=00000000_00000000)

write (addr=30000008,size=0000,be=00001111)

read (addr=30000000,size=0000,be=00001111)

-- Write to offset c, then read status, expect to get FOFO2205

--mem_update(addr=3000000c,data=00000000_00000000)

write (addr=3000000c,size=0000,be=00001111)

read (addr=30000000,size=0000,be=00001111)

------------------------------

-- End of Testing.

------------------------------



